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Overview

 

Introduction

 

This chapter provides a general introduction to the ABI P

 

RISM

 

®

 

 
GeneScan

 

®

 

 Analysis Software, information about the organization of 
this manual, and instructions on how to get help from Applied 
Biosystems.

 

In This Chapter

 

Topics in this chapter include the following: 

 

Topic See Page

 

About the GeneScan Analysis Software 1-2

GeneScan Software on the 310 Instrument 1-3

GeneScan Analysis on the 377 Instrument 1-4

GeneScan Analysis on the 3100 Instrument 1-5

GeneScan Analysis on the 3700 Instrument 1-6

Registering the Software 1-8

Hardware and Software Requirements 1-9

Installing the GeneScan Analysis Software 1-12

Starting the GeneScan Analysis Software for the First Time 1-13

Removing the Software 1-15
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1-2 GeneScan Analysis Software Overview

 

About the GeneScan Analysis Software

 

What Does the
Software Do

 

The GeneScan Analysis Software performs DNA fragment analysis, 
which separates a mixture of DNA fragments according to their lengths, 
provides a profile of the separation, and estimates the lengths and sizes 
of the fragments.

 

Instruments

 

GeneScan Analysis Software Version 3.7 works on the following 
instruments:

 

�

 

ABI P

 

RISM

 

¤

 

 310 Genetic Analyzer

 

�

 

ABI P

 

RISM

 

¤

 

 377 DNA Sequencer

 

�

 

ABI P

 

RISM

 

¤

 

 3100 Genetic Analyzer

 

�

 

ABI P

 

RISM

 

¤

 

 3700 DNA Analyzer
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GeneScan Software on the 310 Instrument 

 

Flowchart User starts instrument run with 
automatic analysis

Data Collection software 
automatically captures raw data 
and creates sample files

Data Collection automatically 
launches GeneScan Analysis 
for sizecalling of sample files

If set in GeneScan Analysis, the 
software automatically submits 
files for printing

User reviews GeneScan 
Analysis software Error Logs

User may open analyzed 
sample files to edit fragment 
sizecalls

OK?

OK?

User adjusts parameters and 
starts analysis

User makes changes required 
by problems in Error Log

User adjusts parameters and 
reanalyzes samples files

Yes

No

No

Yes

DNA fragment ready for further 
processing

User reviews sizecalling results
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GeneScan Analysis on the 377 Instrument 

 

Flowchart User starts instrument run with 
automatic analysis

Data Collection software 
automatically captures raw data into 
gel files

Data Collection automatically 
launches Gel Processor, which 
tracks lanes and extracts data into 
sample files

If set in GeneScan Analysis, the 
software automatically submits files 
for printing

User reviews GeneScan Analysis 
software Error Logs

User may open analyzed sample files 
to edit fragment sizecalls

OK?

OK?

User adjusts parameters and 
starts analysis

User makes changes required 
by problems in Error Log

User adjusts parameters and 
re-analyzes samples files

Yes

No

No

Yes

DNA fragment ready for further 
processing

User reviews sizecalling results

Gel Processor launches GeneScan 
Analysis, which performs sizecalling
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GeneScan Analysis on the 3100 Instrument 

 

Flowchart

External Computers 3100 Instrument

3100 NT
Workstation

Detector

External computer with:
• GeneScan Analysis software
• DNA Sequencing Analysis software

External computer with customized
software prepared with ABIF
Sample File Toolkit

Sequence
Collector
database

Instrument
database

LIMS database

3100 Data Collection
software

GeneScan Analysis
software

DNA Sequencing Analysis
software

ABIF sample files

Import
data

to create
plate

records

Export
unanalyzed

data

Export unanalyzed
or analyzed data

External computer
with sample records
in a spreadsheet
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GeneScan Analysis on the 3700 Instrument 

 

Flowchart

External Computers 3700 Instrument

3700 NT
WorkstationExternal computer

with sample records
in a spreadsheet

Detector

External computer with customized
software prepared with ABIF
Sample File Toolkit

Sequence
Collector
database

LIMS database

3700 Data Collection
software with database

DNA Sequencing Analysis
software

Data Extractor

ABIF sample filesAuto-analysis feature

Import
to create

plate
records

Decision point

Unanalyzed data

Export
unanalyzed

data

Export unanalyzed
or analyzed data

GeneScan Analysis
software

External computer with:
• GeneScan Analysis software
• DNA Sequencing Analysis software
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Sequence Collector
Database Option

 

With the Sequence Collector database system, data is collected by the 
Windows NT-based computer and exported to a Sequence Collector 
database on a networked server. 

The data can later be viewed, edited, and analyzed using the 
GeneScan Analysis Software version 3.7 for Windows NT

 

®

 

, either using 
the same Windows NT-based computer used to collect the data, or a 
different Windows NT-based computer with access to the Sequence 
Collector database. The data can also be viewed and edited (but not 
analyzed) using the GeneScan Analysis Software on a Macintosh

 

®

 

 
computer.

 

Related Manuals

 

GeneScan Analysis Software is part of a suite of Applied Biosystems 
hardware and software products. 

If the information you need is not in this manual, it may be in one of the 
other manuals listed in the table below. 

 

For more information about… See… Part Number

 

ABI P

 

RISM

 

®

 

 3700 DNA Analyzer

 

ABI P

 

RISM

 

 3700 DNA Analyzer User’s 
Manual 

4325941

ABI P

 

RISM

 

®

 

 3100 Genetic Analyzer

 

ABI P

 

RISM

 

®

 

 3100 Genetic Analyzer User’s 
Manual

 

4315834

ABI P

 

RISM

 

®

 

 377 DNA Sequencer

 

ABI P

 

RISM

 

®

 

 377 DNA Analyzer User’s 
Manual

 

4325703

ABI P

 

RISM

 

®

 

 310 Genetic Analyzer

 

ABI P

 

RISM

 

®

 

 310 Genetic Analyzer User’s 
Manual

 

4317588

 

specific GeneScan chemistry 
protocols, designing experiments, and 
preparing samples

 

�

 

GeneScan

 

®

 

 Reference Guide, 
Chemistry Reference for the ABI 
P

 

RISM

 

 310 Genetic Analyzer, or

 

�

 

The protocols that accompany Applied 
Biosystems reagent kits.

4303189

attaching the new matrix to an 
ABI P

 

RISM

 

 377 gel file

 

Gel Processor User’s Manual

 

 

accessing and managing a Sequence 
Collector database

 

Sequence Collector User Guide NT

 

4319527

installation and administration of 
Sequence Collector

Sequence Collector Installation and 
System Administration Guide

4319526
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Registering the Software

License and
Warranty

Before you begin, read Appendix G, “License and Warranty.” This 
appendix explains your rights and responsibilities regarding the 
software.

Registering Your
Software

To register your copy of the GeneScan Analysis Software, complete the 
registration card (included in this software package) and return it to 
Applied Biosystems. 

Note Registering the software enables us to send you notification of software 
updates and any other future information that may be specific to GeneScan 
Analysis Software owners.

IMPORTANT Your product registration number is located on the Registration 
card. Be sure to record this number here before you return the Registration 
card.

Registration Number:
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Hardware and Software Requirements

Introduction The GeneScan Analysis Software can be installed on the Windows 
NT®-based computer connected to your ABI PRISM® instrument or on 
any other Windows NT-based computer that meets the minimum 
requirements stated below. The software can be installed on a 
computer used for analysis only, and on one used for both data 
collection and analysis.

Computers
Connected to

Applied
Biosystems

Instruments

The following table provides important information about computers 
connected to Applied Biosystems instruments:

If... Then...

you received this software with a 
newly purchased instrument

the GeneScan Analysis Software 
was installed by your Applied 
Biosystems Customer Support 
Engineer as part of the installation 
and setup of the instrument. 

The system requirements for that 
computer are described in the 
instrument user’s manual.

you are updating the GeneScan 
Analysis Software, or if you are 
installing the software on a computer 
other than the one supplied with 
your instrument

ensure your computer meets the 
minimum requirements provided 
below before loading the software.

IMPORTANT Your computer 
MUST meet the requirements listed 
to run the new GeneScan Analysis 
Software. 
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System
Requirements

Below are the system requirements to run the GeneScan Analysis 
Software v. 3.7 for Windows NT® platform on your instrument or 
analysis computer.

IMPORTANT Applied Biosystems strongly recommends using the computer 
supplied with your instrument for running GeneScan Analysis software. The 
software was optimized and tested on systems similar to that shipped with your 
instrument. Running the software on systems that do not meet the following 
requirements may cause data loss or other significant problems. 

Note These are the minimum requirements. In general, the more memory, the 
larger the screen size, and the more processing power you have, the better. 

Minimum System
Recommendations

System 
Component

System Requirements

For use with 310 and 377 
Instruments

For use with 3100 and 
3700 Instruments

Model Dell 733 GX 100 Medium 
Desktop

Dell WorkStation 220

Processor 
Speed/Bus

733 MHz/133 MHz 733 MHz/133 MHz

CD-ROM drive Any Any

Operating 
system

Windows NT v. 4. with 
Service Pack 5

Windows NT v. 4. with 
Service Pack 5

RAM The minimum memory 
requirement is 128 MB, 
although 256 MB is 
recommended. 

256 MB RAM

System 
Component Recommendations

Monitor A 17-inch monitor or larger with 1024 x 768 resolution 

Disk Space Storage requirements depend primarily on the quantity of 
data to be generated and stored. It is common to store 
many sample files on the analysis computer.

Each sample file is approximately 150–250 KB. 

Printer A PostScript-compatible color printer
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Hard Drive
Partitions

Use the following information to determine on which drive to install 
software. During installation, the hard drive of the Windows NT-based 
computer was partitioned to create the following drives: 

When installing... Use drive...

programs for general use C.

� Data Collection program 
database software

� GeneScan Analysis software

D.
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Installing the GeneScan Analysis Software

Preparation

Procedure

To prepare for the installation:

Step Action

1 Check that you have at least 40 MB of free disk space to 
accommodate the GeneScan Analysis Software. 

2 Exit all programs that are running.

3 Turn off any virus protection software that you may have running.

To install the GeneScan Analysis Software from a CD-ROM:

Step Action

1 Insert the GeneScan v. 3.7 software CD-ROM into the computer’s 
CD-ROM drive. It will automatically launch the setup when you 
insert the CD and install the software. 

2 If it does not run the setup automatically, you can either:

� Double-click Setup (.exe)  or 

� Click Start, point to Run, then browse to the CD-ROM drive and 
click OK 

Follow the instructions to install the software.

The Setup Complete window opens when the setup has finished 
installing the software on your computer.
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Starting the GeneScan Analysis Software for the First Time

Procedure Follow this procedure when you start the GeneScan Analysis Software 
the first time or when you start the software after moving the application 
from the Applied Biosystems folder.  

To start the GeneScan Analysis Software for the first time: 

Step Action

1 Before opening the GeneScan Analysis Software for the first time:

a. Click Start, point to Settings, and click Printers.

b. Right-click the printer you expect to use for GeneScan Analysis 
Software data.

c. Click the Close button in the Printers window.

2 Go to the D:\AppliedBio\GeneScan\Bin folder and double-click the 
GeneScan icon  to start the software. 

The GeneScan Analysis Software startup screen opens.
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3 The Product Registration dialog box opens. 

Enter your registration information into the three fields and click OK.

Note The registration code is the number you recorded on 
page 1-8. 

This dialog box opens the first time you start the GeneScan 
Analysis Software, and any time that you move the software to a 
different disk or partition.

4 When the Product Registration dialog box closes, the GeneScan 
Analysis Software menu bar opens.

To start the GeneScan Analysis Software for the first time: (continued)

Step Action

For information about... See Page

Creating a Project 2-9

Opening Sample Files 4-7
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Removing the Software

This section describes how to remove the GeneScan Analysis Software 
v3.7 from your Windows NT-based computer. The uninstall process 
deletes all folders and files installed by the GeneScan Analysis 
Software Installer.

If Files or Folders
Have Been Moved

If you have moved the GeneScan Analysis Software files or folders from 
their original installed locations they may not be found and deleted by 
the uninstall operation. 

Any files that have been added to the application folders, such as those 
created when the applications are run, are not deleted by the uninstall 
operation.

Procedure To remove installed GeneScan Analysis Software: 

Step Action

1 Click Start, point to Settings, click Control Panel, and then 
double-click Add/Remove Programs.

The following dialog box opens:

2 On the Install/Uninstall tab, select GeneScan and click Add/Remove.
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3 At the conclusion of the remove operation, an alert box opens with 
the message whether or not the remove was successful.

4 If files have been moved or added to the GeneScan Analysis 
Software or AppliedBio folders, the remove operation will be 
reported as unsuccessful. 

If this happens do one of the following:

• Examine and delete the remaining files yourself, or

• On the Start menu point to Remove GeneScan Analysis v3.7, 
then select Programs, and Applied Biosystems. 

To remove installed GeneScan Analysis Software: (continued)

Step Action
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Creating a Project 2
Overview

In This Chapter Topics in this chapter include the following:

Topics See Page

Creating Projects and Auto-Analysis on 310 Instruments 2-2

Creating Projects and Auto-Analysis on 377 Instruments 2-3

Setting Up for Automatic Analysis on 3100 and 3700 
Instruments

2-4

Working with Project Files 2-8

Finding Missing Sample Files 2-14

2
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Creating Projects and Auto-Analysis on 310 Instruments

Process Using the
310 Instrument

The following diagram illustrates data analysis using the 
ABI PRISM® 310 Genetic Analyzer.

Collecting 
injection #1

Start 
GeneScan

Analyzing 
Sample file #1

Idle

Add reference to 
Sample file #2
to project

New Project, Add 
Sample file, 
Analyze & Print

Add Sample file 
#1 to Run folder

 Add Sample 
file, Analyze & 
Print

Add Sample file 
#2 to Run folder

Data- 
Collection 
and Analysis 
completed

Run folder 
with 
analyzed 
Sample files

Project with 
all 
references 

Create project and 
add reference to 
Sample file #1

• • •

• • •
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Creating Projects and Auto-Analysis on 377 Instruments

Process Using the
377 Instrument

The following diagram illustrates the process of automatic analysis and 
project creation for data from the ABI PRISM® 377 DNA Sequencer.

Extract 
sample

Start 
GeneScan

Analyzing 
Sample file #1

Add reference to 
Sample file #2
to project

New Project, Add 
Sample file, 
Analyze & Print

Add Sample file 
#1 to Run folder

 Add Sample 
file, Analyze & 
Print

Data- 
Collection 
and Analysis 
completed

Run folder 
with 
analyzed 
Sample files

Project with 
all 
references 

Create project and 
add reference to 
Sample file #1

• • •
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Setting Up for Automatic Analysis on 3100 and 3700 Instruments

Introduction To set up the GeneScan® Analysis Software for automatic analysis after 
data-collection, you must have previously defined analysis parameters 
and size standards.

For more information refer to the following sections:

� “Chapter 5, “Working with Analysis Parameters.”.

� “Defining the Size Standard” on page 7-3.

Procedure To set up for automatic analysis after using the 3100 and 3700 Data 
Collection software: 

Step Action

Complete the following steps in the 3100 and 3700 Data Collection software.

1 Set the GeneScan Run default preferences to auto-analyze and 
use the pop-up menu to locate and select the GeneScan Analysis 
Software.

2 In the GeneScan Sample Sheet, for each sample to be analyzed, 
do the following:

� Enter the sample name.

This field must be completed for the samples to be active in the 
Injection or Run Sheet.

� Indicate which dye is the standard.

� Select the check box labeled Pres (Present) for each 
dye/sample you want auto-analyzed.

� Select any additional check boxes.

IMPORTANT If you plan to use the Genotyper® software, you 
must complete the Sample Info box correctly. For more information, 
refer to the Genotyper User’s Manual.
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3 In the Injection List or Run Sheet for each applicable sample, select 
AutoAnalyze, and choose one of the following from one of the 
appropriate pop-up menus:

� Matrix file

� Analysis parameters

� Size standard 

The following table lists considerations when choosing a size 
standard.

4 Select Auto Print to print automatically.

Complete the following steps:

1 If you are using the Auto-Analysis defaults, choose Auto-Analysis 
Defaults from the Settings menu.

The Auto-Analysis Defaults dialog box opens.

The parameters set in the Auto-Analysis Defaults dialog box apply 
when you have:

� Specified <Analysis Defaults> in the Data Collection software.

� Selected the check box labeled Always Override Collection 
Settings.

To set up for automatic analysis after using the 3100 and 3700 Data 
Collection software: (continued)

Step Action

If you choose a... Then GeneScan...

Size Standard definition file in 
the Collection Injection List or 
Run Sheet, but you do not 
specify which dye is the 
standard in the Sample Sheet

performs analysis using the 
dye specified in the 
Auto-Analysis defaults.

dye as the standard in the 
Sample Sheet, but do not 
specify a size standard 
definition file in the Collection 
Injection List or Run Sheet

does not perform size calling.
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2 Select the check box labeled Always Override Collection Settings to 
have the new parameters take precedence over the following files 
specified in the 3100 and 3700 Data Collection programs:

� Size standard

� Analysis parameters

� Dye standard

3 Select a new Size Standard if:

� Analysis Defaults is specified for the size standard in the data 
collection settings, or

� To override the specified size standard.

4 Select the Dye pop-up menu to specify the dye that represents the 
internal size standard you are running with the samples.

5 Select the analysis parameters you want to use from the 
Parameters pop-up menu.

To use the default parameters, select Analysis Parameters.

6 In the Auto-Print section, there are the following options:

7 Click OK.

The GeneScan Analysis Software is now prepared to perform 
automatic analysis.

Note The settings that you specify are initial settings. Make two 
or three trial runs, fine tuning the parameters with each run, to 
determine which parameters work the best for a particular protocol.

To set up for automatic analysis after using the 3100 and 3700 Data 
Collection software: (continued)

Step Action

Choose... To print...

Show Electropherograms electropherograms.

Select the appropriate radio 
button to specify whether the 
electropherograms for the four 
dyes appear:

� Together in one panel 
(overlaid), or 

� In separate panels (tiled).

Show Tabular data tabular data.
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What Is a Project A project is a file containing references to a set of sample files that you 
want to analyze and display together. The project contains Analysis 
Control (Ctrl+1) and Results Control (Ctrl+2) windows that allow you to 
analyze specific dye/samples and display the results of analysis.

Why Create a
Project

You can create a new project and add any combination of sample files, 
allowing you to analyze and display samples from different runs. 

Adding a sample file to the project sets up a link between the project 
and the sample file. The file itself is not imported into the project.

For more information, see “Creating a New Project” on page 2-9.

Where to Store
Projects

Keep the sample files in the same location on the hard disk relative to 
the project file so the GeneScan® Analysis Software can locate them 
when the project is opened.

If... Then...

sample files are moved and the 
software does not find them when 
you open the project

see “Finding Missing Sample Files” 
on page 2-14.
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Working with Project Files

Opening an
Existing Project

To open an existing project:

Step Action

1 Select Open (Ctrl+O) from the File menu.

The Open Existing dialog box opens.

2 Click the Project icon.

An Open dialog box opens.

3 In the dialog box, find and select the project you want to open.

4 Click Open.

The project opens in an Analysis Control window.
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Creating a New
Project

To create a new project:

Step Action

1 Select New (Ctrl+N) from the File menu. 

The Create New dialog box opens.

2 Click the Project icon. 

An untitled Analysis Control window opens.

Note For more information on using the Analysis Control window, 
refer to page 3-6.

3 There are two ways to add files to a project: 

To add... Select...

sample files you select to the 
open project

Add Sample Files (Ctrl+B) from 
the Project menu.

The Add Sample dialog box 
opens (refer to “Using the Add 
Sample Dialog Box” below).

a sample currently open to the 
open project

Add “file name” from the 
Project menu.
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Using the Add Sample Dialog Box

To use the Add Sample dialog box: 

Step Action

1 When the Add Sample Files dialog box opens, find the folder 
containing the samples that you want to add from the Look in 
pop-up menu.
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2 You can take the following action:

3 Click Finish when you have added all the sample files.

To use the Add Sample dialog box: (continued)

Step Action

If you want to... Then...

select a single sample file double-click the file or select 
the file and click Add.

select all the sample files click Add All.

add a random selection of 
sample files

click each file name while 
pressing the Ctrl key.

add a continuous list of 
sample files

a. Click the first sample that 
you want to add.

b. Press the Shift key and 
click the last sample you 
want to add.

All the files between the first 
and last file are selected.

If the... Then...

sample files appear in the 
Analysis Control window

refer to “Analyzing Sample 
Files: Using the Analysis 
Control Window” on page 3-6.

locked files alert appears (see 
below)

go to “Unlocking Sample Files” 
below.
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Unlocking Sample
Files

Adding Locked Sample Files to a Project

Procedure

If... Then...

the sample files added to a project 
are locked

the GeneScan Analysis Software 
does not allow changes to them. 

You cannot analyze locked files. 
When you add locked files, an alert 
appears.

To unlock files:

Step Action

1 Select Save Project (Ctrl+S) from the File menu and close the 
project.

2 Click the Start button, and then point to Programs.

3 Click Windows NT Explorer.

4 Select the applicable sample files and select Properties from the 
File menu.

The Properties dialog box opens.

5 In the Attributes section, unselect the Read-only check box and 
click OK.

6 Close the window and reopen the project.

If... Then...

you did not close the project 
before unlocking the files

once the files are unlocked, 
close and open the project so 
the GeneScan Analysis 
Software recognizes that the 
sample files are unlocked.
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Removing Samples
from a Project

Note A removed sample file is not deleted from the hard disk. The reference 
is removed from the project.

To remove sample files from a project: 

Step Action

1 Select the file or files in the Analysis Control window (Ctrl+1) or the 
Results Control window (Ctrl+2) that you want to remove.

Note Ctrl+click to select multiple files.

2 Select Remove Sample Files from the Project menu, or press the 
Delete key.

A warning dialog box opens.

3 Click Remove.
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Finding Missing Sample Files

When Are Files
Considered Lost

The project and related sample files are usually located in the Run 
folder created by the Data Collection software. 

When an Alert
Appears

The following table describes what happens when the software does 
not locate the sample files associated with a project:

Searching for
Missing Sample

Files

You can re-establish the links between the sample files and the project 
by choosing Find Missing Sample Files from the Project menu and 
choosing one of the following options from the submenu:

If... Then...

the sample files or the project are 
moved so they are no longer in the 
same relative position 

the GeneScan Analysis Software 
might not be able to locate the 
sample files when the project is 
opened. 

Usually, this occurs only if the 
sample files are moved to another 
disk drive, another server on a 
network, or another disk partition on 
the hard drive. 

If... Then...

the GeneScan Analysis Software 
does not locate the sample files 
associated with a project

an alert box opens and the sample 
file names appear dimmed when the 
project opens.

To find missing files:  

Choose... If you... Description

Fast Search suspect that the 
GeneScan Analysis 
Software could not find 
the missing sample 
files because they are 
located on an 
unmounted external 
storage device, or 
diskette.

Once the volume is 
mounted, or the 
diskette containing the 
files is inserted, Fast 
Search finds them 
immediately.
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Re-Establishing
Links

Search a Folder know what folder 
contains the missing 
sample files.

Specify a folder in 
which to search for 
missing sample files. 

The GeneScan 
Analysis Software then 
immediately locates 
the sample files and 
re-establishes links to 
the project.

Exhaustive Search do not know where any 
of the specified missing 
sample files are 
located. 

The GeneScan 
Analysis Software 
searches all mounted 
disk drives, and 
available servers. 

When the files are 
found, the software 
re-establishes links to 
the project.

To find missing files: (continued)

Choose... If you... Description

To re-establish the links with sample files: 

Step Action

1 Click the dimmed file name to select it.

When the missing file is selected the Find “file name” command 
becomes active. 

The name of the missing file appears inside the quotation marks.

2 Select Find “file name”.

A file dialog box opens.

3 In the file dialog box, locate the proper folder and file.

4 Click Open or double-click the file name.
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Procedure To set up for automatic analysis after data collection, complete the 
following steps in the data collection software: 

Step Action

1 Set the GeneScan Run default preferences to auto-analyze and 
use the pop-up menu to locate and select the GeneScan Analysis 
Software.

2 In the GeneScan Sample Sheet, for each sample to be analyzed, 
do the following:

� Enter the sample name.

This field must be completed for the samples to be active in the 
Injection or Run Sheet.

� Indicate which dye is the standard.

� Select the check box labeled Pres (Present) for each 
dye/sample you want auto-analyzed.

� Select any additional check boxes.

IMPORTANT If you plan to use the Genotyper® software, then 
you must complete the Sample Info box correctly. For more 
information, refer to the Genotyper User’s Manual.

3 In the Injection List or Run Sheet for each applicable sample, select 
AutoAnalyze, and choose from the appropriate pop-up menus one 
of the following:

� Matrix file or dye set name

� Analysis parameters

� Size standard 

The following table lists considerations when choosing a size 
standard. 

4 Select Auto Print to print automatically.

If you choose a... Then GeneScan...

Size Standard definition file in 
the Collection Injection List or 
Run Sheet, but you do not 
specify which dye is the 
standard in the Sample Sheet

performs analysis using the 
dye specified in the 
Auto-Analysis defaults.

dye as the standard in the 
Sample Sheet, but do not 
specify a size standard 
definition file in the Collection 
Injection List or Run Sheet

does not perform size calling.
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Analyzing Project 
Files 3
Overview

In This Chapter Topics in this chapter include the following:

Topics See Page

Analyzing Project Files: About the Analysis Control Window 3-2

Analyzing Sample Files: Using the Analysis Control Window 3-6

Defining Folder Locations 3-16

3
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Analyzing Project Files: About the Analysis Control Window

Introduction When you open a project, the Analysis Control window opens. The 
Analysis Control window is the main window of a project. You can use 
this window to specify the following for each sample in the project:

� Dye that represents the size standard you ran with the sample

� Size standard

� Analysis parameters

� Specific dyes to be analyzed

� Format the document and print the results automatically 

For more information, refer to “Analyzing Sample Files: Using the 
Analysis Control Window” on page 3-6.

Analysis Control
Window Example

The following is an example of the Analysis Control window: 

1

2

3

54

67
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Analysis Control
Window Callouts

Described

The following table describes the callouts shown for the Analysis 
Control window in the above figure: 

Analysis Control window callouts: 

Callout Description

1 Use these columns to choose the dye colors to analyze and to 
specify which is the size standard.

2 Diamonds mark the standards.

For more information, refer to “What Are Size Standards” on 
page 7-2.

3 Ctrl+click a dye/sample field to specify that dye/sample as the 
standard.

4 From the arrow pop-up menu , you can:

� Choose Collection Setting.

� Choose a user-defined size standard.

� Define a new size standard for that sample.

For more information, refer to: 

5 From the arrow pop-up menu , you can:

� Choose Collection Setting.

� Choose an analysis parameters file.

For more information, refer to:

Topic See Page

Defining the Size Standard 7-3

Using Size Standards 7-9

Topic See Page

About the Analysis Parameters 5-2

Using Analysis Parameter Files 5-13
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Customizing the
Display

The following table explains how you can customize the display by 
changing the settings:

Note These preferences also apply to the Results Control window. Refer to 
Chapter 8, “Evaluating Analysis Results.” 

6 Double-click the size standard text field or the analysis 
parameters text field to edit the size standard or the analysis 
parameters.

For more information, refer to:

7 A notation appears in this Information Display field when you 
move the cursor over a sample file name or over a dye color field.

Note For more information on how to customize this field, refer 
to “Displaying Sample and Dye Information” on page 3-11.

Analysis Control window callouts: (continued)

Callout Description

Topic See Page

Editing an Existing Size Standard 7-10

Changing an Existing Analysis Parameters File 5-17

To change... Choose... For more information

information 
displayed in the 
information display 
field

Project Options from the 
Settings menu and 
Sample Info Display from 
the submenu.

“Displaying Sample and 
Dye Information” on 
page 3-11.

the sorting of 
sample files

Project Options from the 
Settings menu and 
Sample File Sorting from 
the submenu.

“Setting Sample File Sort 
Order” on page 3-13.

dye indicator code Preferences from the 
Settings menu and Dye 
Indicators from the 
submenu.

“Setting Dye Indicator 
Preferences” on 
page 3-14.

dye color
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Using the Analysis
Control Window

To... Then... Result

select all the samples click the upper-left cell. All the columns in the 
Analysis Control 
window are selected.

select all of one dye 
color

click the column 
heading for that dye 
color.

The column is 
highlighted for the color 
selected.

select all dyes for one 
sample

click the row number. All the colors in the row 
are selected.

change all the 
standards in the size 
standards column to 
the same setting

a. Click the arrow in 
the column heading.

b. Select a file from 
the pop-up menu.

The same size 
standard is displayed 
for all the samples.

change a size standard 
in one of the rows

a. Click the arrow in 
the row.

b. Select a file from 
the pop-up menu.

The size standard for 
the selected row 
changes.

change all the 
parameters in the 
parameters column to 
the same setting

a. Click the arrow in 
the row heading.

b. Select a file from 
the pop-up menu.

The same parameter is 
displayed for all the 
samples.

change a parameter in 
one of the rows

a. Click the arrow in 
the row.

b. Select a file from 
the pop-up menu.

The parameter for the 
selected row changes.

apply a choice to 
selected fields in the 
size standards or 
parameters column

a. Click the row in the 
column containing 
the information you 
want to apply and 
drag down.

b. Select Fill Down 
(Ctrl+D) from the 
Edit menu. 

The value in the 
selected rows changes 
to the value in the first 
row selected.

Click here
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Analyzing Sample Files: Using the Analysis Control Window

Introduction This section describes using the Analysis Control window to perform 
the following tasks:

Accessing Sample
Files

There are two ways to access sample files contained in a project from 
the Analysis Control window. 

Note Sample files that are dimmed can not be found by the project. To find 
missing files, refer to “Finding Missing Sample Files” on page 2-14.

Topic See Page

Accessing Sample Files 3-6

Analyzing Sample Files 3-7

Specifying the Format for Printed Results 3-8

Displaying Size Standards and Analysis Parameters 3-10

Displaying Sample and Dye Information 3-11

Setting Sample File Sort Order 3-13

Setting Dye Indicator Preferences 3-14

You can... Then...

double-click a sample file name

select a sample file and select one 
of the five display modes from the 
Sample menu

the Sample File window appears in 
the display mode selected.

If the sample 
file is... Then that...

open Sample File 
window 
becomes 
active.

not open sample file 
opens to its 
Sample Results 
view.
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Analyzing Sample
Files

The Analysis Control window (Ctrl+1) allows you to analyze multiple 
samples easily. You choose dyes to analyze, dye standard, size 
standard, and analysis parameters for each sample file, and then 
analyze the sample files using these settings. 

To analyze sample files: 

Step Action

1 Click the dye color fields for each sample you want to analyze as 
follows: 

2 Identify the sample containing the standard as follows:

A diamond appears in the field to identify the dye color as the size 
standard.

3 Select a defined size standard setting from the pop-up menu in the 
Size Standard column as follows: 

4 To install a new matrix, select a set or all of the samples in the 
Sample File column and choose Install New Matrix from the Sample 
menu.

To... Click the...

select a dye for all samples colored column header for that 
dye.

select all dyes for a single 
sample file

index number at the left end of 
the row in which the sample file 
appears.

all dyes for all samples area above the row index 
numbers.

To...  Ctrl+click the...

identify each sample that 
contains a size standard

colored field that represents 
the size standard.

select the same dye as the 
size standard for all samples

colored column heading for 
that dye.

To... Refer to...

define a new size standard “Using Size Standards” on 
page 7-9.

edit a size standard “Editing an Existing Size 
Standard” on page 7-10.
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Specifying the
Format for Printed

Results

5 Select a parameter setting from the pop-up menu in the Parameters 
column as follows:

6 Select the Print Results check box to print the results automatically.

For information on print set-up, refer to “Specifying the Format for 
Printed Results” on page 3-8.

7 Click Analyze.

8 To verify the results, refer to “Process of Verifying Results” on 
page 9-31.

To analyze sample files: (continued)

Step Action

To... See...

use the default analysis 
parameters to specify different 
parameters

“About the Analysis 
Parameters” on page 5-2.

To specify the format for printed results: 

Step Action

1 In the Analysis Control window (Ctrl+1), select the check box 
labeled Print Results. 

When this check box is selected, the Print Setup button becomes 
active.
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2 Click the Print Setup button. 

The Auto Print Setup dialog box opens (see below). 

All the dyes selected for analysis are also selected for printing.

3 Moving the cursor over a Sample File name or over a dye color 
field, a notation appears in the Sample Information Display field.

4 Click the sample dye color fields to specify any sample you do not 
want to print as shown above.

To specify the format for printed results: (continued)

Step Action

Sample Dye color fields

Sample Information Display field
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Displaying Size
Standards and

Analysis
Parameters

Use the Analysis Control window to open, review, or change size 
standard and analysis parameters.

To display these files:

5 Select the format by clicking either or both of the buttons at the right 
of the window.

6 Click OK.

To specify the format for printed results: (continued)

Step Action

Click this button... To print...

electropherograms for the 
samples and dyes selected for 
analysis.

Select the appropriate radio 
button to specify whether the 
electropherograms for all the 
dyes appear:

� Together in one panel 
(overlaid), or 

� In separate panels (tiled).

tabular data.

You can... Then...
For more information 
see...

double-click the field 
containing the size 
standard or the 
analysis parameters 
file

the Size Standard or 
Analysis Parameter 
window opens.

� “Using Analysis 
Parameter Files” on 
page 5-13.

� “Defining the Size 
Standard” on 
page 7-3.
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Displaying Sample
and Dye

Information

How to Display Sample and Dye Information

Move the cursor over a dye color field or over a sample file name field to 
display information about the samples and dyes.

How to Specify the Information Displayed

The following procedure describes how to specify the information 
displayed when moving the cursor over a dye color field or a sample file 
name field:

To specify the information displayed: 

Step Action

1 Select Project Options from the Settings menu and Sample Info 
Display from the submenu.

The Sample Info Display dialog box opens.

2 Select the check boxes in the Dye/Sample Info & Legend section to 
control what appears when you move the cursor over the dye color 
fields in the Control windows.

The following table describes the check boxes:

If you select this check box... This appears...

File Name Sample file name.

Sample Name Name of the sample file from 
the sample file.

Sample Info Sample information from the 
sample file.

Comment Comment from the sample file.
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3 In the Sample File Info heading, select the check boxes for the 
information that you want to display when you move the cursor over 
the Sample File name field.

The following table describes the buttons:

4 Select the check box labeled Save as Defaults to have the options 
you choose saved as the default settings.

5 Click OK.

To specify the information displayed: (continued)

Step Action

Select this button... To display...

Show User Name user name from the sample file.

Show Instrument Name instrument name from the 
sample file.

Show Path Name path and name of the folder 
where the file is located.

Show Run Date run date and start time from the 
sample file.

Show Creation Date date and time the sample file 
was created.
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Setting Sample
File Sort Order

Use this option to specify how sample files are sorted using three 
criteria. If no sorting option is specified, then the program sorts by 
sample number.

To set sample file sort order: 

Step Action

1 Select Project Options from the Settings menu and Sample File 
Sorting from the submenu. 

The Sample File Sorting dialog box opens.

2  From the pop-up menus, select from the following items:

� File Name

� Directory

� Sample Number

� User Name

� Instrument Name

� Run Date

� Creation Date

� As Added (sorts the files in the order that they were added)

The precedence indicates the sorting level. 

3 Select a button for each item to indicate whether to sort in 
ascending or descending order.

4 Select the check box labeled Save as Defaults to have the options 
you choose saved as the default settings.

5 Click OK.
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Setting Dye
Indicator

Preferences

The following procedure describes how to change the defaults that 
determine what dye colors appear on the screen and on printed results. 
Setting default dye and plot colors sets the colors used for both the 
Control windows and the Results displays:

To set default dye and plot colors: 

Step Action

1 Select Preferences from the Settings menu and Dye Indicators from 
the submenu. 

The Preferences window opens. 

If the Preferences window is already displayed, select Dye 
Indicators from the pop-up menu. 

Note Use the scroll bar to see the orange dye color. 

2 The following table describes the Dye Color and Plot Color columns:

3 Use the vertical scroll bar to change the dye color and plot color for 
a fifth dye.

Vertical scroll bar

Item Description

Dye Color 
column

Shows the colors that represent the dyes in the 
Control window list.

The dye color is also identified in the left color 
legend in the Results display.

Plot Color 
column

Shows the colors used for plotting the data in 
the electropherograms.
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4 To change a code, type a different character in the appropriate 
entry field in the Code column.

5 Take the following action to change a color:

6 Click OK when finished changing dye indicator preferences.

To set default dye and plot colors: (continued)

Step Action

To... Then...

change a color select a new color from the pop-up 
menu.

define a new color Select Other from the pop-up menu.

A color picker opens.
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Defining Folder Locations

Introduction The GeneScan Analysis Software looks in the designated folders for 
the: 

� Size Standard file 

� Analysis Parameter file 

� Matrix file 

When saving one of these files for the first time, the default folder 
locations for saving the files are those same designated folders.

Storing Matrix
Files

Store matrix files, that are intended for use by Data Collection software 
to assign to collection runs, in the AppliedBio folder. The AppliedBio 
folder is located on the computer on which the Data Collection software 
is installed.

If Data Collection and Analysis are Performed on Different Computers

Make a copy of a matrix and store it as follows. This is useful when data 
collection and analysis are performed on different computers.

Note The ABI PRISM® instrument Data Collection software uses the files 
installed by the GeneScan Analysis Software in the AppliedBio folder. When 
you run the analysis software, the program also creates several files (such as a 
Preference file) and an Analysis Log.

Store a copy in the... For use by the...

AppliedBio folder Data Collection software.

GS Matrix Folder GeneScan Analysis Software.
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Analyzing Sample 
Files 4
Overview

In This Chapter Topics in this chapter include the following:

Topics See Page

About Sample Files 4-2

Converting Macintosh Computer Sample Files 4-3

Converting Sample Files for Use on a Different Platform 4-4

Opening Sample Files 4-7

About the Sample File Window 4-8

Sample Results View 4-9

Sample Info View 4-11

Size Curve View 4-20

Raw Data View 4-22

EPT Data View 4-24

Analyzing a Sample File 4-26

4
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About Sample Files

Sample File
Generation on 377

The Gel Processor bundled with 377 Data Collection software creates 
Sample files after extracting lanes. The information from each lane in 
the gel file is tracked and extracted, and the resulting Sample files are 
placed in their respective sample folder. If you change tracking, lane 
assignment, or Sample Sheet information, you have to regenerate the 
Sample files.

The software consults Sample Sheet information to determine whether 
a lane is used (contains sample). The lane tracker uses this information 
to assign lane numbers to the tracker lines. In addition, the Gel 
Processor Software only extracts those lanes identified as Used.

What Files
Contain

Sample files contain electrophoresis data collected on ABI PRISM® 
instruments. Unanalyzed data contain raw data.

Sample Files Refer to the following table on how Sample files are generated: 

GeneScan software is used to manually analyze, edit and view sample 
files generated on any ABI PRISM instrument. 

Instrument
Software That Generates 
Sample Files Notes

ABI PRISM 310 310 Data Collection Sample file is created after 
each injection. 

Data Collection software 
invokes GeneScan software for 
auto-analysis

ABI PRISM® 377 DNA 
Sequencer

Gel Processor software Gel file is created by 377 Data 
Collection software. Gel 
Processor tracks gels and 
extracts data into Sample files. 
Gel Processor invokes 
GeneScan for auto-analysis. 

ABI PRISM® 3100 Genetic 
Analyzer

ABI PRISM® 3700 DNA 
Analyzer

Data Extractor Sample files are extracted by 
Data Extractor after each run is 
completed. If set for 
auto-analysis, the software is 
invoked to analyze the data. 
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How GeneScan
Analyzes Sample

Files

Converting Macintosh Computer Sample Files

About Converting
Files

When you insert the GeneScan Analysis Software version 3.7 for 
Windows NT® platform CD-ROM into a Macintosh® computer’s 
CD-ROM drive, a folder appears that contains two applications, Mac to 
Win and Win to Mac. 

Use these applications to change sample files created on the 
Macintosh computer to files that can be read by a Windows NT-based 
computer, and to change files that were created on a Windows 
NT-based computer so that they can be read by a Macintosh computer.

The GeneScan® Analysis Software performs the following steps in 
analyzing sample files: 

Step Action

1 Processes the raw data signals to generate analyzed data signal 
and then uses the analyzed signals to detect the signal peaks 
associated with DNA fragments.

2 Performs size calling by identifying the peaks of the in-lane size 
standard found in each sample.

3 Determines the fragment size of each experimental peak within the 
sample based on the size calling curve generated using the size 
standard peaks, the selected size calling method, and by 
comparing it to the pre-defined size standard file.

The algorithmic steps of the process from raw data to analyzed 
data are as follows: 

� Baselining

� Smoothing, if any

� Peak detection
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Converting Sample Files for Use on a Different Platform

Introduction Use the conversion utilities to change sample files created on the 
Macintosh® computer to files that can be read by a Windows NT¤-based 
computer, and to change files that were created on a Windows 
NT-based computer so that they can be read by a Macintosh computer.

IMPORTANT This utility will run only on a Macintosh computer.

Converting
Macintosh Files to

Windows
NT-Based

Computer Files

To convert Macintosh sample files for use on the Windows NT-based 
computer:  

Step Action

1 Insert the ABI PRISM® GeneScan Analysis Software v. 3.7 for 
Windows NT® platform CD-ROM into the Macintosh computer 
where your Macintosh sample files are stored.

2 Double-click the CD-ROM icon.

3 Double-click the Sample File Mac to Win icon to start the application.

The following dialog box is displayed:
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Converting
Windows
NT-Based

Computer Files to
Macintosh Files

4 Click Run.

The following directory dialog box is displayed:

5 Navigate to the folder that contains the sample files that you want to 
convert and click Choose.

The program will perform the task and automatically quit. The 
converted sample files will have the extension .ab1.

To convert Macintosh sample files for use on the Windows NT-based 
computer: (continued)

Step Action

To convert Windows NT-based computer sample files for use on the 
Macintosh computer:  

Step Action

1 Insert the GeneScan Analysis Software v. 3.7 for Windows NT 
platform CD-ROM into the Macintosh computer where your 
Windows NT-based sample files are stored.

2 Double-click the CD-ROM icon.
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3 Click the Sample File Win to Mac icon to start the application.

The following directory dialog box is displayed:

4 Navigate to the folder that contains the sample files that you want to 
convert and click the Choose button.

To convert Windows NT-based computer sample files for use on the 
Macintosh computer: (continued)

Step Action

If... Then...

there are no problems, 
the program will perform 
the task and 
automatically quit

When you open the folder, you can 
double-click the sample files to open 
them using GeneScan Analysis 
Software on a Macintosh computer.
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Opening Sample Files

Introduction Sample files can be opened as separate files outside of projects, and 
display related information about each sample file.

Procedure

To open sample files: 

If you are interested in... Then...

one or two sample files it is often more convenient to open sample 
files individually and analyze or view the 
data without opening an entire project.

multiple sample files use a project. 

For information on opening Sample Files 
from within a Project, see “Accessing 
Sample Files” on page 3-6

To open a sample file as a separate file:  

Step Action

1 Select Open (Ctrl+O) from the File menu. The Open Existing dialog 
box appears.

Note You can also double-click the sample file name in the folder 
containing the files. If the GeneScan Analysis Software is not 
running, the software starts and opens the sample file.
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About the Sample File Window

What It Displays You can use the display modes in the Sample File window to review the 
analyzed and raw data, and all pertinent data collection, sizing and 
sample description information from a single window. The Sample 
Results view appears as the default.

Five Views The five views of the Sample File window are:

2 Click the Sample icon. An Open dialog box appears.

3 In the dialog box, navigate to the folder and select the sample file 
that you want to open.

4 Click Open. The Sample File window appears.

For more information on the Sample File window, refer to page 4-8.

To open a sample file as a separate file: (continued)

Step Action

View See Page

Sample Results View 4-9

Sample Info View 4-11

Size Curve View 4-20

Raw Data View 4-22

EPT Data View 4-24
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Sample Results View

What It Displays The Sample Results View displays the sample file’s analyzed data in 
both electropherogram and tabular data form.

Displaying the
View

The following table describes ways to display the Sample Results View:

To display the view... Do this...

from the Sample File 
window

from a project window a. Select a sample or Ctrl+click to select multiple 
samples in the Analysis Control (Ctrl+1) or the 
Results Control (Ctrl+2) window.

b. Select Sample Results (Ctrl+E) from the 
Sample menu.

You can either Result

click the button for the 
Sample Results view 
at the bottom left of 
the Sample File 
window.

The Sample Results 
View appears. 

Refer to “Example of 
Sample Results View” 
on page 4-10.

select Sample Results 
(Ctrl+E) from the 
Sample menu.
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Example of
Sample Results

View

The following is an example of the Sample Results view: 

Description of
Columns

The following table describes the columns in the above figure:

This column Identifies

Dye/Sample Peak Dye color and Peak number.

Minutes The time, in minutes, from the start of the run to the 
time the fragment was detected.

Size The number of base pairs in the fragment.

This value is calculated automatically only if you:

� Run the size standard in the same lane or injection 
as the sample, and

� Perform size calling.

Peak Height Signal size.

Peak Area Area of the detected peak.

Data point Data point of the fragment at its maximum peak 
height.
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Differences from
the Results Display

The Sample Results view displays the same electropherogram and 
tabular data as the Results Display, with the following differences:

� One sample file is displayed.

� Show or hide dye/sample data by clicking the buttons below the 
electropherogram.

� Cannot display legends.

� Cannot use custom plot colors.

Sample Info View

What It Displays Displays the following sample file information:

Information displayed See Page

Run Information 4-14

Data Collection Settings 4-14

Sample Information 4-14

Gel Information 4-15

Analysis Records 4-15

Dyes Within Analysis Records 4-16

Data Collection Settings 4-17

Gel Information (Polymer) 4-17

Sample Information 4-18

Analysis Records 4-18

Dyes Within Analysis Records 4-19
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Displaying the
View

The following table describes ways to display the Sample Info View:   

To display the view... Do this...

from the Sample File 
window

from a project window a. Select a sample or Ctrl+click to select multiple 
samples in the Analysis Control (Ctrl+1) or the 
Results Control (Ctrl+2) window.

b. Select Sample Info (Ctrl+I) from the Sample 
menu.

The information is organized in four panels. 

Click the triangles to expand or collapse the 
panels to display specific information.

You can either Result

click the button for the 
Sample Info view at 
the bottom left of the 
Sample File window.

The Sample Info view 
appears. 

Refer to “Example of 
Sample Info View” on 
page 4-13.

select Sample Info 
(Ctrl+I) from the 
Sample menu.
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Example of
Sample Info View

The following is an example of the Sample File Information window in 
Sample Info View: 
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Description of
Information

This information is generally applied to Data Collection software. The 
following tables list the information in the Sample Info View:

Run Information

Data Collection Settings

Sample Information

Information found under the 
header Information entered in

� User Name

� Instrument

� Data Collection software version

� Run date and start time

� Tube

� Run Date

� Start Time

� Run Duration

� Total Points

Data Collection software Run file 
and run information

Information found under the 
header Information is entered in

� Module File

� Matrix

� Analysis Parameters

� Size Standard

� Run Voltage, Injection Voltage, 
and Injection Duration

� Temperature 

� Laser power

Data Collection software Run file 
and run information

Information found under header Information is entered in

Sample Name Data Collection software Plate Setup 
RecordSample data and comment for each 

dye color
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Gel Information

This information applies only to samples from the ABI PRISM 377 
instrument. 

Analysis Records

Information found under header Information is entered in 

� Gel Type

� Gel File name

� Gel Percent

� Gel Thickness

� Well-To-Read Distance

� Number of Channels

� Lane Number

� Channel Averaging

� Lane Extraction Range

Data Collection software

Information found under header Information is entered in

Date and time each color was 
analyzed, and more panel-display 
arrows

Analysis information
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Dyes Within Analysis Records

Information found under header Information is entered

Analysis parameters file and range 
analyzed

Analysis Settings

Whether baselined or 
multicomponented

Data smoothing

Peak detection threshold and 
minimum half-width

Polynomial degree

Peak window

Size standard file Analysis Control window

The dye color used for the standard, 
Sizing method, and range

Standard peak detection threshold Analysis Settings

Baseline window size

Slope threshold for peak start

Value for end

Total number of peaks: found in 
sample and dye standard, defined in 
standard matched with standard 
peaks

Analysis results
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Data Collection Settings

Gel Information (Polymer)

Information found under the 
header Information is inserted from

� Module File 

� Matrix File 

� Analysis Parameters 

� Size Standard 

� Electrophoresis voltage, current, 
and power (ABI 373 and 
ABI PRISM 377 only) 

� Run Voltage, Injection Voltage, 
and Injection Duration 
(ABI PRISM 310 only) 

� Temperature 

� Laser power 

ABI 373 or ABI PRISM 377 gel file 
(data collection Run File and run 
information). 

This information is embedded in the 
gel file. 

ABI PRISM 310 data collection Run 
file and run information.

Information found under the 
header Information is inserted from

ABI PRISM 310

� Gel type Optional (user entered) 

� Length to detector Data Collection information

� Lot # and expiration date 

ABI 373 and ABI PRISM 377

� Gel type Optional (user entered).

� Name of gel file Gel file (data collection Run file) 

This information is embedded in the 
gel file.

� Gel percentage and thickness Optional (user entered)

� Well-to-read (separation) 
distance 

� Number of channels Gel file (data collection Run file) 

This information is embedded in the 
gel file.

� Number of Lanes 
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Sample Information

Analysis Records

� Channel Averaging 

Note Zero (0) indicates use of 
pre-averaging offscale data.

The following is an example of how 
pre-averaging offscale data appears: 

Gel processing parameters 

� Range of data points extracted 

Information found under header Information is inserted from

Sample data and comment for each 
dye color 

� ABI PRISM 310 Sample Sheet 

� ABI 373 or ABI PRISM 377 gel file 
(Sample Sheet) 

This information is embedded in the 
gel file.

Information found under header Information is inserted from

Date and time each color was 
analyzed, and more panel-display 
arrows 

Analysis information 

Information found under the 
header Information is inserted from

Extraction method Displayed 

3 channel averaging 3

3 channel averaging 
with pre-averaging 
offscale

30

3 channel 
averaging-weighted

- 3

3 channel 
averaging-weighted, 
pre-averaging 
offscale

- 30
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Dyes Within Analysis Records

Information found under header Information is inserted from

� Analysis parameters file and 
range analyzed 

Analysis Settings 

� Whether baselined or 
multicomponented 

� Data smoothing 

� Peak detection threshold and 
minimum half-width 

� Size standard file Analysis Control window 

� The dye color used for the 
standard, Sizing method, and 
range 

� Standard peak detection 
threshold 

Analysis Settings 

� Split Peak correction 

� Total number of peaks: found in 
sample and dye standard, 
defined in standard matched with 
standard peaks 

Analysis results 
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Size Curve View

What It Displays Displays sizing curves for sample files. The size curve is a measure of 
how well the internal size standard matches the standard definition, and 
whether or not it is linear.

Displaying the
View

The following table describes ways to display the Size Curve View:

To display the view... Do this...

from the Sample File 
window

from a project window a. Select a sample or Ctrl+click to select multiple 
samples in the Analysis Control (Ctrl+1) or the 
Results Control (Ctrl+2) window.

b. Select Size Curve (Ctrl+U) from the Sample 
menu. 

For each selected sample, a Sample File window 
opens and displays its Size Curve view.

You can either Result

click the button for the 
Size Curve view at the 
bottom left of the 
Sample File window.

The Size Curve view 
appears. 

Refer to “Example of 
Size Curve View” on 
page 4-21.

select Size Curve 
(Ctrl+U) from the 
Sample menu.
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Example of Size
Curve View

The Size Curve view displays two curves, as shown in the figure below. 
For a description of the curves, refer to “Curves Described” below.

Curves Described The following table describes the curves in the above figure:

Note Sizing errors due to anomalous mobilities may be displayed as 
nonlinear.

This curve Represents

Red curve The sizecalling curve, based on the sizecalling method 
used to analyze the data.

Black curve The best-fit least squares curve, which the GeneScan 
Analysis Software calculates for all samples, regardless of 
the size calling method. 

This curve is provided to help evaluate the linearity of the 
sizing curve. 

When the sizing curve and best-fit curve match, they 
overlap so you see only the size curve.
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Raw Data View

What It Displays It displays the raw data collected for a sample. This information is stored 
in the sample file.

Displaying the
View

The following table describes ways to display the Raw Data View:

To display the view... Do this...

from the Sample File 
window

from a project window a. Select a sample or Ctrl+click to select multiple 
samples in the Analysis Control (Ctrl+1) or the 
Results Control (Ctrl+2) window.

b. Select Raw Data (Ctrl+R) from the Sample 
menu.

You can either Result

click the button for the 
Raw Data view at the 
bottom left of the 
Sample File window.

The Raw Data View 
appears.

Refer to “Example of 
Raw Data View” on 
page 4-23.

select Raw Data 
(Ctrl+R) from the 
Sample menu.
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Example of Raw
Data View

The following is an example of the Sample File window in Raw Data 
View:

What to Evaluate Use the Raw Data view to evaluate:

� Problems or noise in the baseline that could result in poor size 
calling.

� Start and stop points for analysis. 

For information on changing the horizontal (refer to page 9-21) or 
vertical scale of the data (refer to page 9-22).

Data pointsRelative peak amplitude (signal intensity)
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EPT Data View

What It Displays The EPT Data View (electrophoresis power and temperature) displays 
this information collected for a sample, and it is stored in the sample file.

Displaying the
View

The following table describes ways to display the EPT Data View:

To display the view.... Do this...

from a Sample File 
window

from a project window a. Select a sample or Ctrl+click to select multiple 
samples in the Analysis Control (Ctrl+1) or the 
Results Control (Ctrl+2) window.

b. Select EPT Data (Ctrl+M) from the Sample 
menu, or click the EPT data button.

You can either Result

click the button for the 
EPT Data view at the 
bottom left of the 
Sample File window.

The EPT Data view 
appears. 

Refer to “EPT Data 
View Example” on 
page 4-25.

select EPT Data 
(Ctrl+M) from the 
Sample menu.
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EPT Data View
Example

The following is an example of the Sample File window in EPT Data 
View:

Colored Lines
Described

The following table describes the lines in the above figure:

Blue line

Green line

Black line

Red line

Line Description

Blue Electric voltage in volts/10

Black Electric power in watts

Red Run temperature in  °C

Green Electric current in mA (milliamps)
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Analyzing a Sample File

Introduction The GeneScan Analysis Software analyzes raw data stored in sample 
files according to parameters and standards that you select. You can 
use the analyzed data to detect peaks associated with DNA fragments 
and identify those peaks with an established size standard.

Procedure To analyze a sample file:  

Step Action

1 Select Analyze “Sample File Name” from the Sample menu 
(Ctrl+Y).

The Analyze Sample file dialog box appears.

2 From the Analyze Sample file dialog box, select one of the following 
options: 

3 After analysis, evaluate the results. 

For more information on evaluating the results, refer to Chapter 8, 
“Evaluating Analysis Results.” 

Choose... To select...

Dyes to Analyze check boxes any number of dyes to analyze.

Analyze Parameters pop-up 
menu

from the default parameters or 
any parameter files in the 
folder location specified in the 
application preferences.

Size Standard pop-up menu from the default standard, or 
any standard files in the folder 
location that you specify in the 
application preferences.

Standard Dye pop-up menu the inlane standard dye.
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Installing a New
Matrix File

Use the following procedure to install a new matrix file for the Sample 
file that you want to analyze. 

For information on attaching the new matrix to an ABI 373 or 
ABI PRISM 377 gel file, refer to “Gel Processor User’s Manual.” 

To install a new matrix file: 

Step Action

1 Choose Install New Matrix from the Sample menu.

A directory dialog box appears.

The Folder Preferences settings determine where the GeneScan 
Analysis Software looks for the matrix file. 

For more information, refer to “Defining Folder Locations” on 
page 3-16.

2 Select the new matrix file in the dialog box and click Open.

A message appears when the matrix is successfully assigned.

3 Re-Analyze the Sample file.

Applying a new matrix file clears previous analysis information, so 
you must re-analyze the file.
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Working with Analysis 
Parameters 5
Overview

In This Chapter Topics in this chapter include the following:

Topics See Page

About the Analysis Parameters 5-2

Sizecaller Algorithm Flowchart 5-4

Setting Analysis Parameters 5-5

Using Analysis Parameter Files 5-13

5
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About the Analysis Parameters

What They Are Analysis parameter files are used by 3100 and 3700 Data Collection 
software to inform the software of the parameters to use to 
automatically analyze fragment data. Use the analysis parameters 
provided, or follow the procedure in “Creating GeneScan Analysis 
Modules” on page A-1 to create new analysis parameter files. The 
auto-analysis feature is part of the 3100 and 3700 Data Collection 
software.

These parameters are also used for analysis using the GeneScan® 
Analysis Software.

Why They Are
Necessary

Analysis parameter files are required because the auto-analysis feature 
in 3100 and 3700 software has no user interface, so the parameters for 
analysis cannot be directly configured in the analysis software. The 
GeneScan Analysis Software creates the analysis parameters, and the 
software saves the parameters in a folder that can be read by the Data 
Collection system software that performs auto-analysis.

The analysis parameter file can also be used for manual analysis of 
fragment data. It is then used by auto-analysis while it is processing run 
data.

When to Specify a
Parameter

Before performing a run, specify the analysis parameter to use for 
analysis of each sample. Do this when preparing the plate record for the 
plate that contains the samples on 3100 and 3700 instruments and 
when preparing the run sheet on 310 and 377 instruments.

Note If there is no analysis parameter specified for a particular sample in the 
plate record, the sample will not be analyzed by auto-analysis. Use the 
GeneScan Analysis Software to analyze the data.
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Analysis
Parameter Files

Provided

The following analysis parameter files are provided:

When Analysis
Parameters Are

Used

Analysis parameter files are opened and read by the Data Extractor 
program as each sample is extracted. 

Note If you make a change to an existing analysis parameter file (without 
changing its file name), this change will affect any sample extracted after the 
change is saved.

Analysis parameter file Suggested parameters for using...

GS120Analysis.gsp GeneScan 120 Size Standard

GS350Analysis.gsp GeneScan 350 Size Standard

GS400Cubic Analysis.gsp GeneScan 400 HD Size Standard

GS400HDAnalysis.gsp GeneScan 400 HD Size Standard

GS400Ord2Analysis.gsp GeneScan 400 HD Size Standard

GS500Analysis.gsp GeneScan 500 Size Standard
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Sizecaller Algorithm Flowchart

Flowchart The following flowchart shows how the sizecaller algorithm works:

Baseline

Detect Peaks

Analyzed
Data Ready

Output Results

Select by Size

Clear
Extrapolation

Call Sizes

Make Sizing Curve

Match Size
Standard

Limit Analysis
Range

Input
Electropherogram

Sizecalling
needed?

yes

no

Fragment
Sizes
Ready
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Setting Analysis Parameters

Default Settings The following table describes the default settings for the analysis 
parameters. Some of these parameters will be different depending on 
the analysis setting you select. This is an example of one of the 
settings.  

Parameter Default setting

Analysis Range Full Range

Data Processing Smooth Options–the Light button is selected

Peak Detection Select Analysis Parameters from the Settings menu.The 
Analysis Parameters dialog box opens. 

Full Range Full Range

Sizecalling 
Method

Local Southern Method

Baselining Baseline Window Size 251 points

Auto Analysis Size Standard <None>

Parameter Default setting

Peak Amplitude 
Thresholds

Min. Peak Half Width 2 points

Degree of Polynomial 
differentiation

3

Peak Window Size 19 points

Slope Threshold for 
Peak Start

0.0 

Slope Threshold for 
Peak End

0.0

Dye Setting

Blue 50

Green 50

Yellow 50

Red 50

Orange 50
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Displaying
Analysis

Parameters

Select Analysis Parameters from the Settings menu. The Analysis 
Parameters dialog box opens.

Note To display the orange Peak Amplitude Threshold, use the scroll bar 
under the values and scroll to the right. 
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Analysis
Parameters

There are seven analysis parameters:

Analysis Range
Options

The following are the Analysis Range options:

Data Processing
Options

The Smooth Options only affect the appearance of the analyzed 
electropherograms.

Note Since the tabulated peaks are calculated from unsmoothed data, they 
might not be consistent with the smoothed display. For example, the reported 
peak heights might not be the same as those visible from the smoothed 
electropherogram. It is recommended that you select the None button.

Analysis parameter See Page

Analysis Range Options 5-7

Data Processing Options 5-7

Peak Detection Options 5-8

Sizecall Range Options 5-10

Sizecalling Method Options 5-10

Baselining Option 5-12

Auto-Analysis Only Option 5-12

Item Description

Full Range button Use to analyze all the data collected on the genetic 
analysis instrument for each sample.

This Range 
(Data Points) 
button

Enter Start and Stop data point numbers in the entry 
fields in order to specify only a limited range to be 
analyzed for each sample.

This affects what is displayed in the results display. 
Normally, set the analysis range to start after the 
primer peak.
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Peak Detection
Options

About the Peak Detection Options

The Peak Detection options locate peaks at the positive-to-negative 
zero crossings of the first derivative of the baselined electropherogram. 
The peak detector computes the first derivative at a data point i by fitting 
a polynomial to a window centered on i. 

Peak Detection Parameter Options Described

The following table describes the options:  

Item Description For example

Peak Amplitude 
Thresholds

The sizecaller reports 
to the user only those 
peaks whose heights 
are at least the Peak 
Amplitude Threshold 
for that dye.

Set the dye amplitude 
threshold at a level that 
allows the software to 
detect peaks, but 
eliminate noise. 

For each dye, the 
GeneScan Analysis 
Software detects peaks 
above the threshold 
entered in the entry 
field. 

If you leave the default 
value of 50, peaks with 
amplitude above 50 are 
analyzed and appear in 
the tabular data. 

Lower amplitude peaks 
still appear in the 
electropherogram, but 
are not analyzed and 
do not appear in the 
tabular data.

Minimum Peak Half 
Width

Defines what 
constitutes a peak. 

Use to specify the 
smallest full width at 
half maximum for peak 
detection.

The range is 2–99. 

A typical number might 
be 3 for microsatellites, 
or 10 for SSCPs.

If this number is large, 
the software ignores 
noise spikes. 

If the peaks in the data 
are narrow, set the 
value to a low number. 

Experiment with this 
value to determine the 
best number for the 
data.
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Polynomial Degree Sets the degree of the 
polynomial.

These parameters 
control the sensitivity of 
this process. Sensitivity 
increases with the 
polynomial degree and 
decreases with the 
window size.

Use polynomials of 
degree 2 or 3 for 
well-isolated peaks, 
such as those from a 
size standard, and a 
degree 4 for finer 
control.

For degree 4, the Peak 
Window Size should be 
1 to 2 times the full 
width at half maximum 
of the peaks that you 
wish to detect.

These parameters 
cannot be set for each 
color independently.

Peak Window Size Sets the width of the 
window.

Slope Threshold for 
Peak Start

Slope Threshold for 
Peak End

Determines where a 
peak starts and stops.

For example, a peak 
ends when the first 
derivative again 
exceeds the Slope 
Threshold for Peak 
End. 

Slope Threshold for 
peak start must be 
non-negative and 
Slope Threshold for 
peak end must be 
nonpositive. 

Values other than 0 will 
move the extent of the 
peak toward its center.

The following table describes the options: (continued)

Item Description For example

Min. 
setting

Max. 
setting

2 5

Min. setting Max. setting

1 above the Degree of 
Polynomial 
differentiation setting.

Number of scans 
between peaks.
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Sizecall Range
Options

About the Sizecall Range Options

Use the Sizecall Range parameter options to specify the range of size 
fragment (in base pairs) to be included in the peak tabular data.

Sizecall Range Parameter Options Described 

Sizecalling Method
Options

About Sizecalling Method Options 

Click a button to select the desired sizecalling method. The GeneScan 
Analysis Software uses these methods to determine the molecular 
length of an unknown fragment.

Baseline Window Size Controls the slope of 
the baseliner.

The sizecaller 
determines a baseline 
value for each scan i.

Basically, the sizecaller 
sets the baseline to the 
lowest 
electropherogram 
value that it sees in a 
window of size ß 
centered on scan i.

To achieve symmetry, 
you should set ß to an 
odd value, though even 
values are acceptable.

Small ß will cause the 
baseline to creep up 
into peaks.

Large ß will create a 
baseline that does not 
touch all peaks; that is, 
the peaks will not be 
baseline resolved after 
the sizecaller subtracts 
the baseline from the 
electropherogram.

The following table describes the options: (continued)

Item Description For example

Item Description

Full Range button Select this choice to report all peaks within the range 
of the matched size standard.

This Range 
(Base Pairs) button

Select this choice to limit the reported peaks by 
fragment size.
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Sizecalling Method Parameter Options Described 

Item Description

2nd Order Least Squares and 3rd 
Order Least Squares

Both Least Squares Methods use 
regression analysis to build a best-fit 
sizecalling curve.

For information on the Sizecalling 
Methods, refer to page B-1. 

Cubic Spline Interpolation Forces the sizing curve through all 
the known points of the selected 
GeneScan size standard.

For information on the Cubic Spline 
Interpolation Method, refer to 
page B-4.

Local Southern Method Determines the sizes of fragments 
by using the reciprocal relationship 
between fragment length and 
mobility. 

For information on the Local 
Southern Method, refer to page B-5. 

Global Southern Method Similar to the Least Squares Method 
in that it compensates for standard 
fragments that may run 
anomalously. 

For information on the Global 
Southern Method, refer to page B-7. 



5-12 Working with Analysis Parameters

Baselining Option About the Baselining Option

The Baselining option controls the scope of the baseliner. Use this 
option to set the size Beta of the Baseline Window.The sizecaller 
computes a baseline for the electropherogram of each dye 
independently.

How the Baselining Option Works

A baseline comprises a value at each data point i. Basically, the 
baseline value at each data point i, is the lowest electropherogram 
value in a window whose width Beta is set using the Baselining option, 
and centered at each data point i. 

More accurately, the baseline computed in this manner is intermediate. 
The real baseline value at each data point i, is the highest intermediate 
value, again in a window whose width Beta is set using the Baselining 
options and centered at each data point i. The sizecaller baselines an 
electropherogram by subtracting the baseline from the raw 
electropherogram.

If the Baseline Window Is Too Small or Too Large

The following table describes what happens if the baseline window is 
either too small or too large:

Auto-Analysis
Only Option

When performing auto-analysis, select the Size Standard to use from 
this pop-up menu.

Using... Causes...

a small baseline window size the baseline to creep into the peaks, 
resulting in shorter peaks in the 
analyzed data.

a large baseline window size the baseline to ride too low, resulting 
in elevated and possibly not 
baseline-resolved peaks.
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Using Analysis Parameter Files

In This Section This section contains the following topics:

Assigning the
Same Analysis

Parameters to All
Files

Topic See Page

Assigning the Same Analysis Parameters to All Files 5-13

Assigning Different Parameters to Single Samples 5-15

Displaying Default Parameters 5-16

Creating Custom Analysis Parameter Files 5-16

Changing an Existing Analysis Parameters File 5-17

Deleting Custom Analysis Parameters 5-17

To analyze samples using the same analysis parameters:  

Step Action

1 If the Analysis Control window is not displayed, then select Analysis 
Control (Ctrl+1) from the Windows menu.

2 Click the arrow in the Parameters column heading and choose 
parameters from the pop-up menu. 

Your menu choice applies to all fields in the column.

Note Selecting this pop-up menu automatically selects ALL 
samples. You cannot assign parameters to only a subset of 
samples.

Pop-up menu
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3 The pop-up menu contains the following options:

To analyze samples using the same analysis parameters: (continued)

Step Action

Item Description

Analysis Parameters Applies the parameters that are stored 
as preferences in the software.

Collection Setting Applies the analysis parameters file 
specified in the Data Collection 
software, which is embedded in the 
sample file.

Custom parameters 
that are listed at the 
bottom of the menu

These are files that have been 
predefined and they are located in the 
Params folder.

The path is: 
D:\AppliedBio\Shared\Analysis\
Sizecaller\Params 
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Assigning
Different

Parameters to
Single Samples

To apply separate analysis parameters to selected samples:

Step Action

1 If the Analysis Control window is not displayed, then select Analysis 
Control (Ctrl+1) from the Windows menu.

2 Click the arrow in the Parameters column for the sample parameter 
settings that you want to change.

A pop-up menu opens.

3 The pop-up menu contains the following options:

4 Repeat step 2 and step 3 for each sample.

Note You can also use the Cut, Copy, and Paste commands from 
the Edit menu.

Pop-up menu

Choose... To...

Analysis Parameters apply the parameters that are stored 
as preferences in the software.

Define New display the Analysis Control dialog 
box.

For information on completing the 
fields, see “About the Analysis 
Parameters” on page 5-2.
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Displaying Default
Parameters

There are two ways to display the default parameters:

Creating Custom
Analysis

Parameter Files

You can... Then...

select Analysis Parameters from the 
Settings menu.

the Analysis Parameters dialog box 
opens with the default parameters.

For information on defining the 
Analysis Parameters, refer to 
page 5-2.

double-click Analysis Parameters 
from any entry in the Parameters 
column in the Analysis Control 
window.

To create a custom analysis parameter file:

Step Action

1 Select New from the File menu.

Note You can also select the Define New option from the pop-up 
menu in the Parameters column of the Analysis Control window.

The Create New dialog box opens.

2 Click the Analysis Parameters icon. 

The Analysis Parameters dialog box opens.

3 Change the parameters as necessary. 

For more information on the analysis parameters, refer to page 5-2. 

4 Choose Save (Ctrl+S) from the File menu.

A dialog box opens.

5 Enter a descriptive name and click Save.

The file now opens in the pop-up menu for analysis parameters in 
the GeneScan Analysis Control window. 

You can also select the file in the Data Collection software for 
automatic analysis.
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Changing an
Existing Analysis

Parameters File

Deleting Custom
Analysis

Parameters

To change an existing analysis parameter file: 

Step Action

1 Select Open (Ctrl+O) from the File menu.

Note You can also double-click the file name in the Parameters 
column of the Analysis Control window.

The Open Existing dialog box opens.

2 Click the Analysis Parameters icon. 

An Open directory dialog box opens.

3 Select a file that you want to change and click Open.

4 Make the changes and close the window by clicking OK.

If... Then...

the Params folder does not 
appear

navigate to the folder. 

The path is: 
D:\AppliedBio\Shared\Analysis
\Sizecaller\Params

To delete a custom analysis parameters file:

Step Action

1 Click the Start button, and then point to Programs.

2 Click Windows NT® Explorer and find the file in the folder you 
specified as the location for the analysis parameters files.

Note The custom analysis parameters file is in the folder that is 
normally called the GS Parameters Folder. This folder is inside the 
ABI PRISM GeneScan folder. 

3 Drag the custom analysis parameters file to the Recycle Bin.
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Making a Matrix File6
Overview

This chapter describes the processes of making a matrix file, loading 
and running samples and evaluating the file. You have the option of 
selecting four or five dyes depending on the application when creating a 
new matrix for data collection. 

Note This chapter applies only to the 310 and 377 instruments. 

In This Chapter Topics in this chapter include the following:

Topics See page

About Matrix Files 6-2

Process of Creating a New Matrix File 6-7

Loading and Running Dye Standards for the ABI PRISM 310 6-9

Loading and Running Dye Standards for the ABI PRISM 377 6-12

Generating Matrix Sample Files for the ABI PRISM 377 
Instrument

6-15

Choosing a Scan Range for the Matrix Calculation 6-17

Generating a New Matrix File 6-20

Saving and Naming the Matrix File 6-22

Assigning the Matrix File to Sample Files 6-23

Evaluating the Matrix File 6-25

Causes for Bad Matrix Files 6-26

6
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About Matrix Files

Introduction There are three dye-labeling chemistries currently available to prepare 
nucleic acid samples to use the GeneScan® Analysis Software on ABI 
PRISM® instruments: 

� Fluorescent NHS-Ester

� Fluorescent dNTP

� Fluorescent Phosphoramidite

Each chemistry has a set of dye labels that fluoresce at different 
wavelengths when excited by a laser.

Matrix File
Definition

Matrix files are mathematical matrices that correct for spectral overlap 
of fluorescent emission spectra data collected from ABI PRISM® 
instruments. 

A matrix file allows you to account for spectral overlap when analyzing 
Sample files.

Multicomponent
Definition

This process of eliminating the bleed-through caused by spectral 
overlaps is called multicomponenting. 

Applying a matrix file to raw data allows you to generate 
multicomponented data.

During data collection on the... The wavelengths are separated...

 310 or 377, 377XL, or 96-lane 
upgrade instrument

by a spectrograph into a known 
spectral pattern across a detection 
system with the sequencer.
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Why Is a Matrix
File Necessary

A matrix file is necessary because the four or five dyes used to label the 
fragments fluoresce at different wavelengths and may have spectral 
overlaps, as shown below:

When to Create a
Matrix File

Create a matrix file for each dye set used from that particular instrument 
before analyzing fragment data. 

You may have to create new matrix files for different gel compositions or 
unusual run conditions.
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Sample Files Using
Matrix File

The figures below show examples of data analyzed with and without a 
matrix file. 

You can see that peak data from a Sample file analyzed without a 
matrix file displays the expected peak, along with extra peaks in other 
dye colors, or bleed-through from other dye colors.

Installing a Matrix
File

You can install a matrix file into a gel file or into a Sample file. 

Normally the matrix from a matrix file is installed within a gel file or a 
Sample file automatically upon generation during or after a run. 
Additionally a matrix can be manually installed into a 377/310 Sample 
file from within the GeneScan Analysis Software. 

When to Assign a
Matrix File

Before you can successfully analyze Sample files using the GeneScan 
Analysis Software, you must make a new matrix file or assign an 
existing one to a set of Sample files. 

Limitations to
Matrix Files

You can only assign a matrix file to Sample files generated on the same 
instrument, under the same electrophoresis, gel matrix and buffer 
conditions, and using the same dye set.

Note If you are using a fifth dye, then you need to create a new matrix file for 
that dye.

Sample file analyzed without a matrix file

Sample file analyzed with a matrix file
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When to Create a
New Matrix File

Create a new matrix file in the following conditions:

� For each dye set:

– NHS-Esters

– Phosphoramidite set

– Fluorescent dNTPs

� Whenever you change the dye set you use to label sample 
fragments, for example, if you are using the fifth dye.

� When you use gel materials or buffers with pH values that differ 
greatly from the pH value of the gel material or buffer on which the 
existing matrix files were generated.

� When you use dyes other than those provided by Applied 
Biosystems.

� When you run the same gel on a different instrument.

� When you see multiple unexpected peaks of different colors under 
an expected peak.

� When you recalibrate your CCD camera (310 and 377 instruments) 
and the change is greater than 3 pixels from the original pixel 
position.

� When you replace the CCD camera (ABI PRISM 310 and 
ABI PRISM 377).
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Considerations
Before Making a

Matrix File

The following table lists some of the considerations before making a 
matrix file:

Where to Store
Matrix Files

Store matrix files intended for use by Data Collection software in: 

D:\AppliedBio\Shared\Analysis\Sizecaller\Matrix\ 

If Data Collection and Analysis are installed on different computers, the 
location is the same. Remember to copy the matrix file from the 
analysis computer to the Data Collection computer. 

Consideration Comment

How much dye matrix standard to 
load?

With the ABI PRISM 377, loading 
more than 3 µL, produces too much 
signal. 

Any amount that results in a signal 
over 4,000 FUs is too strong.

Which lanes to load with the dye 
matrix standards?

For gel electrophoresis, load the 
matrix standards with an empty lane 
between each sample to avoid 
contamination of the individual dyes 
by residual material leaking adjacent 
samples.

What exact gel data will be used for 
matrix creation?

After generating a gel image, for 
ABI PRISM 377 instrument, check 
that the tracking of the gel file is 
adequate.
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Process of Creating a New Matrix File

Process Diagram The following diagram shows the procedure for making a new matrix 
file:

For sample preparation and loading information, refer to the appropriate 
instrument user manual 

Steps to Create a
New Matrix

1

9

2

3

8

7

6

5

4

Prepare Dye
Matrix

Standards

Load Dye
Matrix

Standards

Generate
Sample Files

View
Raw Data

Choose
a Scan Range

Generate a
New Matrix

File

Save and
Name the
Matrix File

Assign the
Matrix File to

Select Sample
Files

Evaluate the
Matrix File

Creating a New Matrix

The following table lists the steps to create a new matrix file:  

Step Process See Page

1 Loading and Running Dye Standards for the 
ABI PRISM 310

6-9

2 Loading and Running Dye Standards for the 
ABI PRISM 377

6-12

3 Choosing a Scan Range for the Matrix Calculation 6-17

4 Generating a New Matrix File 6-20
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5 Saving and Naming the Matrix File 6-22

6 Assigning the Matrix File to Sample Files 6-23

7 Evaluating the Matrix File 6-25 

8 Causes for Bad Matrix Files 6-26

The following table lists the steps to create a new matrix file: (continued)

Step Process See Page
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Loading and Running Dye Standards for the ABI PRISM 310

Introduction This section describes how to do the following tasks before running 
matrix standards on the ABI PRISM 310: 

Note When loading the matrix standards on an instrument, note which colors 
you load in which autosampler positions.

Creating a
GeneScan Sample

Sheet

Topic See Page

Creating a GeneScan Sample Sheet 6-9

Creating a GeneScan Injection List 6-10

Starting the Data Collection Software 6-11

To create a GeneScan Sample Sheet:   

Step Action

1 Open the ABI PRISM 310 Data Collection software.

2 Choose New from the File menu.

3 Click the GeneScan Sample Sheet 48 or 96 tube icon.

The GeneScan Sample Sheet opens.

4 Enter the appropriate colors (Blue, Green, Yellow, Red, or Orange) 
in the positions for each sample name.

5 Enter any additional information about the sample in the Comments 
column.
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Creating a
GeneScan

Injection List

The Sample Sheet is imported into the Injection List, which defines the 
sample names and the initial injection order.

6 Use the Save As command and save the Sample Sheet to the 
Sample Sheet folder.

To create a GeneScan Sample Sheet:  (continued)

Step Action

To create a GeneScan Injection List: 

Step Action

1 Choose New from the File menu.

2 Click the GeneScan Injection List icon.

The GeneScan Injection List opens.

3 Select a Sample Sheet from the Sample Sheet pop-up menu.

4 Select the appropriate module in the Module pop-up menu for lines 
1 through 4, for example, A1, A3, A5, and A7.

5 Unselect Auto-Anlz (analysis).

6 Unselect Auto-Print.
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Starting the Data
Collection

Software

If the Run was
Cancelled

If the run was cancelled and you are using Data Collection Software 
Version 1.0.4 or later (Macintosh or Windows version), the sample file is 
saved if you skip to the next sample or cancel a run.

Run Time Run time is approximately 30 minutes for the GS STR POP-4 module, 
so the total run time will be about 120 minutes.

Assigning Matrix
File

For information on “Assigning the Matrix File to Sample Files,” refer to 
page 6-23.

To start the Data Collection software:

Step Action

1 Click the Run button.

The following windows open:

2 Choose Status from the Window menu. 

The current run is in italics in the Injection List. 

You can monitor activities such as electrophoresis current, laser 
power, running time, and gel temperature.

Window Description

Raw Data window Shows the real-time chromatogram of the 
run.

Log Window Shows the real-time written record of run 
events.
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Loading and Running Dye Standards for the ABI PRISM 377

Introduction This section describes how to do the following tasks using the 377 and 
the 377 with XL Upgrade instruments:

Note When loading the matrix standards on an instrument, note which colors 
you load in which lanes for gel-based systems.

Creating a
GeneScan Sample

Sheet

The GeneScan Sample Sheet assigns sample and dye information to 
the appropriate lane. 

Topic See page

Creating a GeneScan Sample Sheet 6-12

Loading Matrix Standards 6-13

Running the Matrix Standards 6-14

To create a GeneScan Sample Sheet:  

Step Action

1 Open the ABI PRISM 377 Data Collection software.

Define or verify the data collection preferences.

2 Choose New from the File menu.

3 Click the GeneScan Sample Sheet icon. 

The GeneScan Sample Sheet opens. 
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Loading Matrix
Standards

4 Enter the individual colors in the appropriate lanes where the matrix 
standards are loaded.

Note It is important to fill out the Sample Sheet completely.

5 Enter any additional information about the sample in the Comments 
column.

6 Use the Save As command and save the Sample Sheet to the 
Sample Sheet folder.

To create a GeneScan Sample Sheet: (continued)

Step Action

To load matrix standards: 

Step Action

1 For denaturing gels load:

� 0.5–2 µL of matrix standard per lane.

� 8 lanes with different colors, leaving an empty lane between 
each lane of matrix standard.

2 Complete the information in the data collection Run sheet, making 
sure to choose the appropriate PreRun and Run modules.

Take the following action:

3 Electrophorese samples according to conditions specified in your 
instrument manual.

For this matrix...
Choose modules 
that use... Module file

Dye Primer matrix Virtual Filter A GS 36A...

Fluorescent 
Amidite

Virtual Filter C GS36C...
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Running the
Matrix Standards

Run the matrix standards under the precise conditions you want to 
generate a matrix file.

To run the matrix standards: 

Step Action

1 Complete the information in the data collection Run sheet. 

Refer to the figure below to select the appropriate PreRun and Run 
Modules.

2 Take the following action:

3 Start the electrophoresis run according to the conditions specified 
in your instruction manual.

4 Go to “Generating Matrix Sample Files for the ABI PRISM 377 
Instrument” on page 6-15.

For this matrix...
Choose modules 
that use... Module file

Dye Primer or 
dNTP matrix

Virtual Filter A GS 36A...

GS Amidite matrix Virtual Filter C GS36C...
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Generating Matrix Sample Files for the ABI PRISM 377 Instrument 

Who Should Use
This Step

Gel Handling on
Windows

The 377 Data Collection for Windows generates gel files. There is a new 
program on Windows called Gel Processor. This program handles all 
gel file-related tasks, including tracking and sample file generation. For 
more information on the Gel Processor, refer to the Gel Processor 
user’s manual. 

Verify Tracking Before generating Sample files, verify that the lanes were set and 
tracked correctly. Once you have successfully completed your run of 
Dye Matrix Standards, open the gel file in the Gel Processor and 
visually verify the positions of the tracker lines. 

Generating
Sample Files

Follow these guidelines to use this step:

Who should use this step Who should not use this step

This step is only necessary if you 
are using an:

� ABI PRISM 377 instrument 

� XL-upgraded instrument

� 96-lane upgrade

The ABI PRISM 310 Genetic 
Analyzer automatically processes 
collection data and generates 
Sample files when the run 
completes. 

If you ran your Dye Matrix Standards 
on the ABI PRISM 310, go to 
“Choosing a Scan Range for the 
Matrix Calculation” on page 6-17.

To generate Sample files from within Gel Processor:  

Step Action

1 Click the appropriate Lane Indicators at the top of the Gel window to 
make sure the tracker line is optimally aligned over each band in all 
lanes.

If any of the lanes are not properly tracked, use the tracker line 
editing tools to align the tracker lines in each lane. Refer to the Gel 
Processor User’s Manual. 

2 If you change any of the lane assignments in any way, save the 
changes.
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3 From the Gel menu, choose Track & Extract Lanes.

Note If the gel is already tracked, choose Extract Lanes from the 
Gel menu.

The project Analysis Control window opens containing each of the 
Sample files.

To generate Sample files from within Gel Processor: (continued)

Step Action
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Choosing a Scan Range for the Matrix Calculation

Introduction Depending on how well your Matrix Standards run, it may be necessary 
for you to choose a specific range of data points to be considered for 
your matrix calculation.

In order to choose appropriate values for the Scan range, you must first 
view the Sample file raw data from each of the matrix standard files, so 
you can decide where to choose the start and stop points for the scan 
range.

Viewing the Raw
Data

When you have multiple Sample files, raw data can be accessed more 
easily through a project’s Analysis Control window. Raw data can 
provide useful information about the Sample files you have created. 

Note You can view Sample files without opening a project. However, this 
procedure is easier if you use a project to organize the Sample files. 

To view raw data:  

Step Action

1 Use the following steps to create a project for the Dye Matrix 
Standards: 

a. Choose New from the File menu.The Create New dialog box 
opens.

b. Click the Project icon. An untitled Analysis Control window 
opens.

c. Choose Add Sample Files from the Project menu.

d. Find and open your matrix run folder.

e. Select the five Sample files representing the blue, green, yellow, 
red, and orange dye-labeled runs, and click Add. 

f. Click Done after the Sample files are transferred. 

For more information, refer to “Creating a New Project” on 
page 2-9.

2 From the Analysis Control window, select the matrix standard 
Sample files by clicking on the first Sample file, holding down the 
mouse button, and releasing on the last Sample file.
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What to Look For
in the Raw Data

Display

In the raw data display of the Sample files verify the following:

� Data peaks are present in all four of the matrix standards. 

� There are no anomalies.

� The baseline is stable. 

� Peaks should be on-scale—no more than 4000 relative fluorescent 
units—and the peaks of the dye of interest should have a value of at 
least 200.

If peak data does not show these characteristics, refer to “Causes for 
Bad Matrix Files” on page 6-26, for possible interpretations of your peak 
data.

Choosing a Scan
Range

3 From the Project menu, choose Raw Data (Ctrl+R).

Electropherograms displaying raw data from the matrix standard 
Sample files appear.

Note For the ABI PRISM 377 instrument, you can also view raw 
data from the gel display by selecting one of the lanes containing 
Dye Matrix Standard and looking at the Slice View to the left of the 
gel image.

For more information about viewing the gel image, refer to the Gel 
Processor User’s Manual. 

To view raw data: (continued)

Step Action

To choose a scan range: 

Step Action

1 Move the cursor well away from the primer peak, in a region at the 
beginning of the run and in a flat part of the baseline, and record 
the scan numbers.

Note When choosing the start point, do not include primer peaks 
in the scan range (refer to “Eliminating Primer Peaks”). Also, the 
region for both the start and stop points should be flat points at the 
baseline.

2 Record the data point values for both the start and stop points of 
the scan range.

You will need to enter these values in the next step when 
generating the new matrix file (refer to page 6-20).



Making a Matrix File 6-19

Eliminating
Primer Peaks

Both the primer peaks and the data peaks are displayed when viewing 
the raw data of your matrix standards. Any time you run dye-labeled 
samples on a gel (377 instrument), or capillary (310 instrument), you 
always have excess dye-labeled primer in the reaction. The primer peak 
displays as the first peak, usually off-scale because it is in molar 
excess. 

Eliminate the primer peak when making a matrix, by choosing the start 
point after the primer peak in a flat area with a stable baseline. 

3 Close the raw data boxes and the project by clicking in the upper 
left-hand corner of the window. 

Note Holding down the Alt key while clicking in the upper 
left-hand corner of the window will close the windows 
simultaneously.

To choose a scan range: (continued)

Step Action
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Generating a New Matrix File 

Procedure To generate a new matrix file:  

Step Action

1 Choose New from the File menu. 

The Create New dialog box opens.

2 Click the Matrix icon. 

The Make New Matrix dialog box opens.

3 Choose the number of dyes from the Number of Dyes pop-up menu.

If 5 dyes are selected, a button is added to the bottom of the list.

4 The B, G, Y, R, and O buttons represent dye colors.

a. Click a button to display a pop-up menu. 

b. Use the pop-up menu to access a Sample file to link to each of 
the dye-labeled primers.

c. Choose the Sample file that represents the dye color for that 
button.

5 Enter the start point that you determined when choosing a scan 
range in the Start at field.

Refer to “Choosing a Scan Range” on page 6-18.
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Matrix File
Example

The following is an example of the Matrix Values window that opens 
showing the values used to calculate the overlap correction.

For each dye, the value where the dye fluorescence is read by the 
appropriate filter is 1.000. The adjacent colors show the amount of 
overlap for which the system must compensate. The adjacent values, in 
most cases, should be less than 1.000, but equal to or greater than 
0.0000.

6 Enter the total number of data points to include to calculate the 
matrix in the Points field.

Note You must have at least five peaks to make a matrix.

In most cases, leave the default value, unless you must exclude a 
portion of your data because of artifacts or bleed-through.

7 Click OK.

This generates a new matrix file. 

To generate a new matrix file: (continued)

Step Action
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Saving and Naming the Matrix File

Introduction The matrix file is instrument-specific. You cannot apply a matrix file you 
made on the ABI PRISM 377 to data you collected on an ABI PRISM 310, 
nor can you apply a matrix file made on an ABI PRISM 377 to a Sample 
or gel file made on another ABI PRISM 377. In other words, you cannot 
apply matrix files created on one instrument to other instruments of the 
same model.

Naming
Considerations

When naming a matrix file, consider including the following information 
in the name:

Saving the Matrix
File

Where to Store the
Matrix File

Store matrix files that are intended for use by data collection to assign 
to collection runs in:

D:\AppliedBio\Shared\Analysis\Sizecaller\Matrix\

When Data
Collection and

Analysis Are
Performed on

Different
Computers

Be sure to copy matrix files generated on the analysis computer (the 
computer running GeneScan analysis) to the Data Collection computer, 
if different. This will ensure that the correct matrix is stored in the 
GeneScan sample file. The proper matrix is required for accurate 
analysis of 310 and 377 sample files. 

Item For example

Instrument type ABI PRISM 377, or ABI PRISM 310.

Filter set used D, C, F, G5 and E5 

Gel conditions native or denaturing.

To save the matrix file:

Step Action

1 Select Save from the File menu.

A dialog box opens.

2 Enter a descriptive name for the new matrix file and click Save.
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Assigning the Matrix File to Sample Files

Introduction After generating the new matrix file, assign it to all the Sample files that 
you want to analyze.

IMPORTANT After assigning your matrix file to Sample files, refer to 
“Evaluating the Matrix File” on page 6-25.

Procedure To assign a matrix file to Sample files and review them:  

Step Action

Assigning a matrix file to Sample files:

1 From the project that contains your matrix standard Sample files, 
open the Analysis Control window.

2 Select the matrix standard Sample files.

3 Select Assign New Matrix from the Project menu.

4 Select the matrix file you just created.

5 Select numbers 1, 2, 3, and 4 on the left side of the window to 
highlight the colors for each row.

6 Select Set Analysis Parameters from the Settings menu.

7 Enter the appropriate range for the Analysis Range and click OK to 
return to the Analysis Control window.

8 Click Analyze.



6-24 Making a Matrix File

Reviewing the results:

1 Choose Results Control from the Windows menu.

The Results Control window opens as shown below.

2 Select 4 from the # of Panels pull-down menu (see above).

3 Click 1 under Dye/Samples (see above).

4 Click 1 on the Sample Files side of the Results Control window.

5 For the rest of the matrices, click Analyze and repeat steps 1 and 2.

To assign a matrix file to Sample files and review them: (continued)

Step Action

# of Panels
pull-down menu

Dye/Samples



Making a Matrix File 6-25

Evaluating the Matrix File

Introduction After creating a new matrix file and assigning it to select Sample files, 
the next step is evaluating the quality of the matrix file. The quality of the 
matrix file has a direct impact on the quality of the results data.

Procedure To evaluate the matrix file: 

Step Action

1 Analyze the Sample files used to make the matrix.

2 Display Results data for all the Dye Matrix Standard Sample files on 
one screen, showing only electropherogram data.

3 For each displayed Sample file:

You should see... If not...

that the only visible peaks 
represent the color of the Dye 
Matrix Standard run in that 
lane, or for that injection 
(ABI PRISM 310).

you probably have a bad matrix 
file. 

For instructions on how to 
identify and correct problems 
with bad matrix files see, 
“Causes for Bad Matrix Files” 
on page 6-26.

all other lines should be 
relatively flat.

This indicates that the matrix 
properly compensated for the 
spectral overlap. 

For example, for the blue 
matrix standard Sample file, 
you should only see blue.

sharp, well-defined, singularly 
colored peak data.
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Causes for Bad Matrix Files

If an Error
Message Appears

There are two possible causes for the error messages shown in the 
following table: 

Two Causes of Bad
Matrix Files

For this cause... Take this action...

designated the wrong files. reassign the matrix files. 

Refer to “Assigning the Matrix File to 
Sample Files” on page 6-23.

signal is too weak to make a matrix. rerun the matrix standards.

The following table lists two common causes of bad matrix 
files: 

Problem Cause What to do

Artifact peaks of 
different colors under 
the true peaks.

Refer to the figure 
below.

Loading too much dye 
when running matrix 
standards, resulting in 
dye bleed-through.

Complete another run 
and recreate the 
matrix.

Noisy baseline. If the matrix subtracts 
too much of a 
particular color from 
the sample, then the 
baseline may become 
too elevated, resulting 
in false peaks.

Refer to the figure 
below.

Complete another 
matrix run and make 
sure you do not have 
any off-scale data.
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The following table lists two common causes of bad matrix 
files: (continued)

Problem Cause What to do
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Working with Size 
Standards 7
Overview

In This Chapter Topics in this chapter include the following:

Topics See Page

About Size Standards 7-2

Defining the Size Standard 7-3

Using Size Standards 7-9

7
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About Size Standards

What Are Size
Standards

Size standards are specific DNA fragments of known sizes. After 
defining the peaks of a size standard, the GeneScan® Analysis 
Software matches this definition to the internal size standard included 
with the run. The software assigns the defined size values to the 
appropriate peaks of the internal size standard, and uses this 
information with the selected sizecalling method to size all unknown 
fragments.

Advantages of
Using Size
Standard

Running an internal size standard results in determining accurate and 
precise molecular length. This is because the internal size standard and 
the unknown fragments undergo exactly the same electrophoretic 
forces. The GeneScan Analysis Software can then compensate for 
band-shift artifacts caused by variations in the gel and in the sample 
from lane to lane or injection to injection.

Size Standards
Provided

Applied Biosystems provides several fluorescently labeled size 
standards, which are described in Appendix C.

You can also label and use other fragments if they better suit the 
fragment sizes with which you are working.

When to Define
Size Standards

Normally, a size standard is defined using the GeneScan Analysis 
Software after running the size standard with samples on the 
instrument. The software detects peaks for a selected dye color in a 
selected sample file and allows you to define the peak sizes. You can 
save the defined size standard in a file and use it to automatically 
analyze other samples run with the same size standard and under the 
same conditions.

For a list of the size standards that are supplied with the GeneScan 
Analysis Software, refer to Appendix C, “GeneScan Size Standards.”

If Split Peaks
Appear

Split peaks might appear in size standards in which both DNA strands 
are labeled. For some peaks, the two strands migrate at different rates 
when running under denaturing conditions, and they appear as two 
peaks approximately half the height of normal, non-split, peaks. One 
peak of the two runs is true to size. Assign a size to that peak for the 
size standard definition, and assign zero to the other peak.
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Defining the Size Standard

Two Ways to
Define the Size

Standard

There are two ways to define a new size standard:

Using the New
Command

Topic See Page

Using the New Command 7-3

Using the Analysis Control Window 7-7

To use the New command to define a new size standard: 

Step Action

1 Select New from the File menu. 

The Create New dialog box opens.

2 Click the Size Standard icon. 

The following dialog box opens:
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3 Select the sample file that contains the dye standard you want to 
use as a template for the new size standard and click Open.

The Select Dye and Analysis Parameters dialog box opens.

4 From the Dye pop-up menu, select the code that represents the dye 
label of the size standard in the selected sample File.

5 From the Analysis Parameters pop-up menu, select the analysis 
parameters to use.

The pop-up menu contains the following options:

To use the New command to define a new size standard: (continued)

Step Action

Item Description

Analysis Parameters Applies the parameters that 
are stored as preferences in 
the software.

custom parameters that are 
listed at the bottom of the 
menu

These are files that you 
defined and they are located in 
the Params folder.

The path is: 
D:\AppliedBio\Shared
\Analysis\Sizecaller\Params.



Working with Size Standards 7-5

6 Click OK.

A window opens (see below) showing the electropherogram and a 
table of peaks for the dye color and sample selected. 

You should be able to recognize the peak pattern of the size 
standard in the electropherogram.

Note You can only change the peak size value in the right column 
of the table. You cannot change or rearrange the peak numbers.

The software assigns a number to each peak found in the 
electropherogram in order, from left to right.

To use the New command to define a new size standard: (continued)

Step Action

If... Then...

too many peaks appear in the 
electropherogram or the 
baseline is too high

you may need to adjust the 
analysis parameters. 

See “Using Analysis 
Parameter Files” on page 5-13.
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7 Specify the peaks of the size standards and their sizes as follows:   

8 When you finish defining the peaks, save the size standard by 
selecting Save As from the File menu.

Note You can also click the Close button.

9 Enter a descriptive name for the size standard and click Save.

Note Run conditions are not stored in the Size Standard file. Use 
a name that clearly defines the size standard for future use.

This file is automatically saved in the SizeStandards folder.

The path is: 
D:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards 

To use the New command to define a new size standard: (continued)

Step Action

Step Action

a. Click the peak you want to define either in the 
electropherogram or in the table.

Use the Zoom In (Ctrl+ Plus sign) and Zoom Out 
(Ctrl+ Minus sign) commands from the View menu to 
zoom the electropherogram for easier viewing. 

– If you click a peak in the electropherogram, the 
corresponding row in the table is highlighted.

– If you click a peak number in the table, the 
corresponding peak in the electropherogram is 
highlighted.

b. Type the value for the selected peak in the 
corresponding Size field in the table.

Refer to Appendix C, “GeneScan Size Standards,” for 
values and peaks patterns.

Note Leave a zero in the Size field to ignore a peak for 
the size standard definition.

c. Press Enter to automatically move to the next size 
standard peak.
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Using the Analysis
Control Window

To define a new size standard: 

Step Action

1 Open an existing project or create a new project.

The Analysis Control window should open. If it does not, select 
Analysis Control (Ctrl+1) from the Windows menu.

2 In the Analysis Control window, find the row that contains the 
sample for which you want to define the size standard.

3 In that row, Ctrl+click the dye color cell that represents your size 
standard.

A diamond symbol (") appears in the cell, identifying it as the size 
standard.

4 Click the arrow in the Parameters field of the same row, and select 
an option from the pop-up menu that opens.

The pop-up menu contains the following options:

5 In the same row, click the arrow in the Size Standard field, and 
select Define New from the pop-up menu.

A window opens showing the electropherogram and a table of 
peaks for the dye color and sample you selected. 

You should be able to recognize the peak pattern of the size 
standard in the electropherogram.

For information on... See Page

Opening an Existing Project 2-8

Creating a New Project 2-9

Item Description

Analysis Parameters Applies the parameters that are 
stored as preferences in the 
software.

filename Applies the settings specified in 
the data collection run file.

Custom parameters that are 
listed at the bottom of the 
menu

These are files that you defined 
and they are located in the 
Params folder.

The path is: 
D:\AppliedBio\Shared\Analysis\
Sizecaller\Params 
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6 Follow step 7 to step 9 on page 7-6.

The name of the size standard appears in the Size Standard pop-up 
menu in the Analysis Control window. 

To define a new size standard: (continued)

Step Action
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Using Size Standards

In This Section This section contains the following topics:

Verifying Size
Calculations

For information, see “Verifying Size Calculations” on page 9-33.

Changing the
Number of Peaks

Detected

Use the Analysis Parameters dialog box to change the number of peaks 
detected in the Define New Standard window. 

For information, refer to “Peak Detection Options” on page 5-8.

Editing the Size
Standard
Definition

The following procedure describes how to edit the size standard 
definition (Collection Setting standard) that is embedded in the sample 
file. Double-clicking the size standard definition will not open the file. 

Topic See Page

Changing the Number of Peaks Detected 7-9

Editing the Size Standard Definition 7-9

Using the Open Command to Edit an Existing Size Standard 7-10

Using the Analysis Control Window to Edit an Existing Size 
Standard

7-11

Deleting an Existing Size Standard 7-12

Analyzing Samples Using the Same Size Standard 7-13

Selecting Separate Size Standards for Samples 7-14

To edit the size standard definition: 

Step Action

1 Choose Open from the File menu. 

The Open Existing dialog box opens.

The Collection Setting does not change.

2 Click the Size Standard icon. 

An Open dialog box opens.
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Editing an Existing
Size Standard

The two ways to edit a previously defined size standard are by:

� Using the Open Command to Edit an Existing Size Standard

� Using the Analysis Control Window to Edit an Existing Size 
Standard

Using the Open Command to Edit an Existing Size Standard   

3 Navigate to the SizeStandards folder, select the file that you want to 
edit, and click Open.

The path is: 
D:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards

4 Make any changes to the file and click the Close button.

5 Choose the edited file from the Size Standard pop-up menu to apply 
the changes.

To edit the size standard definition: (continued)

Step Action

Step Action

1 Choose Open (Ctrl+O) from the File menu.

The Open Existing dialog box opens.

2 Click the Size Standard icon.

An Open dialog box opens.

3 Navigate to the SizeStandards folder, select the size standard file 
that you want to modify, and click Open.

The path is: 
D:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards 

4 Edit the peak size values by following steps 7 to 9 on page 7-6.

5 Select Save (Ctrl+S) from the File menu to update an existing file, or 
Save As to specify a new name.
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Using the Analysis Control Window to Edit an Existing Size Standard    

Step Action

1 If the Analysis Control window is not open, select Analysis Control 
(Ctrl+1) from the Windows menu.

2 Click the arrow in the Size Standard column for the sample that you 
want to change. 

3 Select a size standard from the pop-up menu.

4 Edit the peak size values by following steps 7 to 9 on page 7-6

5 Select Save (Ctrl+S), or Save As from the File menu to save 
changes and specify a new file name.
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Deleting an
Existing Size

Standard

The following procedure describes how to delete a user-defined size 
standard from the Params Folder so that it no longer appears in the 
Size Standard pop-up menus. The size standard is permanently 
removed, and you must redefine it to use it again.

To delete an existing size standard: 

Step Action

1 Click the Start button, and then point to Programs.

2 Click Windows NT® Explorer to find and open the SizeStandards 
folder.

The path is: 
D:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards 

3 Select the size standard file that you want to delete.

4 Drag the file to the Recycle Bin.

Note You can also drag the size standard to another folder for 
storage.
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Analyzing Samples
Using the Same

Size Standard

To select the same size standard to analyze all samples:  

Step Action

1 If the Analysis Control window is not displayed, select Analysis 
Control (Ctrl+1) from the Windows menu.

2 Click the arrow in the Size Standard column heading and choose a 
size standard file from the pop-up menu. 

Your menu choice applies to all fields in the column.

Note Alternatively, you can choose a value from the pop-up 
menu, click the header to select the entire column, and select Fill 
Down (Ctrl+D) from the Edit menu. 

3 The pop-up menu contains the following options:

Pop-up menu

Item Description

None Apply no standard definition.

Collection Setting Apply the size standard specified in 
the Data Collection software, which is 
embedded in the sample file.

For information on editing this file, see 
“Editing the Size Standard Definition” 
on page 7-9.

Custom standards that 
are listed at the bottom 
of the menu

These are files that you defined and 
they are located in the SizeStandards 
folder. 

The path is: 
D:\AppliedBio\Shared\Analysis\Sizeca
ller\SizeStandards 
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Selecting Separate
Size Standards for

Samples

To apply separate size standards to selected samples, click the arrow in 
the Size Standard column for the sample that you want to change (refer 
to the figure below) to open the pop-up menu.

For information on using the pop-up menu, see step 3 above. 

Pop-up menu
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Evaluating Analysis 
Results 8
Overview

In This Chapter Topics in this chapter include the following:

Topic See Page

Process of Evaluating Analysis Results 8-2

Ways to Display Analysis Results 8-3

About the Results Display Window 8-4

Using the Results Control Window 8-7

Changing How the Results Are Displayed and Printed 8-13

About the Sample Results View 8-15

Updating the Results 8-16

Saving and Renaming the Results Control Format 8-17

8
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Process of Evaluating Analysis Results

Evaluating
Analysis Results

The following table describes the steps to evaluate the analysis results:

Step Action For information, see...

1 Displaying analysis results “Ways to Display Analysis 
Results” on page 8-3

2 Using electropherogram and 
tabular data displays 

“About Electropherogram and 
Tabular Data Displays” on 
page 9-2

3 Viewing electropherograms “Displaying Electropherogram 
Data” on page 9-9

4 Verifying analysis results “Process of Verifying Results” 
on page 9-31

5 Displaying other sample file 
data 

� “Sample Info View” on 
page 4-11

� “Size Curve View” on 
page 4-20

� “Raw Data View” on 
page 4-22

� “EPT Data View” on 
page 4-24

6 Using the analysis log “Using the Analysis Log” on 
page 9-36

7 Remembering and renaming 
the results display 

“Saving and Renaming the 
Results Control Format” on 
page 8-17



Evaluating Analysis Results 8-3

Ways to Display Analysis Results

Two Ways to
Display Analysis

Results

The following table describes two ways to display analysis results: 

You can use... Description See Page

About the 
Results 
Display 
Window

This window is created from the Results 
Control window of a project. 

Use to group and view multiple sample files 
as electropherogram and tabular data.

8-4

About the 
Sample 
Results View

This view displays one sample file at a time, 
like the Results Display window, but is more 
convenient to view analysis results from a 
single sample file.

It also allows quick access to supporting 
information views.

8-15
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About the Results Display Window

Introduction The Results Display window is created from the Results Control window 
of a project. It allows you to group and view multiple sample files as 
electropherogram or tabular data. You can use the window to show up 
to eight panels, with multiple dye/samples per panel.

Displaying the
Window

When you select Results Control (Ctrl+2) from the Windows menu, a 
window opens like the example shown below. The callouts are 
described in the table that follows this example.

6

7

8

9

10

1 2 3 4 5

111213
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Results Control
Window Callouts

Described

The following table describes the callouts in the previous figure of the 
Results Control window:  

Callout Description

1 Click one of the dye color fields (B, G, Y, R, O) to select dye/sample 
information.

2 Click to display electropherograms for the selected samples.

3 Click to show which sample is selected for this panel. 

4 Choose the number of electropherogram panels available for 
display from the pop-up menu.

5 Click to display tabular data for the selected samples.

6 Identifies the sample by row number and dye code.

Sample information is displayed as specified in the project 
options.

7 Plot color indicator 

Note If you change the plot color, a vertical line appears beside 
the indicator, showing that it has been modified.

If you... Then...

double-click the plot 
color indicator

the Choose a Plot Color dialog box 
opens.

For more information, refer to 
“Defining Individual Plot Colors” on 
page 9-26.

Ctrl+double-click the 
dye color indicator

the plot color indicator returns to 
the default color.

For more information, refer to 
“Setting Dye Indicator 
Preferences” on page 3-14.
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8

Note If you change the scale, a vertical line appears beside the 
indicator, showing that it has been modified.

9 Quick Tile buttons. 

See “Creating Tiled Electropherogram Displays” on page 8-10.

10 Display button. 

See “Displaying the Results” on page 8-12.

11 Clear Panel button. 

See “Removing Samples” on page 8-12.

12 Print button. 

See “Printing the Results” on page 8-12.

13 Clear All button. 

See “Removing Samples” on page 8-12.

The following table describes the callouts in the previous figure of the 
Results Control window: (continued)

Callout Description

Dye color indicator

If you... Then...

double-click the dye color 
indicator

the Choose a Dye Scale 
dialog box opens.

For more information, see 
“Changing the Dye Scale in 
Electropherograms” on 
page 9-28.

Ctrl+double-click the dye 
color indicator

the dye color indicator 
returns to the default scale.

For more information, see 
“Changing the Dye Scale 
Preferences” on page 9-30.
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Using the Results Control Window

Selecting Display
Format

Choose the results display format by clicking the electropherogram or 
tabular icons, or both. You must select one of the icons to display or 
print data.

Selecting
Electropherogram

Panels

In electropherograms, the data appears in panels. You can overlay up to 
16 samples within up to eight panels. Select the number of available 
panels (up to eight) from the pop-up menu labeled # of Panels. 

Note Set the number of panels when using the Quick Tile option. Using this 
option causes the GeneScan® Analysis Software to automatically change 
panels as you select samples to display (see “Creating Tiled Electropherogram 
Displays” on page 8-10).

Click this icon... To display... And the...

electropherogram data panel information below 
the icon is enabled. Refer 
to the figure below. 

tabular data Tabular data appears in a 
single table, so 
electropherogram panel 
configuration is not 
relevant.

Pop-up menu
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Selecting Samples
to Display

Use the dye color field on the left side of the Results Control window to 
select the dye to display. 

You can select any or all dye colors, including the standard, for each 
sample file.

To select samples to display: 

Step Action

1 Click the Electropherogram icon.

The panel below the button is enabled.

2 Click a panel number in the list to the left of the Dye/Samples list.

If fewer than eight panels are available and you want to use more, 
choose a larger number (up to eight) from the # of Panels pop-up 
menu.
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3 Click the dye color fields to select or unselect the corresponding 
samples.

Take the following action:

The samples corresponding to the selected dyes appear in the 
Dye/Samples list to the right of the Sample File list, as shown in the 
figure below.

To select samples to display: (continued)

Step Action

To... Click the...

select the entire column header of the column.

unselect the entire column Clear All button, or click the 
header if it is already selected.

select all colors for a 
sample file

index number to the left of the 
color columns.

Dye color
of sample

Plot color of
electropherogram

Row number and dye code
followed by dye/sample information
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Creating Tiled
Electropherogram

Displays

Procedure 

Example 

4 When you change to a new panel, the dye colors of the samples 
you selected in other panels appear dark gray to indicate that they 
have been selected.

You can select them again in the current panel.

To select samples to display: (continued)

Step Action

To create tiled electropherogram displays:

Step Action

1 Choose the number of panels you want to display from # of Panels 
pop-up menu.

2 Click the On button under Quick Tile.

3 Select samples by clicking color fields.

For information on:

Each time a sample is selected, the program automatically changes 
to the next panel, so each selection is placed after the one 
containing your previous selection. 

After you select a sample for the last panel, the panel displays the 
first panel again.

The following table describes two examples of how to use the Quick Tile 
feature:  

If you... Then...

have four samples and choose four 
panels for display

click the column heading for the blue 
dye to select all four blue 
dye-labeled samples.

The blue dye for each sample file 
appears in a separate panel.

Topic See Page

Selecting Samples to Display 8-8

Setting the tiled electropherogram preferences 8-13
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Unselecting
Samples

click the row index number for the 
first sample file to select all dye 
colors for one sample file

each dye for that sample file 
appears in a separate panel.

The following table describes two examples of how to use the Quick Tile 
feature: (continued)

If you... Then...

To unselect the samples that you have selected for display:  

Step Action

1 If you specified the Electropherogram display, click the panel 
number to the left of the Dye/Samples list to display the panel 
containing the samples you want to unselect.

2 On the left side of the Results Control window, unselect the dye 
color fields corresponding to the samples you want to remove.

The dye/sample identifiers are removed from the Dye/Samples list 
as you unselect samples.

Panel numbersDye color fields
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Removing Samples

Displaying the
Results

To display the results on the screen, you can either:

� Click the Display button.

� Press the Return or Enter key.

Printing the
Results

To remove samples: 

Step Action

1 Select the panel number on the buttons to the left of the 
Dye/Samples list.

2 You can take the following action:

To remove… Click…

all the samples you selected to 
display in a panel

Clear Panel.

the samples you have selected 
to display in all panels

Clear All.

To print the results:

Step Action

1 You can either:

� Click the Print button, or

� Select Print (Ctrl+ P) from the File menu.

2 Click OK in the dialog box that opens.
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Changing How the Results Are Displayed and Printed

Procedure You can set certain display preferences that remain in effect each time 
you display or print results data.

To change how results are displayed and printed: 

Step Action

1 Select Preferences from the Settings menu and Results Display 
from the submenu.

The following dialog box opens:

There are three Results Display preference categories:

� Default Display Attributes

� Stacked Electropherogram Panels

� Printing Preferences
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2 Set the Default Display Attributes to control the display attributes of 
new results displays, as follows:

3 Set the Stacked Electropherogram Panels, as follows:

To change how results are displayed and printed: (continued)

Step Action

You can select the... For more information...

Align By Size check box “Showing Data by Fragment 
Size” on page 9-20.

Show Peak Positions check box “Displaying Peak Positions” on 
page 9-14.

Show Legends check box “Using Legends to Change the 
Display” on page 9-15.

Show Offscale Region check 
box

“Showing Off-Scale Data” on 
page 9-18.

Standard 

or 

Custom Plot Colors buttons

“Defining Custom Colors” on 
page 9-25.

Opaque 

or 

Transparent Peak Highlighting 
buttons

“Highlighting Peaks” on 
page 9-15.

Choose... To set...

Use Common Vertical Scale 
check box

all panels in a display so they 
have the same vertical scale. 

The common scale is based on 
the electropherogram with the 
largest vertical scale.

Panel Height Resize Limits minimum and maximum values 
for electropherogram panel 
height in the results display. 

Use to limit how much the 
electropherogram panels 
stretch or shrink to fit the size 
of the window.
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About the Sample Results View

About the View The Sample Results view is displayed within a Sample File window. You 
can access the window through a sample file or through a project’s 
Analysis Control or Results Control window.

4 Set the Printing Preferences, as follows: 

5 Click OK.

To change how results are displayed and printed: (continued)

Step Action

If... Then...

the height of the panels that 
appears on screen is 
acceptable

select the As Shown on Screen 
button.

you want to print the 
electropherogram at a 
specified height

click the Fixed at button and 
enter a value in the field.

you want to force a page break 
after the electropherograms 
have been printed

select the Page Break before 
Tabular Data check box.

If... Then...

you are opening a sample file as a 
stand-alone file

the Sample Results view is the 
default display within the Sample File 
window.

For more information on... See Page

the Sample Results view 4-9
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Updating the Results

Re-analyzing the
Data

The Results Control and the Sample Results windows are dynamic.

If you re-analyze your data with either window active, then the software 
updates this window.
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Saving and Renaming the Results Control Format 

Introduction You can use the Results Control window to view multiple sample files in 
electropherogram and tabular format. The GeneScan Analysis Software 
allows you to save formats for future use. You can then redisplay or print 
these formats without having to redefine them again.

Important
Considerations

The following are important considerations for saving a Results Control 
format:

� You must save the project for the display to be available when you 
open the project again.

� Remembering a display preserves the combination of 
windows/panels/data and customized color settings. 

It does not preserve any zooming you have performed.

Saving the Display
Format

To save a display format for future viewing:  

Step Action

1 With the Results Control window set for the display, either:

� Click the Display button, or 

� Press the Enter key.

2 With the display on the screen, select Remember Display from the 
Project menu. 

The Remember Display dialog box opens.

3 Enter a name for the display and click OK.
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Working with a
Previously Saved

Display

Use the Previous Displays dialog box to display, print, remove or 
rename a saved display.

To work with a previously saved displays: 

Step Action

1 Select Previous Displays from the Project menu. 

The following is an example of the Previous Displays dialog box:

 

2 Select a display or multiple displays and take the following action:

To... Click an item in the list and click...

display the saved 
formats

Display.

print the saved formats Print.

The standard print dialog box opens.

remove the saved 
formats

Remove.

An alert opens.

rename a currently 
saved format

Note You can only 
rename one display at 
a time.

Rename.

The Rename dialog box opens.

See “Renaming the Current Results 
Display” on page 8-19.
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Renaming the
Current Results

Display

To rename the Results display that is currently on the screen and to 
save the display under a different name:

Step Action

1 Ensure that the display is the active window.

2 Select Rename Display from the Project menu. 

The following is an example of the Rename Display dialog box:

3 Enter a new name for the display and click OK.

The new name opens in the Previous Displays dialog box.
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Evaluating 
Electropherograms 9
Overview

In This Chapter Topics in this chapter include the following:

Topic See Page

About Electropherogram and Tabular Data Displays 9-2

Displaying Electropherogram and Tabular Data 9-4

Displaying Electropherogram Data 9-9

Working with Electropherogram Data 9-12

Defining Custom Colors in Electropherograms 9-24

Changing the Dye Scale in Electropherograms 9-28

Process of Verifying Results 9-31

Verifying Size Calculations 9-33

Using the Analysis Log 9-36

Verifying Peak Detection 9-38

9
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About Electropherogram and Tabular Data Displays

Introduction After analyzing the data, you can display the results for each sample in 
electropherogram and tabular data. You can also customize the 
electropherogram and tabular data display.

Note Altering the appearance of the electropherograms and the tabular data 
displays does not change the analyzed data contained in the sample file on 
which they are based. 

How the Window
Is Divided

When electropherogram and tabular data are displayed together, the 
window is divided into upper and lower windows.

What Tabular
Data Contains

If you analyze samples and perform sizecalling, the tabular data 
contains the estimated sizes (in base pairs) of all detected fragments. 
Use this information for detailed data analysis and further calculations. 
The peaks matched to the defined size standard are identified by dots 
next to the Dye/Sample Peak field.

Sample peaks that are larger (in base pairs) than the largest defined 
peak in the selected standard are not sized. The corresponding size 
fields are blank.

Note Tabular data displays only peaks that are detected based on the Dye 
Amplitude Thresholds and Minimum Peak Half Width setting of the analysis 
parameters.

How
Electropherogram

Panels Are Sized

In the Results Display window, the GeneScan® Analysis Software sizes 
all electropherogram panels to fit within the electropherogram portion of 
the window by using the largest size that fits them into the visible area. 
You can scroll to see the portion of the display that is not visible.

Window Contains

Upper window electropherogram data

Lower window tabular data

For more information on... See 

customizing the window’s 
appearance by adjusting the relative 
size of each window

“Adjusting Window Size” on 
page 9-7.
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For More
Information

For more information, see the following topics:

Topic See Page

Displaying Electropherogram and Tabular Data 9-4

Displaying Electropherogram Data 9-9

Working with Electropherogram Data 9-12
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Displaying Electropherogram and Tabular Data 

Procedure To display electropherogram and tabular data:  

Step Action

1 Select Results Control (Ctrl+2) from the Windows menu to open the 
Results Control window.

2 Click the Electropherogram button  and the Tabular 
button .

3 If applicable, select the number of electropherogram panels from 
the # of Panels list.

4 Click the dye color fields to select or unselect the corresponding 
samples.

Take the following action:

The samples corresponding to the selected dyes appear in the 
Dye/Samples list to the right of the Sample File list.

5 Click Display. 

The electropherogram and tabular data are displayed in the Results 
Display window.

See also “Working with Electropherogram Data” on page 9-12.

Dye color fields

To... Click the...

select the entire column header.

unselect the entire column Clear All button.

select all colors for a sample 
file

index number to the left of the 
color columns.
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Example of
Tabular Data and

Electropherogram

The following is an example of tabular data with a corresponding 
electropherogram:

Table Describing
Columns

The following table describes the columns in the “Example of Tabular 
Data and Electropherogram” above:  

Column heading Identifies...

Dye/Sample Peak � Sample index number

� Dye color

� Peak number

Minutes The time, in minutes, from the start of the run to the 
time the fragment was detected

Size The differences in fragment mobility 

This value is calculated automatically only if you:

� Run the size standard in the same lane or injection 
as the sample, and

� Perform sizecalling

Peak Height Signal size (RFU)
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Why Some Peaks
May Be Visible

Only in an
Electropherogram

Peaks may be visible in the electropherogram and not listed in the 
tabular data because:

Why Some Peak
Areas May Have a
Negative Number

If negative values appear in peak areas in the electropherogram, it is 
because a portion of the peak is below the baseline. The GeneScan 
Analysis Software display does not show the part of the 
electropherogram that is below the baseline.

Highlighting
Information

To highlight information for one peak in the electropherogram and 
tabular data:

Peak Area Area of the detected peak

Data point Data point of the fragment at its maximum peak 
height

The following table describes the columns in the “Example of Tabular 
Data and Electropherogram” above: (continued)

Column heading Identifies...

Reason For more information, see...

The software detects the peaks 
based on the Peak Amplitude 
Thresholds and Min Peak Half 
Width.

“Peak Detection Options” on 
page 5-8

Electropherograms display the 
peaks that fall within the range 
specified by the Sizecall Range 
parameters that are defined in the 
Analysis Parameters dialog box.

“Sizecall Range Options” on 
page 5-10

Click... Then...

the peak in the electropherogram the peak fills with color and the 
corresponding row in the tabular 
data window is highlighted.

the Dye/Sample Peak number in the 
tabular data window

highlights the corresponding peak in 
the electropherogram.
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Changing the
Highlight Color

Note For more information on highlighting peaks, see page 9-15. 

Adjusting Window
Size

Hiding Selected
Rows of Data

To change the highlight transparency:

Step Action

1 Select Peak Highlighting from the View menu. 

2 Then select either Opaque or Transparent from the submenu.

To adjust the relative size of the electropherogram and tabular windows:

Step Action

1 Move the cursor to the window divider (the double line between the 
two windows).

2 When the cursor changes to a bidirectional arrow ( ), click the 
window divider line and drag it up or down.

To hide selected rows of data:

Step Action

1 Take the following action:

2 Select Hide Selected Rows (Ctrl+H) from the View menu.

If you want to... Then...

select a row either:

� Click the first field in the row, 
or

� Click the corresponding 
peak in the 
electropherogram.

select several rows that are not 
next to each other

Ctrl+click the rows.
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Limiting the Rows
to Display

To limit the display to the selected rows of data:

Step Action

1 Select the rows you want to display.

2 Select Show ONLY Selected Rows (Ctrl+G) from the View menu.

Note Select Show All Rows (Ctrl+G) from the View menu to 
display all of the tabular data after limiting the display.
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Displaying Electropherogram Data

Definition Each electropherogram provides a profile of the selected dye samples it 
represents. The y-axis represents the relative fluorescence of the 
detected fragments as they occurred over time. The x-axis represents 
time and can be displayed by data points or base pairs.

Base Pairs Versus
Data Points

The tick marks on the x-axis can represent size in base pairs instead of 
data points. This option is only available for runs that include an internal 
size standard with the sample (see “Showing Data by Fragment Size” 
on page 9-20).

Procedure to
Display Data

To display electropherogram data:  

Step Action

1 Select Results Control (Ctrl+2) from the Windows menu to open the 
Results Control window.

2 Click the Electropherogram button.

3 If applicable, select the number of electropherogram panels from 
the # of Panels pop-up menu.

4 Click the dye color fields to select or unselect the corresponding 
samples.

Take the following action:

The samples corresponding to the selected dyes appear in the 
Dye/Samples list to the right of the Sample File list.

5 Click Display. 

The electropherogram is displayed in the Results Display window 
as shown in the example below.

Dye color fields

To... Click the...

select the entire column header.

unselect the entire column Clear All button.

select all colors for a sample 
file

index number to the left of the 
color columns.



9-10 Evaluating Electropherograms

Electropherogram
Example

The following is an example of an electropherogram:

Electropherogram
Callouts Described

1

2

3456

The following table describes the callouts in the figure above:  

Call 
out Description See...

1 Cross hairs “Displaying X- and 
Y-Axis Positions” on 
page 9-13

2 Magnifying glass

Use to zoom in a specific area or hold 
down while pressing the Alt key to zoom 
out to a smaller scale.

Or, click and drag a marque around an 
area to zoom in to that area. 

“Zooming In and Out” 
on page 9-17

3 Legend

Text from the sample file that appear 
beneath electropherogram panels in the 
Results Display window.

“Using Legends to 
Change the Display” 
on page 9-15
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4 Dye color indicator “Dye color indicator” 
on page 8-6

5 Plot color indicator “Plot color indicator” 
on page 8-5

6 Scroll bar

Use the scroll bar to scroll horizontally.

“Scrolling the Display” 
on page 9-16 

The following table describes the callouts in the figure above: (continued)

Call 
out Description See...
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Working with Electropherogram Data

In This Section This section describes how to perform the following tasks:

Task See Page

Displaying X- and Y-Axis Positions 9-13

Moving the Electropherogram 9-13

Changing the Dye Color 9-14

Displaying Peak Positions 9-14

Highlighting Peaks 9-15

Using Legends to Change the Display 9-15

Scrolling the Display 9-16

Zooming In and Out 9-17

Showing Off-Scale Data 9-18

Electropherogram Displaying Off-Scale Data 9-19

Electropherogram Displaying the Flat-Topped Effect 9-19

Showing Data by Fragment Size 9-20

Changing the Horizontal Scale 9-21

Changing the Vertical Scale 9-22

Assigning Standard or Custom Colors 9-23
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Displaying X- and
Y-Axis Positions

Moving the
Electropherogram

Move the associated electropherogram to the front by clicking one of 
the following in the legend:

� Dye scale indicator

� Plot color indicator, or

� Text

The following table describes how to display the x- and y-axis positions: 

To... Then...

display the x- and y-axis positions. click the cross hairs and select an 
area in the Electropherogram.

The x- and y-axis values appear in 
the box in the lower left corner of the 
electropherogram. 

If tabular data is also displayed, the 
row in the table is highlighted.

TextDye scale
indicator

Plot color
indicator
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Changing the Dye
Color

Displaying Peak
Positions

Use Show Peak Positions from the View menu to examine how the 
GeneScan Analysis Software defines peaks by displaying markers that 
identify the beginning, center, and end of each peak.

The following table describes how to change the dye color and how to 
return to the default dye color: 

To... Then...

change the dye color double-click the dye color indicator.

return to the default dye color Ctrl+double-click the dye color 
indicator. 

If... Then...

you change the dye color or scale a vertical line appears beside the 
indicator, showing that it has been 
modified.
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Highlighting Peaks Use the Peak Highlighting command to highlight a selected peak with 
the dye/sample’s plot color.

Using Legends to
Change the

Display

The following table shows how to use legends to change how 
electropherograms are displayed:

To highlight selected peaks: 

Step Action

1 Select Peak Highlighting from the Views menus and either Opaque 
or Transparent from the submenu.

2 Click a detected peak in an electropherogram. The peak is 
highlighted. 

Use this option... To...

Opaque fill the peak with a solid color that can 
obscure peaks behind the selected peak.

Transparent use a slightly diffused plot color that allows 
you to view overlapping peaks.

If you want to... Then...

show or hide legends select Show Legends from the View 
menu.

open sample file windows double-click the corresponding 
legend text.

reorganize overlaid 
electropherograms

a. Display the electropherograms 
with legends.

b. Click either the dye scale 
indicator, plot color indicator, or 
the text for the sample you want 
to move to the front.
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Scrolling the
Display

The following table describes ways to scroll the display: 

Use the Description

scroll bar

scroller 
symbols

a. Hold the mouse cursor over either the vertical or 
horizontal scale of the electropherogram.

Either a vertical scroller symbol ( ) or a horizontal 
scroller symbol ( ) appears.

b. Hold down the mouse button and move the mouse in 
the direction of the information you want to view.

If you want to... Then...

shift the electropherogram 
to the right or the left

click in the gray region of 
the scroll bar to the right or 
left of the scroll box.

scroll across the 
electropherogram

click an arrow at the end of 
the scroll bar.

control the amount of 
scroll

drag the scroll bar to the 
right or the left.
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Zooming In and
Out

About Zooming In and Out

By default, the GeneScan Analysis Software scales each 
electropherogram horizontally to show all peaks detected during the 
run. While this provides a good overview of the run, some peaks may 
be quite compressed.

Improving Visibility

To improve visibility, you can change the horizontal scale of the 
electropherograms by zooming.

Zooming affects:

� Only the horizontal scale, and zooms the middle portion of the 
window

� All displayed electropherogram panels

How to Change the View Scale 

If you want to... Then...

see views with greater detail � Select Zoom In (Ctrl++) from the 
View menu, or

� Click the magnifying glass in the 
upper-left corner of the window, 
and drag around a specific area 
to zoom in on the 
electropherogram.

see a smaller scale view of the data 
after zooming in

� Select Zoom Out (Ctrl+ -) from 
the View menu, or 

� Click the magnifying glass cursor, 
hold down the Alt key, and click 
the electropherogram.

The data appears in successively 
smaller scale views.

quickly scale the data so that the 
entire length fits within the window, 
again

Select Zoom Out (Full Range) from 
the View menu.
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Showing Off-Scale
Data

Procedure 

About Flat-Topped Peaks

An additional feature is that peaks that contain off-scale data points are 
drawn in the electropherograms as “flat topped;” that is, the top section 
of the peak is flat rather than pointed (see “Electropherogram 
Displaying the Flat-Topped Effect” on page 9-19). 

This section contains the following information: 

Topic See Page

Procedure 9-18

About Flat-Topped Peaks 9-18

Electropherogram Displaying Off-Scale Data 9-19

Electropherogram Displaying the Flat-Topped Effect 9-19

To show off-scale data:

Step Action

1 Select Preferences from the Settings menu and Results Display 
from the submenu. 

The Results Display Preferences dialog box opens.

2 Select the Show Offscale Regions check box to highlight with a red 
bar regions in the electropherogram that contain off-scale data (see 
“Electropherogram Displaying Off-Scale Data” on page 9-19). 

Note Select the Zoom In (Ctrl++) command from the View menu 
to more clearly show the areas of off-scale data.

Note You can toggle this command for individual 
electropherograms by selecting Hide/Show Offscale Regions 
(Ctrl+`) from the View menu.

If... Then...

the sample was sized the Analysis Log lists the 
numbers of off-scale regions in 
the analysis range for each 
sample file.
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This feature can be seen when the data is analyzed with no or light 
smoothing; the flat-topped peaks may not be apparent with heavy 
smoothing.

Select Analysis Parameters from the Settings Menu (see “Data 
Processing Options” on page 5-7).

Electropherogram
Displaying

Off-Scale Data

The following is an example of an electropherogram displaying off-scale 
data:

Electropherogram
Displaying the

Flat-Topped Effect

The off-scale peaks in the electropherogram in the expanded view 
below illustrate the flat-topped effect.

Off-scale data
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Showing Data by
Fragment Size

The following table explains how to show data by fragment size:

How to Switch Between Size and Data Point Display

If... Then...

you analyze your samples with an 
internal size standard

use the Align by Size (Ctrl+T) 
command from the View menu to 
align the horizontal scale of the 
electropherograms by fragment size 
instead of by data point.

Note You can display data by size 
only if you analyzed and performed 
sizecalling of your samples using a 
size standard.

For example, if Then...

you run two identical samples in 
different runs

the Align by Size command adjusts 
for run-to-run variations by aligning 
peaks by size value. This eliminates 
any apparent differences that were 
caused by run discrepancies.

Note You can display overlaid 
samples in the same dye in different 
colors. See “Defining Custom Colors 
in Electropherograms” on page 9-24.

If you want to... Then...

show data by size select Align by Size (Ctrl+ T) from the View menu.

When the data is aligned by size, the menu command 
changes to Align by Data Point.

Select the command again, to show the data aligned 
by data point.

set the default peak 
alignment

select Preferences from the Settings menu, and select 
Results Display from the submenu. 

You can use the Results Display Preferences dialog 
box to set certain preferences that remain in effect 
each time you display or print results data.

For more information, see “Changing How the Results 
Are Displayed and Printed” on page 8-13.
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Changing the
Horizontal Scale

Changing the Horizontal Scale for All Electropherograms

Changing the Horizontal Scale for Individual Electropherograms

To change the scale of the horizontal axis for all electropherograms: 

1 Display the electropherogram panels you want to change.

2 Select Horizontal Scale from the View menu.

The Horizontal Scale Parameters dialog box opens.

You can also move the cursor over the horizontal axis of a displayed 
electropherogram and double-click.

3 Enter the increments represented by the tick marks for the 
horizontal axis in the Tick Spacing box.

4 Enter a range in the entry fields labeled Display from and Display to.

5 Click OK.

To change the horizontal scale for individual electropherograms: 

Step Action

1 Display the electropherograms.

2 Move the cursor over the horizontal axis of the panel that you want 
to change and double-click.

The Horizontal Scale Parameters dialog box opens.

3 Enter the increments represented by the tick marks for the 
horizontal axis in the Tick Spacing box.

4 Enter a range in the entry fields labeled Display from and Display to.

5 Click OK. 

The horizontal scale changes.
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Changing the
Vertical Scale

Changing the Vertical Scale for All Electropherograms 

To change the vertical scale for all electropherograms: 

Step Action

1 Display the electropherogram panel that you want to change.

2 Select Vertical Scale from the View menu. 

The Vertical Scale dialog box opens.

3 Enter the increments represented by the tick marks for the vertical 
axis in the Tick Spacing box.

4 Enter a range in the entry fields labeled Display from and Display to.

5 Click OK.
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Changing the Vertical Scale for Individual Electropherograms

Assigning
Standard or

Custom Colors

The following table describes how to assign standard or custom colors 
and where to look for more information:

To change the vertical scale for individual electropherograms: 

Step Action

1 Display the electropherograms.

2 Move the cursor over the vertical axis of the panel that you want to 
change, and double-click.

The following dialog box opens:

3 Enter tick mark increments and a range.

4 Ensure that the Apply to all Electropherogram panels check box is 
not selected.

Select the check box only to apply the changes to all displayed 
electropherogram panels.

5 Click OK.

The vertical scale changes only for the electropherogram panel that 
you selected.

To... Then...

assign standard or custom colors select the Plot Colors command from 
the View menu and either Standard 
or Custom from the submenu.

For information on defining custom 
colors, see “Defining Custom Colors 
in Electropherograms” on page 9-24. 
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Defining Custom Colors in Electropherograms

Introduction The GeneScan Analysis Software assigns a plot color to each 
dye/sample added to an electropherogram. Normally, it is the color 
associated with the individual dye/sample by the Dye Indicators 
Preferences.

Note To change the default dye colors in the Analysis Control window and the 
Results displays, see “Setting Dye Indicator Preferences” on page 3-14.

Note Custom plot colors are not available in the Sample Results view.

Why Change
Colors in the

Electropherogram

Change the colors in the electropherogram to:

� Differentiate between different samples labeled with the same color 
dye

� Improve contrast between different dye colors

� Show data in a special color for a presentation

� Optimize plot colors for a particular printer

Saving the Display
Format

The following table describes the options to save the display format 
after customizing the display colors:

If you... And then...

specify saving the display format of 
a Results Display window after 
customizing the display

open it at a later time, the custom 
colors still appear.

For more information, see “Saving 
and Renaming the Results Control 
Format” on page 8-17. 

do not save the display format after 
manually customizing the colors

display the same results again. The 
electropherograms are redrawn 
using default colors.
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Defining Custom
Colors

To define custom colors for all electropherograms: 

Step Action

1 Select Project Options from the Settings menus and Choose 
Custom Plot Colors from the submenu.

The Custom Plot Colors dialog box opens.

2 Select new colors from the pop-up menus beside the 16 plot 
numbers.

Note The plot numbers indicate the order of the samples in the 
electropherogram legend.

3 Select Other from the pop-up menu to specify a color that does not 
appear in the pop-up menu.

The following is an example of a color picker that opens:
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Defining
Individual Plot

Colors

4 Position the cross hairs pointer on the color you want, and click.

The color appears in the Custom Color box.

5 To save the custom color, click Add to Custom Colors.

6 Click OK.

The Color Picker window closes.

7 In the Custom Plot Colors dialog box, select the check box labeled 
Save As Defaults to save the customized colors.

8 Click OK.

To define custom colors for all electropherograms: (continued)

Step Action

To define the individual plot colors:  

Step Action

1 Display the electropherograms with legends.

2 Double-click the plot color indicator next to the sample you want to 
change.

The Choose a Plot Color dialog box opens:

3 Select a new color from the pop-up menu.

If you select Other, then a color picker opens.

Plot color
indicator

Pop-up menu
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4 Click OK.

The color of the electropherogram for the individual sample 
changes, and a vertical line appears beside the plot color indicator 
to signify that it has been modified.

Note You can change the plot color in the same way from the 
Results Control window. When you do so, the dye/sample is plotted 
with the set color each time you open the applicable Results Display 
window.

Note Press Ctrl and double-click the plot color indicator to reset it 
to the original color.

To define the individual plot colors: (continued)

Step Action
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Changing the Dye Scale in Electropherograms

What the Dye
Scale Defines

The dye scale defines how dyes in an electropherogram appear relative 
to each other. You can compensate for peaks with different intensities 
by redefining the dye scale.

Note Changing the dye scale affects only the display, not the underlying data.

 Increasing the Dye
Scale Example

The following table describes one way to increase the dye scale:

If... Then... Action...

you loaded a smaller 
amount of green 
sample in relation to 
the red sample

the peaks for the green 
sample might appear 
half as tall as those of 
the red sample.

To make it easier to 
view both samples on 
the same scale, 
increase the dye scale 
value of the green 
sample to make the 
peaks appear similar.



Evaluating Electropherograms 9-29

Changing the Dye
Scale of an

Electropherogram

To change the dye scale of an individual electropherogram:

Step Action

1 Display the electropherograms with legends.

2 Double-click the dye color indicator next to the sample you want to 
change.

The Choose a Dye Scale dialog box opens.

3 Enter a new scale in the dialog box and click OK.

The dye scale for the individual sample changes, and a vertical line 
appears beside the dye color indicator to signify that it is modified.

Note You can change the dye color in the same way from the 
Results Control window. The dye is scaled each time you open the 
Results Display window.

Plot color
indicator
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Changing the Dye
Scale Preferences

To change the dye scale preferences: 

Step Action

1 Select Preferences from the Settings menu and select Results Dye 
Scales from the submenu.

The Preferences dialog box opens with the Results Dye Scales 
pop-up menu displayed.

2 Enter a positive number between 0.1 and 100 for each sample 
relative to any other sample, and click OK.

Note Dye scale values do not automatically revert to default 
values. Change them back to the defaults before examining results 
of another run.
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Process of Verifying Results

Introduction You can use the electropherogram and tabular displays to verify the 
results of analysis by checking the GeneScan Analysis Software 
calculated sizes and peaks.

Note The sizecalling of the standard and of sample fragments varies 
according to the sizecalling method you defined in the Analysis Parameters and 
the accuracy of the defined standard.

Steps to Verify Size
Calculation

To verify size calculations:  

Step Action See

1 Compare how well multiple size 
standard electropherograms 
line up within a Results Display 
window when aligned by size.

“Verifying Size Calculations” on 
page 9-33.

2 View the sizing curve calculated 
by the GeneScan Analysis 
Software.

“Example of Size Curve View” 
on page 4-21.

3 Determine how well the defined 
size standard matches the size 
standard run with your sample.

Use the Peak Total information in 
the Sample Info view of the 
Sample File window.

“Sample Info View” on 
page 4-11.

4 View the Analysis Log, which 
provides messages for each 
analyzed sample file. 

If there is a problem or a 
questionable condition during 
sizecalling, a warning message 
is displayed in the Analysis Log.

“Using the Analysis Log” on 
page 9-36.

5 Use the Raw Data view to 
display information about the 
raw data for a sample.

Analyzed sample files contain 
raw and analyzed data.

“Example of Raw Data View” on 
page 4-23.
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6 Use EPT Data to troubleshoot 
problems caused by poor run 
conditions, such as:

� EP voltage

� EP current

� Laser power

� Run temperature versus time

EPT data can be displayed for 
each sample file.

“EPT Data View Example” on 
page 4-25.

To verify size calculations: (continued)

Step Action See
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Verifying Size Calculations

Introduction This section describes the following topics:

� Verifying for the GeneScan-350 Standard

� Evaluating for Multiple Size Standards

Verifying for the
GeneScan-350

Standard

About the Standard

In the GeneScan-350 standard, the size of the first peak should be 
approximately 50 bp, the second 75 bp, and so on, assuming that 
processing started after the 35-bp fragment passed the scan region. If 
peaks appear to be correctly measured for your run, measurement of 
the sample fragments that ran with the standard should also be correct.

Note For a complete list of fragment sizes, refer to Appendix C, “GeneScan 
Size Standards.”

Procedure

To verify the size calculation for the GeneScan-350 standard: 

Step Action

1 In the Results Control window, select the Electropherogram button 
and the Tabular button.

2 Click the Clear All button to clear the panels.

3 Click the dye color for the size standard you want to view.

4 Click Display.

Note You can also open the Sample File window for the sample 
file of interest to verify sizecalling.

Dye color fields
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5 Click each peak in the electropherogram and check the tabular data 
to ensure it is the correct size (see figure below).

Note The peaks matched to the defined size standard are 
identified by dots next to the Dye/Sample Peak field.

6  If you find that the sizes were not calculated correctly, you can:

� Redefine the size standard, or

� Change the analysis parameters and re-analyze the affected 
samples (see “Sizecaller Algorithm Flowchart” on page 5-4)

To verify the size calculation for the GeneScan-350 standard: (continued)

Step Action

Indicates peak matched to defined size standard



Evaluating Electropherograms 9-35

Evaluating for
Multiple Size

Standards

To evaluate size calculations for multiple size standards:

Step Action

1 In the Results Control window, select the Electropherogram button.

2 Click the Clear All button to clear the panels.

3 Click the On button to turn on the Quick Tile option.

4 Click the dye colors for the size standards you want to view.

When the Quick Tile option is on, the GeneScan Analysis Software 
inserts each in a separate panel.

Note Click the header of the appropriate dye/sample column to 
display all standards in the project that are the same color dye.

5 Click Display.

The standards appear in tiled electropherogram displays.

For information on setting the tiled electropherogram displays, see 
“Creating Tiled Electropherogram Displays” on page 8-10.

6 Select Align by Size (Ctrl+T) from the View menu if the 
electropherograms are not already aligned by size. 

The size standards should line up when aligned by size.

Note You can set preferences so that all new displays show data 
aligned by size by selecting Preferences from the Settings menu 
and Results Display from the submenu. Click the Align By Size 
check box.

For more information, see “Saving and Renaming the Results 
Control Format” on page 8-17.

Dye color fields
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Using the Analysis Log

What Is the
Analysis Log

The Analysis Log maintains a running record of analysis performed by 
the GeneScan Analysis Software. If a problem occurs during analysis of 
a sample file, the Analysis Log automatically opens in the foreground as 
an alert.

Displaying the
Analysis Log

Select Analysis Log (Ctrl+0) from the Windows menu.

The following is an example of the Analysis Log:
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What to Evaluate Evaluate the following:

Removing
Information from
the Analysis Log

Closing the
Analysis Log

You can either:

� Click the Close button in the upper-left corner, or

� Select Close (Ctrl+W) from the File menu

What to evaluate What not to evaluate

Potential problems that the 
GeneScan Analysis Software might 
have had during sizecalling.

Analysis Log will alert you if more 
than two defined size standard 
peaks were not matched.

The GeneScan Analysis Software 
will not alert you to any consecutive 
peaks at the end of the definition.

This is to avoid logging warnings 
when your sample was not run long 
enough to include all the defined 
size standard peaks. 

This prevents you from having to 
create a new standard for shorter 
runs.

The Analysis Log will, however, alert 
you if less than 50% of the defined 
size standard peaks were not 
matched, regardless of the peak 
locations in the definition.

To remove information from the Analysis Log: 

Step Action

1 Select the information you want to remove.

Note Choose Select All (Ctrl+A) from the Edit menu to select all 
the information.

2 Select Clear from the Edit menu.
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Verifying Peak Detection

Introduction Use the Show Peak Positions command from the View menu, while the 
electropherogram and associated tabular data are displayed, to verify 
results by examining how the GeneScan Analysis Software defined the 
total area that comprises each peak and the center of the peak.

Verifying Peak
Detection

To verify peak detection: 

Step Action

1 Select Show Peak Positions from the View menu.

Markers appear that identify the beginning, center, and end of each 
peak.

Note For a better view, select Zoom In from the View menu, or use 
the Zoom tool (see “Zooming In and Out” on page 9-17).

2 Examine the display to ensure that each peak’s center, beginning, 
and end points are correct.
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3 Select Hide Peak Positions from the View menu to suppress the 
display of the peak markers.

Note You can also use the Sample Info view to display information 
about the peaks detected and matched. 

For more information, see “Description of Information” on 
page 4-14.

To verify peak detection: (continued)

Step Action
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Saving, Archiving, and 
Copying Files 10
Overview

In This Section Topics in this chapter include the following:

Topics See Page

Why Save GeneScan Files 10-2

Saving GeneScan Files 10-3

Archiving Sample Files 10-4

Transferring Data to Other Applications 10-5

10
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Why Save GeneScan Files

Reasons for Saving
Files

The following table explains why you save projects, sample files, and 
Results Displays. For information on archiving files, see “Archiving 
Sample Files” on page 10-4.

Save Because See

GeneScan® Analysis 
Software projects

It protects the links to 
sample files and their 
preferences.

Projects contain links 
to sample files and 
preferences regarding 
display and analysis.

“Saving Projects” on 
page 10-3.

Sample files It protects the links to 
projects and their 
preferences.

Sample files also 
contain raw data and 
critical information 
about the run, settings, 
and analysis control.

“Saving Sample Files” 
on page 10-3.

Results Displays It saves the Results 
Display settings in 
projects when you 
have a display format 
that suits your needs.

“Saving Results 
Displays” on 
page 10-3.
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Saving GeneScan Files

Introduction This section describes how to save projects, sample files, and results 
displays.

Saving Projects Note You do not need to save a sample file after analysis. The analyzed data 
is written directly to the sample file during analysis.

The following table describes the options to save a project:

Saving Sample
Files

To save sample files, select Save (Ctrl+S) from the File menu. If you 
select Close from the File menu or click the Close button when you have 
not saved the changes, a dialog box opens with a message asking if 
you want to save them.

Saving Results
Displays

You can combine electropherograms and tabular data in many ways for 
display, and the GeneScan Analysis Software allows you to save 
display combinations and formats for future viewing. 

For more information on saving a display for future viewing, refer to 
“Saving and Renaming the Results Control Format” on page 8-17. 

If you choose... Then...

Save Project 
(Ctrl+S)

you can take the following action:

Save Project As the Save this document as dialog box opens.

Select a location for the file, enter a name, and click 
Save.

If you... Then...

previously saved the 
project

it is automatically saved 
using the same name.

had not saved the 
project

the Save this document 
as dialog box opens.

Select a location for the 
file, enter a name, and 
click Save.
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Archiving Sample Files

When to Archive
Sample Files

Archive sample files when you feel confident that the channel selections 
(tracking) used to generate them were correct. 

Procedure A sample file is 60 KB to 150 KB in size, depending on the length of the 
run. 

Step Action

1 To archive sample files, drag the file icon or the run folder 
containing the files to the floppy disk icon or to an alternative 
storage device. 

2 A 1.4 MB high-density disk holds about 12 files.
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Transferring Data to Other Applications

Genotyper
Software

GeneScan Analysis Software files can be read by Genotyper® software 
for Windows NT® platform.

Cutting and
Pasting Tabular

Data

Creating a Text
File

To cut and paste tabular data:  

Step Action

1 Display the tabular data you want to copy.

2 Select the rows you want to copy by taking the following action:

3 Select Copy (Ctrl+C) from the Edit menu.

4 Optional: To view the contents of the clipboard before pasting, from 
the Edit menu, select Show Clipboard.

5 Open the new application and click where you want to place the 
information.

6 Select Paste (Ctrl+V) from the Edit menu.

If you want to select... Then...

all tabular data Choose Select All (Ctrl+A) from 
the File menu.

several consecutive rows Shift-click the first and last row 
in the group you want to select.

several rows that are not listed 
next to each other

Ctrl+click the rows.

To create a text file from tabular data:

Step Action

1 Display the tabular data.

2 Select Export Table from the File menu.

The Save As dialog box opens.

3 Choose a name and file location in the dialog box and click Save.
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Printing Results 11
Overview

In This Chapter Topics in this chapter include the following:

About Printing

Ways You Can
Print

You can print the results of the run automatically at the end of the run or 
interactively, as selected sample files or display combinations. 

If You Get
Unexpected

Results

Topics See Page

About Printing 11-1

Printing Run Results Automatically 11-2

Printing Selected Sample Files 11-3

You might initially get unexpected results from autoprinting or the Print 
One command if you switch printers. 

Step Action

1 The first time you print after changing the printer configuration, 
select Print Setup (Ctrl+J) from the File menu and click OK.

2 Select Print (Ctrl+P) from the File menu and use the Print dialog 
box.

11
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Printing Run Results Automatically

Introduction You can specify that the results are printed in the 310 and 377 Data 
Collection software or in the GeneScan® Analysis Software.

From the Data
Collection

Software

When you choose automatic printing from the 310 and 377 Data 
Collection software, the GeneScan Analysis Software prints a separate 
page for each designated Sample file, showing electropherograms and 
tabular data as specified in the Auto-Analysis Defaults (see step 2 on 
page 2-6).

Choose automatic printing in the 310 and 377 Data Collection software 
as follows:

For information about setting up your run, refer to the instrument user 
manual.

Procedure

On this instrument... Choose...

ABI PRISM® 310 Auto-Print in the Injection list.

ABI PRISM® 377 Auto-Print in the Run Sheet. 

To print the results automatically as the samples are analyzed: 

Step Action

1 In the Analysis Control window, select the check box labeled Print 
Results.

2 Select the samples you want to analyze.

For more information, see “Analyzing a Sample File” on page 4-26.

3 Click the Print Setup button to specify the samples and the format.

For more information, see “Specifying the Format for Printed 
Results” on page 3-8.

4 Click OK.

The results are printed after the results are analyzed.
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Printing Selected Sample Files

Introduction Print selected sample files by using the Results Control window or by 
choosing the sample file.

Setting Printing
Options

Printing from the
Results Control

Window

Print selected samples after analysis, regardless of whether you 
choose automatic printing.

To set the printing options:

Step Action

1 Select Preferences from the Settings menu and Results Display 
from the submenu. 

The Results Display Preferences dialog box opens.

2 Use the Printing Preferences section, change the electropherogram 
height and page breaks.

Depending on how you set these options, the format that prints may 
be different from what is on the screen.

For information on printing saved Results Control formats, see 
“Working with a Previously Saved Display” on page 8-18.

To print results for selected sample files after analysis: 

Step Action

1 In the Results Control window, select the dye/samples and format 
you want to print.

Use the same technique as you did to select the format and the 
dye/samples to display the data. 

For more information, see “Using the Results Control Window” on 
page 8-7.
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Printing from the
File Menu

2 You can take the following action:

To print results for selected sample files after analysis: (continued)

Step Action

You can either... Then...

Click the Print button. The Print dialog box opens.

Make any changes to the 
settings and click OK.

Select Print (Ctrl+P) from the 
File menu.

Select Print One from the File 
menu.

The sample files are printed.

Note The Print dialog box 
does not appear.

To print a sample file from the File menu: 

Step Action

1 Select Open from the File menu.

The Open Existing dialog box opens.

Note You can also double-click the sample file name in the folder 
containing the files. If the GeneScan® Analysis Software is not 
running, the software starts and opens the sample file.

2 Click the Sample icon.

An Open dialog box opens.

3 In the dialog box, navigate to the folder and select the sample file 
that you want to open.

4 Click Open. 

The Sample File window opens. 

For more information about the Sample File window, see page 4-8.

5 Select one of the five views of the Sample File window, and select 
Print or Print One from the File menu.

Note If you select Print One, then the Print dialog box does not 
appear.
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Creating GeneScan 
Analysis Modules A
Overview

In This Chapter Analysis modules provide the auto-analysis feature with the parameters 
to use for the GeneScan® Analysis Software. For more information 
about analysis parameters, refer to Chapter 5, “Working with Analysis 
Parameters.” 

This appendix includes the following topics:

Topic See Page

About GeneScan Analysis Modules A-2

Creating GeneScan Analysis Modules A-5

A
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About GeneScan Analysis Modules 

Introduction The GeneScan Analysis Software modules contain the following 
analysis options:

� Analysis range to use

� Statistical method used to fit the standard curve to the size 
standards data

Analysis Module
Format

GeneScan analysis modules have the file name format filename.gsp 
and are stored in the Params folder.

The path is: D:\AppliedBio\Shared\Analysis\Sizecaller\Params

Files Referenced
by the Module

GeneScan analysis modules reference two types of companion files 
that contain other analysis parameter information.

Default Settings The following table describes the default settings for the analysis 
parameters:  

File type Description

Sizecaller 
standard file

Size standards are specific DNA fragments of known 
sizes. After defining the peaks of a size standard, the 
GeneScan® Analysis Software matches this definition 
to the internal size standard included with the run. The 
software assigns the defined size values to the 
appropriate peaks of the internal size standard, and 
uses this information with the selected sizecalling 
method to size all unknown fragments.

Size standard setting is used only during auto-analysis 
by 3100 and 3700 Data Collection software. 

For more information, refer to “What Are Size 
Standards” on page 7-2.
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Sizecaller 
parameter file

There are two sizecaller parameter files. The format is 
filename.scp, and they are stored in the SizeStandards 
folder at the following directory location:

D:\AppliedBio\Shared\Analysis\Sizecaller\Params

Note Do not move or delete these files.

The following table describes the default settings for the analysis 
parameters: (continued)

File type Description

File Use this file...

ABISizecallerAu
toAnalysis.scp

when the run data is being 
analyzed automatically (the 
first time it is analyzed).

ABISizecallerGS
Analysis.scp

if the data is re-analyzed.
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Relationship
Between a Module

and the Files

The relationship between an analysis module and the two companion 
files is illustrated below.

Never Modify the
Files

Never modify the sizecaller standard file or the sizecaller parameter file. 
If you modify one of these files, it will no longer work. 

Filename.gsp

Filename.scp

Filename.szs

Filename.scp

Filename.szs

Written in ABI Format, a 
GeneScan Analysis 
Software module contains 
the name of the basecaller 
settings file to be referenced.

The sizecaller standard fie and 
sizecaller parameter file are 
referenced while the analysis 
module is being read 
automatically.
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Creating GeneScan Analysis Modules

Summary of the
Procedure

Follow these steps to create an analysis module:

Step Action

1 Review the size standards data and select the analysis parameters 
that remove unwanted noise and peaks outside of the size range of 
the standards.

See step 1 in the “Creating a Size Standard File” procedure below.

2 Create a size standard file (filename.szs) for the reviewed 
standards.

See step 2 on page A-6 to step 10 on page A-9.

3 Review the sample file of a sample to be sized, selecting the 
analysis parameters that optimize the appearance of the data.

See step 1 on page A-9 to step 4 on page A-11.

4 Save the analysis parameters as a new .gsp file, referencing the 
size standard file just created.

See step 5 on page A-11 to step 8 on page A-12.
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Creating a Size
Standard File

To create a size standard file: 

Step Action

Reviewing and Choosing a Size Standard as a Template

1 Review the size standard data and optimize the analysis 
parameters.

2 Select New (Ctrl+N) from the File menu. 

The Create New dialog box opens.

3 Click the Size Standard icon.

The Select Sample File browser box opens. 

4 Navigate to the Completed folder at the following directory location:

D:\AppliedBio\DataExtractor\Completed
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5 Select the GeneScan Analysis Software sample file, with the 
extension .fsa, that you want to use as a template.

6 Click Open. 

The Select Dye and Analysis Parameters dialog box opens.

7 From the Dye pop-up menu, select the dye that was used to label 
the size standard DNA fragments.

To create a size standard file: (continued)

Step Action
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8 From the Analysis Parameters pop-up menu, select Analysis 
Parameters.

This references the current analysis parameter setting rather than a 
specific analysis parameter file.

9 Click OK.

The following is an example of the dialog box that opens:

To create a size standard file: (continued)

Step Action
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10 In the Size column, enter the known sizes of the standard’s peaks.

Saving the Size Standard

1 Select Save from the File menu.

The Save this document as dialog box opens.

2 Navigate to and open the Size Standards folder (see below). 

The folder contains size standards (.szs) files.

The path is 
D:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards 

3 Enter a name in the File name text box for the size standards files, 
and click Save.

The dialog box closes and the file is saved to the correct location for 
auto-analysis to read.

4 Click the Close button ( ) in the newly created Filename.szs 
dialog box.

The dialog box closes.  

To create a size standard file: (continued)

Step Action
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Creating an
Analysis

Parameter File

To create an analysis parameter file: 

Step Action

1 In the GeneScan Analysis Software, select New from the File menu. 
The Create New dialog box opens.

2 Click the Analysis Parameters icon. An untitled Analysis Parameters 
dialog box opens.

Note To display the orange Peak Amplitude Threshold use the 
scroll bar under the values and scroll to the right. 

Note The Size Standard option is only specific to the 3100 and 
3700 instruments. 
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3 Complete the dialog box using the definitions in the “Sizecaller 
Algorithm Flowchart” on page 5-4.

4 In the AutoAnalysis Only group box, select from the pop-up menu 
the size standard that you just created.

5 Select Save from the File menu.

The Save this document as dialog box opens.

6 Navigate to and open the Params folder.

The path is: 

D:\AppliedBio\Shared\Analysis\Sizecaller\Params

To create an analysis parameter file: (continued)

Step Action
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7 Enter a file name for the analysis parameter file in the File name text 
box, and click Save.

This saves the file to the correct location for auto-analysis to read.

8 Click the Close button in the newly created Filename.gsp dialog 
box. 

To create an analysis parameter file: (continued)

Step Action
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Sizecalling Methods B

Overview

In This Appendix Topics in this appendix includes the following:

Topic See Page

Least Squares Method B-2

Cubic Spline Interpolation Method B-4

Local Southern Method B-5

Global Southern Method B-7

B
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Least Squares Method

About This
Method

Both Least Squares Methods (2nd Order and 3rd Order) use regression 
analysis to build a best-fit sizecalling curve. This curve compensates for 
any fragments that may run anomalously. As a result, this method 
normally results in the least amount of error for all the fragments, 
including the size standards and the samples.

Depending on whether you choose the 2nd or 3rd Order Least Squares 
Method in the Analysis Parameters dialog box, the resulting size curve 
is either a quadratic function or a cubic function. The software uses the 
known standard fragments and the associated scan number positions 
to produce a sizing curve based on multiple linear regression.

Least Squares
Sizecalling
Examples

The first figure below shows the 2nd Order Least Squares sizecalling 
curve, and the second figure shows the 3rd Order Least Squares 
sizecalling curve.

Figure B-1 2nd Order Least Squares sizecalling curve
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Figure B-2 3rd Order Least Squares sizecalling curve

Advantages In nearly all instances in the “Least Squares Sizecalling Examples” 
above, the mobility of an individual DNA fragment is coincident with the 
best curve fit of the entire data set. Stated differently, the mobility of 
most DNA fragments is strictly length dependent. This method 
automatically compensates for fragments that run anomalously.

GeneScan® Analysis Software calculates a best-fit least squares curve 
for all samples, regardless of the sizecalling method you choose. The 
curve is black in the Standard Sizing Curve window.
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Cubic Spline Interpolation Method

About This
Method

By definition, the Cubic Spline Method forces the sizing curve through 
all the known points of the selected GeneScan size standard. Although 
this produces exact results for the values of the standards themselves, 
it does not compensate for standard fragments that may run 
anomalously.

Possible Local
Sizing Inaccuracy

Mobility of any DNA fragment can be affected by its sequence and by 
secondary and tertiary structure formation. If any internal size standard 
fragment has anomalous mobility, the Cubic Spline Method may exhibit 
local sizing inaccuracy.

For example: Assume that a standard fragment is close in molecular 
length to an unknown sample fragment. Assume further that the 
standard fragment runs anomalously. The Cubic Spline Method assigns 
the official value to this standard fragment, even though it may be 
slightly incorrect. The size of the unknown fragment is then likely to be 
calculated incorrectly as well. 

Note This method does not determine the amount of sizing accuracy error.
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Local Southern Method

About This
Method

The Local Southern Method determines the sizes of fragments by using 
the reciprocal relationship between fragment length and mobility, as 
described by E. M. Southern (1979).

The Equation The following equation attempts to describe the reciprocal relationship 
between the mobility, m, and the length, L0, of the standard fragments: 

L = [c/(m – m0)] + L0 
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How This Method
Works

This method, which is similar to the Cubic Spline Method, uses the four 
fragments closest in size to the unknown fragment to determine a 
best-fit line value. Using this method, only the region of the size ladder 
near the fragment of unknown length is analyzed. 

Note Size estimates may be off if any of the standard fragments run 
anomalously.

The following table summarizes how the Local Southern Method works:

Step Action

1 The fitting constants of the curve are calculated for each group of 
three neighboring points on the standard. 

A separate curve is created for each set of three points.

2 A curve is then created by using three standard points (two points 
below and one point above the fragment), and a fragment size is 
determined.

3 Another curve is created by looking at an additional set of three 
points (one point below and two points above the fragment) and 
another value is assigned. 

4 The two size values are averaged to determine the unknown 
fragment length.
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Global Southern Method

About This
Method

This method is similar to the Least Squares Method in that it 
compensates for standard fragments that may run anomalously. The 
method creates a best-fit line through all the available points, and then 
uses values found on that line to calculate the fragment values.

The Equations The following table describes how the equations work:

Equation Description

L = [c/(m – m0)] + L0 Attempts to describe the reciprocal 
relationship between the mobility, m, 
and the length, L0, of the standard 
fragments.

∑i(Li - (c/(mi – m0) + L0))2 The fitting constants L0, m0, and c 
are calculated by a least squares fit 
to minimize the following quantity. 
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How This Method
Works

All points in the standard are weighted equally, and the curve is not 
constrained to go through any specific point. The software can analyze 
a large range of fragment sizes with this method.

For best results, use a standard that brackets all the fragments of 
interest.

DNA fragments that are... Are sized using...

not bracketed within the size 
standard curve

a second-order least squares curve 
extrapolation.

bracketed within the size standard 
curve

the method that was chosen.
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GeneScan Size 
Standards C
Overview

About the Size
Standards

The GeneScan Analysis Software comes with several ready-to-use size 
standard definition files that you can choose from to analyze fragments 
run on the ABI PRISM® 3700 DNA Analyzer. The size standards are 
stored in the SizeStandards folder.

The path is:
D:\AppliedBio\Shared\Analysis\Sizecaller\SizeStandards

See also “About Size Standards” on page 7-2.

Size Standards
Included

The following table lists the ready-to-use size standards: 

The table below lists size standards in which some of the fragments 
have been set to 0.

Note You can easily remove any of these sizes by opening the definition and 
setting any unwanted sizes to 0. 

Size Standard See Page

GS 120.szs C-2

GS 350 All.szs C-4

GS 400HD.szs C-9

GS 500 All.szs C-11

Size Standard See Page

GS 350 377.szs C-7

GS 350-250.szs C-8

GS 500 377.szs C-13

GS 500-250.szs C-14

C
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GeneScan 120 Size Standard

About This Size
Standard

You can use the GeneScan-120 LIZ size standard to determine 
fragment lengths between 15 and 120 base-pairs.

Special Uses This size standard was designed to provide accurate sizing of short 
DNA fragments. Therefore, it is particularly useful for SNP analysis. All 
fragments have been checked for migration that is true to size under a 
wide variety of run conditions. There are no anomalous fragments.

How It Is Prepared All aspects of the preparation of the GeneScan 120 LIZ size standard 
are proprietary. Each fragment contains a single LIZ fluorophore.

Fragment Lengths The following table lists the lengths of the nine fragments that comprise 
the GeneScan 120 LIZ size standard: 

Denaturing
Electropherogram

The GeneScan 120 LIZ size standard is made of single-stranded DNA 
fragments. The following figure shows the peak patterns of GeneScan 
120 fragments run under denaturing conditions. Fragments were run 
using the 3700 POP-5 polymer at 60  °C.

15

20

25

35

50

62

80

110

120
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Electropherogram
of GeneScan 120

LIZ

The following is an electropherogram of GeneScan 120 LIZ:
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GeneScan 350 All Size Standard

About This Size
Standard

The GeneScan 350 All size standard contains sizes for all fragments in 
the GS 350 size standard. This size standard is useful for sizing 
fragments between 35 and 350 base-pairs. The native fragments are 
uniformly spaced to provide accurate sizecalling.

How It Is Prepared The GeneScan 350 All size standard is prepared by Pst 1 digestion of 
plasmid DNA, followed by ligation of a TAMRA or ROX-labeled 22-mer 
oligodeoxynucleotide to the cut ends. A subsequent enzymatic 
digestion with BstU 1 yields DNA fragments containing a single TAMRA 
or ROX dye (see “GeneScan 350 Molecular Lengths” below).

GeneScan 350
Molecular Lengths

The following table lists the GeneScan 350 Denatured Fragment 
Molecular Lengths (Nucleotides):

35 160

50 200

75 250

100 300

139 340

150 350
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Running Under
Denaturing
Conditions

The following table describes running the GeneScan 350 All standard 
under denaturing conditions:

Like the GeneScan 2500 and 
GeneScan 1000 standard...

However, like the GeneScan 
250 standard... Consequently

the GeneScan 350 standard is 
made of double-stranded DNA 
fragments. 

the GeneScan 350 standard 
has only one labeled strand.

under denaturing conditions, 
even if the two strands migrate 
at different rates, only the 
labeled strand is detected. 
Refer to “Electropherogram of 
GeneScan 350” below. 

Because of this, split peaks are 
avoided that result when two 
strands move through a 
denaturing polymer at different 
rates. 
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Electropherogram
of GeneScan 350

The following is an electropherogram of GeneScan 350 run under 
denaturing conditions:

Double-Stranded
GeneScan 500

Fragments

The following figure shows the sizes of double-stranded GeneScan 500 
fragments. Use these values to size fragments run under native 
conditions.

IMPORTANT An asterisk (*) for the 250 and 340 base-pair peaks denotes 
peaks resulting from abnormal migration of double strands that did not 
completely separate under denaturing conditions when analyzed on the 3100 
and 3700 instruments. Do not use these peaks to size samples. The peaks 
show smaller values than the actual size of the fragments. 
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GeneScan 350 377 Size Standard

About This Size
Standard

The GeneScan 350 377 size standard contains all GS 350 fragment 
sizes except the 35 and 50 base-pair sizes. The two smallest fragments 
(35 and 50 base-pairs) are often lost in the primer peak on gel 
instruments. The construction of this size standard differs from the GS 
500 377.szs. This is because its electropherogram begins only after the 
50 base-pair peak (depending on the run conditions), so the two 
smallest sizes are not present and do not need to be set to 0 (as in the 
GS 500 377 size standard).

This size standard can be used on any instrument.

GeneScan 350 377
Molecular Lengths

The following table lists the GeneScan 350 denatured fragment 
molecular lengths (nucleotides):

Electropherogram
of GeneScan

350 377

The following is an electropherogram of GeneScan 350 377 run under 
denaturing conditions:

75 200

100 250

139 300

150 340

160 350
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GeneScan 350-250 Size Standard

About This Size
Standard

The GeneScan 350-250 size standard contains all GS 350 fragment 
sizes except the 250 base-pair size, which has been set to 0.

GeneScan 350-250
Molecular Lengths

The following table lists the GeneScan Denatured Fragment Molecular 
Lengths (Nucleotides): 

Electropherogram
of GeneScan

350-250

The following is an electropherogram of GeneScan 350-250 run under 
denaturing conditions:

35 160

50 200

75 0

100 300

139 340

150 350
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GeneScan-400HD Size Standard

About This Size
Standard

Use the GeneScan-400HD (High Density) size standard to determine 
fragment lengths between 50 and 400 base-pairs.

Special Uses The high density of marker bands in this standard makes it particularly 
useful for microsatellite analysis. All fragments have been checked for 
migration that is true to size under a wide variety of run conditions on all 
ABI PRISM® instruments. There are no anomalous fragments 
(compared with the 250-bp fragment in GeneScan 350 or 500 on the 
3700 Analyzer).

GeneScan-400HD is the recommended size standard for use with the 
ABI PRISM Linkage Mapping Sets.

How It Is Prepared All aspects of the preparation of the GeneScan-400HD size standard 
are proprietary. Each fragment contains a single ROX fluorophore.

Fragment Lengths The following table lists the lengths of the 21 fragments that make up 
the GeneScan-400HD size standard:

Denaturing
Electropherogram

Although the GeneScan-400HD size standard is made of 
double-stranded DNA fragments, only one of the strands is labeled. 
Consequently, even if the two strands migrate at different rates under 
denaturing conditions you will not need to worry about peak splitting. 
The following figure shows the peak patterns of GeneScan-400HD 
fragments run under denaturing conditions. Fragments were run using 
the 3700 POP-6™ polymer at 50 °C.

50 160 260 360

60 180 280 380

90 190 290 400

100 200 300

120 220 320

150 240 340



C-10 GeneScan Size Standards

Electropherogram
of

GeneScan-400HD

The following is an electropherogram of GeneScan-400HD: 
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GeneScan 500 All Size Standard

About This Size
Standard

The GeneScan 500 All size standard contains all fragments in the GS 
500 size standard. This size standard is useful for sizing fragments 
between 35 and 500 base-pairs. The native fragments are uniformly 
spaced to provide accurate base calling.

How It Is Prepared The GeneScan 500 All size standard is prepared by Pst 1 digestion of 
plasmid DNA, followed by ligation of a TAMRA or ROX-labeled 22-mer 
oligodeoxynucleotide to the cut ends. A subsequent enzymatic 
digestion with BstU 1 yields DNA fragments containing a single TAMRA 
or ROX dye (see “GeneScan 350 Molecular Lengths” below).

GeneScan 500
Molecular Lengths

The following table lists the GeneScan 500 denatured fragment 
molecular lengths (nucleotides):

Running Under
Denaturing
Conditions

Like the GeneScan 2500 and GeneScan 1000 standard, the GeneScan 
500 standard is made of double-stranded DNA fragments. However, 
with the GeneScan 500, only one strand of the double-stranded DNA is 
labeled, whereas the other two standards have labels on both strands. 
Consequently, under denaturing conditions, even if the two strands 
migrate at different rates, only the one labeled strand is detected. 
Because of this, split peaks are avoided that result when two strands 
move through a denaturing polymer at different rates. 

Refer to “Electropherogram of GeneScan 500” below.

35 250

50 300

75 340

100 350

139 400

150 450

160 490

200 500
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Electropherogram
of GeneScan 500

The following is an electropherogram of GeneScan 500 run under 
denaturing conditions:

Double-Stranded
GeneScan 500

Fragments

The following figure shows the sizes of double-stranded GeneScan 500 
fragments. Use these values to size fragments run under native 
conditions.
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GeneScan 500 377 Size Standard

About This Size
Standard

The GeneScan 500 377 size standard includes all GS 500 fragment 
sizes except the 35 and 50 base-pairs, which have been set to 0. The 
two smallest fragments (35 and 50 base-pairs) are often lost in the 
primer peak on gel instruments. 

This size standard can be used on any instrument.

GeneScan 500 377
Molecular Lengths

The following table lists the GeneScan 500 377 denatured fragment 
molecular lengths (nucleotides): 

Electropherogram
of GeneScan 500

377

The following is an electropherogram of GeneScan 500 377 run under 
denaturing conditions:

0 250

0 300

75 340

100 350

139 400

150 450

160 490

200 500
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GeneScan 500-250 Size Standard

About This Size
Standard

The GeneScan 500-250 size standard has the 250 base-pair peak set 
to 0, since this peak does not migrate as it should on capillary 
instruments.

Note The 340 base-pair peak is still present in this file and may not migrate 
properly. You can check this for the run conditions by changing the 340 
base-pair definition to 0, and then use the GeneScan Analysis Software to size 
the size standard. If you are not happy with GeneScan’s size for the 340 
base-pair fragment, then it is not migrating properly and you should not use it for 
your definition.

GeneScan 500-250
Molecular Lengths

The following table lists the GeneScan 500-250 denatured fragment 
molecular lengths (nucleotides):

35 0

50 300

75 340

100 350

139 400

150 450

160 490

200 500
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Electropherogram
of GeneScan

500-250

The following is an electropherogram of GeneScan 500-250 run under 
denaturing conditions:
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Troubleshooting the 
GeneScan Software D
Introduction

In This Appendix The tables in this section present information about problems you might 
experience with your GeneScan® Analysis Software runs and suggest 
possible causes and corrections.

Topics in this appendix include the following:

Topics See Page

Troubleshooting Projects and Results D-2

Troubleshooting Gel Data D-4

Troubleshooting Genotyping Results D-7

GeneScan Analysis Software Error Messages D-8

D
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Troubleshooting Projects and Results

Table Description The following table describes the problem, probable cause, and 
correction for troubleshooting projects and results:  

Problem Probable Cause Correction

File name is dimmed in 
Size Standard or 
Parameters column in 
Analysis Control 
window.

The file has been 
moved from the folder 
of its original location.

a. Move the file back to 
its original location.

b. Reset preferences 
to specify the new 
folder location.

c. Create or select a 
new file.

Peaks appear on 
display but the 
GeneScan Analysis 
Software does not 
detect them (cannot 
select them in 
electropherogram 
display).

� Peak Amplitude 
Threshold set too 
high.

� Minimum Peak Half 
Width set too high.

� Electrophoresis run 
too quickly resulting 
in poor resolution.

a. Adjust minimum 
peak height to 
include smallest 
peaks desired and 
re-analyze.

b. Reduce minimum 
peak half-width 
setting and 
re-analyze.

c. Repeat 
electrophoresis at 
reduced power.

For more information, 
refer to “Peak 
Detection Options” on 
page 5-8.

At the position of one 
strong peak additional 
colors appear 
underneath the peak.

Off-scale data not 
multicomponented 
correctly.

a. Repeat 
electrophoresis; 
load less sample.

b. Regenerate sample 
files.

Peaks appearing in a 
dye color that should 
not be present.

Bleed-through from 
other colors because of 
off-scale data.

Repeat 
electrophoresis; load 
less sample.
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Peak centers seem to 
be incorrect in 
electropherogram.

� Resolution of the 
gel might be 
inadequate (ABI 
PRISM® 377). 

� Signal-to-noise ratio 
might be too low.

Repeat electrophoresis 
at lower power.

Software cannot 
display the sizing curve 
for a sample.

� Sample’s in-lane 
size standard does 
not match defined 
size standard.

� Sample file was not 
sizecalled.

� Re-analyze the 
sample file with a 
different size 
standard or create a 
new one.

In the Analysis Control 
window:

a. Ctrl+click 
dye/sample that 
represents Size 
Standard for the 
sample file.

b. Select a size 
standard definition 
file and re-analyze.

Peaks disappear in the 
electropherogram.

Included the primer 
peak in the analysis.

Re-analyze sample file 
without primer peak. 

The following table describes the problem, probable cause, and 
correction for troubleshooting projects and results: (continued)

Problem Probable Cause Correction
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Troubleshooting Gel Data

Table Description The following table lists the problem, probable cause, and correction for 
troubleshooting of gel data:  

Problem Probable Cause Correction

At the position of one 
strong peak, additional 
colors appear 
underneath the peak.

� Off-scale data not 
multicomponented 
correctly.

� Poor / incorrect 
matrix.

� Gel Image not 
multicompo-
nented.

a. Repeat 
electrophoresis; 
load less sample.

b. Attach a new gel 
matrix, regenerate 
the gel image.

c. Regenerate the gel 
image with 
multicomponenting 
selected. 

Peaks appearing in a 
dye color that should 
not be present.

Bleed-through from 
other colors because of 
off-scale data.

Repeat 
electrophoresis; load 
less sample.

TAMRA-labeled size 
standard appears 
yellow on the gel 
display.

Collected using:

� Filter set A 
(ABI 373), or

� Virtual filter A 
(ABI PRISM 377).

Repeat electrophoresis 
with:

� Filter set B 
(ABI 373), or 

� Virtual filter C 
(ABI PRISM 377).

TET-labeled products 
not seen on gel display.

Collected using:

� Filter set A 
(ABI 373), or

� Virtual filter A 
(ABI PRISM 377).

Repeat electrophoresis 
with:

� Filter set B 
(ABI 373), or 

� Virtual filter C 
(ABI PRISM 377).
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Signal showing up in 
neighboring lanes.

Leaking wells of gel. � Consider using a 
square-tooth comb 
instead of a 
shark-tooth comb.

� If using 96 lanes, 
then rerun gel 
using protocol in 
the ABI PRISM 377 
DNA Sequencer 
96-Lane Upgrade 
User’s Manual 
(P/N 4305423).

Signal intensity very 
high and signal is 
being detected in 
neighboring lanes due 
to closeness of 
spacing.

Move tracker lane 
position from center of 
band to edge of the 
band away from strong 
signal and extract as 
usual.

Use 1- or 2-lane 
averaging to extract 
lanes.

HEX-labeled products 
appear green on gel 
display.

Collected using:

� Filter set A 
(ABI 373), or 

� Virtual filter A 
(ABI PRISM 377).

Repeat electrophoresis 
with:

� Filter set B 
(ABI 373), or 

� Virtual filter C 
(ABI PRISM 377).

Collection time was 
sufficient, but only a 
small portion of gel 
displayed.

� Gel Image 
Processing 
preferences did 
not include 
enough scans to 
display entire gel. 

� Electrophoresis 
power too low.

a. Regenerate gel 
image with new 
scan range.

b. Adjust to correct 
settings; repeat 
electrophoresis.

The following table lists the problem, probable cause, and correction for 
troubleshooting of gel data: (continued)

Problem Probable Cause Correction
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Improper tracking 
results.

Bad matrix. Attach new matrix.

Sample Sheet not filled 
out properly.

Fill out Sample Sheet 
properly.

Comb types set 
improperly.

a. Fix and type in gel 
preferences.

b. Retrack gel.

Peak height or red 
signal too low.

Rerun gel with more 
size standard.

The following table lists the problem, probable cause, and correction for 
troubleshooting of gel data: (continued)

Problem Probable Cause Correction



Troubleshooting the GeneScan Software D-7

Troubleshooting Genotyping Results

Table Description The following table describes the problem, probable cause, and 
correction for troubleshooting the Genotyper® software results:

Problem Probable Cause Correction

Allele peaks seen in 
correct molecular 
weight range, with 
additional peaks 
seen outside this 
range.

� Bleed-through from 
other colors because 
of off-scale data.

� Primers not fully 
optimized.

a. Repeat 
electrophoresis; 
load/inject less 
sample.

b. Check optimization.

With allele peaks of 
high intensity, the 
GeneScan Analysis 
Software calls many 
small peaks.

� Background above 
minimum peak 
height.

� Too much PCR 
product loaded.

a. Adjust minimum 
peak height 
threshold; 
re-analyze.

b. Repeat 
electrophoresis; 
load/inject less 
sample.

For more information, 
refer to “Peak Detection 
Options” on page 5-8.

A homozygous 
individual shows a 
dip at the top of an 
allele peak which 
may be called as two 
separate peaks.

Truncated single peak 
because of off-scale 
data can appear as two 
peaks.

Repeat electrophoresis; 
load/inject less sample.

Warning message: 
“Could not complete 
‘Run Macro’ 
command because 
the labeled peak 
could not be found.”

The first allele peak for 
one or more loci in the 
allelic ladder is lower 
than the preset 
minimum peak height 
specification in the 
categories list.

a. Adjust minimum 
peak height; 
re-analyze.

b. Repeat 
electrophoresis; 
load/inject less 
sample.

For more information, 
refer to “Peak Detection 
Options” on page 5-8.
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GeneScan Analysis Software Error Messages

Introduction This section includes two tables:

� Analysis Log Error Messages

� Error Messages When Defining Size Standards

Analysis Log
Error Messages

The following table describes the error messages you might encounter 
in the GeneScan Analysis Software Log: 

Analysis Log Error 
Message Comment/Correction Refer To

The Analysis Range 
parameter does not 
include enough data 
points. 

Check your analysis 
parameters.

Make sure the Analysis 
Range in your analysis 
parameters contains at 
least 250 data points.

“Setting Analysis 
Parameters” on 
page 5-5.

The Range of Data 
Points parameter to 
analyze is too large. 

Check your analysis 
parameters.

Specify a smaller 
range in the analysis 
parameters.

“Setting Analysis 
Parameters” on 
page 5-5.

The analysis 
Parameters could not 
be accessed. 

Check your Analysis 
Parameters Setting.

Make sure the Analysis 
Parameters file 
specified in the 
Analysis Control 
window is valid and 
accessible.

“Setting Analysis 
Parameters” on 
page 5-5.
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Error Messages
When Defining
Size Standards

The following table describes the error messages you might encounter 
while defining size standards:

Error Message Comment/Correction Refer To

The affected sample 
file is not available. 

Locate the sample file 
and try again.

If the sample file name 
is dim in the Analysis 
Control window, the 
GeneScan Analysis 
Software has not 
located the sample file. 

You can instruct the 
program to search for 
the sample file.

“Finding Missing 
Sample Files” on 
page 2-14.

A Dye Standard is not 
selected for the 
affected sample file. 

Select a Dye Standard 
and try again.

Select the dye/sample 
that represents the 
standard by 
Ctrl+clicking the 
appropriate 
dye/sample field.

The affected sample 
file does not have a 
valid Analysis 
Parameters Selection. 

Select new analysis 
parameters and try 
again.

Select either:

� The default program 
parameters 
(<Analysis 
Parameter >), or

� A valid analysis 
parameters file in 
the Analysis Control 
window.

“Using Analysis 
Parameter Files” on 
page 5-13.

No peaks were found 
within the Analysis 
Range. 

Check your analysis 
parameters.

� Make sure the Peak 
Amplitude Threshold 
setting allows for 
detection of the 
peaks in your 
sample. 

� If peaks in your data 
are narrow, make 
sure the Minimum 
Peak Half Width is a 
small number.

“Sizecaller Algorithm 
Flowchart” on 
page 5-4.
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GeneScan Analysis 
Software Files E

Table of Files The following table lists the files that the GeneScan Analysis Software 
reads, writes, and, in most cases, creates. The software does not create 
gel files, and creates Sample files only through lane extraction from a 
gel. 

Table E-1 GeneScan Analysis Software files  

File Type Created by Location Where is it used

.fsa 3700 Data Extractor 
3100 Data Extractor 
Gel Processor (377) 
310 Data Collection

In a folder often with the title 
"Run Folder"

GeneScan software 
can be used to display, 
view and edit any .fsa 
file. 

.gel 377 Data Collection In a folder often with the title 
"Run Folder"

The gel file contains 
the raw data collected 
during the instrument 
run. The gel file is 
tracked and data is 
extracted into sample 
files by Gel Processor. 

filename.gsp Shipped with 
GeneScan software. 
Users can create 
custom files.

D:\AppliedBio\Shared\Analysis
\Sizecaller\Params

These files specify 
certain ranges and 
methods used during 
data analysis. Users 
can create custom .gsp 
files. 

filename.szs Shipped with 
GeneScan software. 
Users can create 
custom files.

D:\AppliedBio\Shared\Analysis
\Sizecaller\SizeStandards

These files are used to 
identify peak sizes for 
specified size 
standards run under 
certain conditions. 
Users can define the 
standards after running 
them on the 
instruments. 

E
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filename.prj GeneScan Software User can specify location. This 
file is often stored in a folder 
with the sample files in of the 
corresponding project

Projects contain 
references to Sample 
files. Sample files of a 
single project can be 
from one or multiple 
runs. Projects allow a 
group of data to be 
organized, displayed 
and analyzed together. 

filename.mxt GeneScan Software, 
using the Matrix 
making feature

Matrix files must be 
created for each 
instrument. The matrix 
standards are collected 
on 310 and 377 
instruments. These 
files are used to create 
.mxt files using 
GeneScan Analysis 
software.

Sample 
log.log

GeneScan Software D:\AppliedBio\GeneScan\Bin Contains a running 
record of analysis 
performed by the 
software

Analysis 
log.log

GeneScan Software D:\AppliedBio\GeneScan\Bin Contains a running 
record of analysis 
performed by the 
software

Table E-1 GeneScan Analysis Software files (continued)

File Type Created by Location Where is it used
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Technical Support F
Contacting

Technical Support
You can contact Applied Biosystems for technical support by telephone 
or fax, by e-mail, or through the Internet. You can order Applied 
Biosystems user documents, MSDSs, certificates of analysis, and other 
related documents 24 hours a day. In addition, you can download 
documents in PDF format from the Applied Biosystems Web site 
(please see the section “To Obtain Documents on Demand” following 
the telephone information below).

To Contact
Technical Support

by E-mail

Contact technical support by e-mail for help in the following product 
areas:

Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems and 
PCR

pcrlab@appliedbiosystems.com

Protein Sequencing, 
Peptide and DNA Synthesis

corelab@appliedbiosystems.com

Biochromatography, PerSeptive 
DNA, PNA and Peptide Synthesis 
systems, CytoFluor®, FMAT™, 
Voyager™, and Mariner™ Mass 
Spectrometers

tsupport@appliedbiosystems.com

Applied Biosystems/MDS Sciex api3-support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com

F
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Hours for
Telephone

Technical Support

In the United States and Canada, technical support is available at the 
following times:

To Contact
Technical Support

by Telephone or
Fax

In North America

To contact Applied Biosystems Technical Support, use the telephone or 
fax numbers given below. (To open a service call for other support 
needs, or in case of an emergency, dial 1-800-831-6844 and press 1.)

Product Hours

Chemiluminescence 8:30 a.m. to 5:30 p.m. Eastern Time

Framingham support 8:00 a.m. to 6:00 p.m. Eastern Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time

Product or
Product Area

Telephone
Dial...

Fax
Dial...

ABI PRISM® 3700 DNA 
Analyzer

1-800-831-6844,
then press 8

1-650-638-5981

DNA Synthesis 1-800-831-6844,
then press 21

1-650-638-5981

Fluorescent DNA 
Sequencing

1-800-831-6844,
then press 22

1-650-638-5981

Fluorescent Fragment 
Analysis (includes 
GeneScan® applications)

1-800-831-6844,
then press 23

1-650-638-5981

Integrated Thermal Cyclers 
(ABI PRISM® 877 and 
Catalyst 800 instruments)

1-800-831-6844,
then press 24

1-650-638-5981

ABI PRISM® 3100 Genetic 
Analyzer

1-800-831-6844,
then press 26

1-650-638-5981

BioInformatics (includes 
BioLIMS®, BioMerge®, and 
SQL GT™ applications)

1-800-831-6844,
then press 25

1-505-982-7690

Peptide Synthesis (433 and 
43X Systems)

1-800-831-6844,
then press 31

1-650-638-5981

Protein Sequencing 
(Procise Protein 
Sequencing Systems)

1-800-831-6844,
then press 32

1-650-638-5981



Technical Support F-3

PCR and Sequence 
Detection

1-800-762-4001,
then press 1 for 
PCR,
2 for the 7700 or 
5700,
6 for the 6700
or dial 
1-800-831-6844, then 
press 5

1-240-453-4613

Voyager MALDI-TOF 
Biospectrometry and 
Mariner ESI-TOF Mass 
Spectrometry Workstations

1-800-899-5858,
then press 13

1-508-383-7855

Biochromatography 
(BioCAD Workstations and 
Poros Perfusion 
Chromatography Products)

1-800-899-5858,
then press 14

1-508-383-7855

Expedite Nucleic acid 
Synthesis Systems

1-800-899-5858,
then press 15

1-508-383-7855

Peptide Synthesis 
(Pioneer and 9050 Plus 
Peptide Synthesizers)

1-800-899-5858,
then press 15

1-508-383-7855

PNA Custom and Synthesis 1-800-899-5858,
then press 15

1-508-383-7855

FMAT 8100 HTS System 
and CytoFluor 4000 
Fluorescence Plate Reader

1-800-899-5858,
then press 16

1-508-383-7855

Chemiluminescence 
(Tropix)

1-800-542-2369 (U.S. 
only),
or 1-781-271-0045

1-781-275-8581

Applied Biosystems/MDS 
Sciex

1-800-952-4716 1-650-638-6223

Product or
Product Area

Telephone
Dial...

Fax
Dial...
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Outside North America

Region
Telephone
Dial...

Fax
Dial...

Africa and the Middle East

Africa (English Speaking) 
and West Asia (Fairlands, 
South Africa)

27 11 478 0411 27 11 478 0349

South Africa 
(Johannesburg)

27 11 478 0411 27 11 478 0349

Middle Eastern Countries 
and North Africa (Monza, 
Italia)

39 (0)39 8389 481 39 (0)39 8389 493

Eastern Asia, China, Oceania

Australia (Scoresby, 
Victoria)

61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 86 10 64106617

Hong Kong 852 2756 6928 852 2756 6968

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 758 8268 60 3 754 9043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 2358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 712 5555 32 (0)2 712 5516

Czech Republic and 
Slovakia (Praha)

420 2 61 222 164 420 2 61 222 168

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0) 6150 101 0 49 (0) 6150 101 101

Hungary (Budapest) 36 (0)1 270 8398 36 (0)1 270 8288

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Poland, Lithuania, Latvia, 
and Estonia (Warszawa)

48 (22) 866 40 10 48 (22) 866 40 20
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Portugal (Lisboa) 351 (0)22 605 33 14 351 (0)22 605 33 15

Russia (Moskva) 7 095 935 8888 7 095 564 8787

South East Europe (Zagreb, 
Croatia)

385 1 34 91 927 385 1 34 91 840

Spain (Tres Cantos) 34 (0)91 806 1210 34 (0)91 806 1206

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands 
(Nieuwerkerk a/d IJssel)

31 (0)180 331400 31 (0)180 331409

United Kingdom 
(Warrington, Cheshire)

44 (0)1925 825650 44 (0)1925 282502

All other countries not listed 
(Warrington, UK)

44 (0)1925 282481 44 (0)1925 282509

Japan

Japan (Hacchobori, 
Chuo-Ku, Tokyo)

81 3 5566 6100 81 3 5566 6501

Latin America

Del.A. Obregon, Mexico 305-670-4350 305-670-4349

Region
Telephone
Dial...

Fax
Dial...
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To Reach
Technical Support

Through the
Internet

We strongly encourage you to visit our Web site for answers to 
frequently asked questions and for more information about our 
products. You can also order technical documents or an index of 
available documents and have them faxed or e-mailed to you through 
our site. The Applied Biosystems Web site address is

http://www.appliedbiosystems.com/techsupp

To Obtain
Documents on

Demand

Free, 24-hour access to Applied Biosystems technical documents, 
including MSDSs, is available by fax or e-mail or by download from our 
Web site.

To submit technical questions from North America or Europe:

Step Action

1 Access the Applied Biosystems Technical Support Web site.

2 Under the Troubleshooting heading, click Support Request Forms, 
then select the relevant support region for the product area of 
interest.

3 Enter the requested information and your question in the displayed 
form, then click Ask Us RIGHT NOW (blue button with yellow text).

4 Enter the required information in the next form (if you have not 
already done so), then click Ask Us RIGHT NOW.

You will receive an e-mail reply to your question from one of our 
technical experts within 24 to 48 hours.

To order 
documents... Then...

by index 
number

a. Access the Applied Biosystems Technical Support Web 
site at 
http://www.appliedbiosystems.com/techsupp

b. Click the Index link for the document type you want, 
then find the document you want and record the index 
number.

c. Use the index number when requesting documents 
following the procedures below.
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by phone for 
fax delivery

a. From the U.S. or Canada, call 1-800-487-6809, or
from outside the U.S. and Canada, call 1-858-712-0317.

b. Follow the voice instructions to order the documents 
you want.

Note There is a limit of five documents per request.

through the 
Internet for fax 
or e-mail 
delivery

a. Access the Applied Biosystems Technical Support Web 
site at 
http://www.appliedbiosystems.com/techsupp

b. Under Resource Libraries, click the type of document 
you want.

c. Enter or select the requested information in the 
displayed form, then click Search.

d. In the displayed search results, select a check box for 
the method of delivery for each document that matches 
your criteria, then click Deliver Selected Documents Now 
(or click the PDF icon for the document to download it 
immediately).

e. Fill in the information form (if you have not previously 
done so), then click Deliver Selected Documents Now to 
submit your order.

Note There is a limit of five documents per request for 
fax deliver but no limit on the number of documents you 
can order for e-mail delivery.

To order 
documents... Then...
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License and 
Warranty G
Applera Corporation Software License and Limited Product 
Warranty

Warranty
Statement

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS, 
WHICH APPLY TO THE SOFTWARE ENCLOSED (THE 
“SOFTWARE”). YOUR OPENING OF THIS PACKAGE INDICATES 
YOUR ACCEPTANCE OF THEM. IF YOU DO NOT ACCEPT THEM, 
PROMPTLY RETURN THE COMPLETE PACKAGE, AND YOUR 
MONEY WILL BE RETURNED. THE LAW PROVIDES FOR CIVIL AND 
CRIMINAL PENALTIES FOR ANYONE IN VIOLATION OF THE LAWS 
OF COPYRIGHT.

Copyright The SOFTWARE, including its structure, organization, code, user 
interface, and associated documentation, is a proprietary product of 
Applied Biosystems group of Applera Corporation, and is protected by 
international laws of copyright. Title to the SOFTWARE, and to any 
portion of the SOFTWARE, shall at all times remain with Applera 
Corporation and its subsidiaries.

License 1. You may use the SOFTWARE on a single computer (or in a single 
network, if your software is designated as a network version). You may 
transfer the SOFTWARE to another single computer (or network, if a 
network version), but the SOFTWARE may never be installed on more 
than one computer (or more than one network, if a network version) at 
any one time.

2. Registration codes for multiple users are available as follows:
Access to the number of copies of SOFTWARE is provided by a 
registration code. For example, if you have a registration code that 
enables you to three copies of SOFTWARE simultaneously, you 
cannot install the SOFTWARE in more than three separate computers.

G
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3. You may make one copy of the SOFTWARE for backup purposes.

4. You may not transfer this SOFTWARE license to a third party.

Restrictions 1. You may not copy, transfer, rent, modify, use, or merge the 
SOFTWARE, or the associated documentation, in whole or in part, 
except as expressly permitted in this Agreement.

2. You may not reverse assemble, decompile, or otherwise reverse 
engineer the SOFTWARE.

Limited Warranty For a period of 90 days after purchase of the SOFTWARE, 
Applied Biosystems warrants that the SOFTWARE will function 
substantially as described in the documentation delivered with the 
SOFTWARE. If you believe that you have discovered an error which 
causes substantial deviation from that documentation, and after written 
notification from the purchaser, and Applied Biosystems is able to 
reliably reproduce that error at Applied Biosystems’ facility, then 
Applied Biosystems will have the option to either (i) correct the error in a 
subsequent release of the SOFTWARE, which shall be supplied to you 
free of charge, or (ii) accept a return of the SOFTWARE from the 
purchaser, and refund your purchase price of the SOFTWARE. 
Applied Biosystems does not warrant that the SOFTWARE will meet 
your requirements, or will be error-free, or will conform exactly to the 
documentation. 

Limitation of
Liability

EXCEPT AS SPECIFICALLY STATED IN THIS AGREEMENT, THE 
SOFTWARE IS PROVIDED AND LICENSED “AS IS”. THIS 
WARRANTY IS GIVEN IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESSED OR IMPLIED, INCLUDING THOSE OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
APPLIED BIOSYSTEM’S SOLE LIABILITY FOR BREACH OF 
WARRANTY SHALL BE LIMITED TO A REFUND OF THE PURCHASE 
PRICE FOR SUCH PRODUCT. IN NO EVENT WILL 
APPLIED BIOSYSTEMS BE LIABLE FOR ANY DAMAGES, 
INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN 
IF APPLIED BIOSYSTEMS HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

Term You may terminate this Agreement by destroying all copies of the 
SOFTWARE and documentation. Applied Biosystems may terminate 
this Agreement if you fail to comply with all of its terms, in which case 
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you agree to return to Applied Biosystems all copies of the SOFTWARE 
and associated documentation.

Miscellaneous 1. Failure to enforce any of the terms and conditions of this Agreement 
by either party shall not be deemed a waiver of any rights and privileges 
under this Agreement.

2. In case any one or more of the provisions of this Agreement for any 
reason shall be held to be invalid, illegal, or unenforceable in any 
respect, such invalidity, illegality, or unenforceability shall not affect any 
other provisions of this Agreement, and this Agreement shall be 
construed as if such invalid, illegal, or unenforceable provisions had 
never been contained herein.

3. This Agreement shall be construed and governed by the laws of the 
State of California.

4. This Agreement constitute the entire agreement between 
Applied Biosystems and you concerning the SOFTWARE.

5. This Software License Agreement supersedes any other license 
agreement which may be contained in this software package.
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Glossary

This glossary defines special terminology used in the GeneScan Analysis Software User’s 
Manual. The terms are listed in alphabetical order. Many terms are defined in the text of the 
manual, so if you do not find a term here, check the index to see if you can locate it in the 
manual.

align-by-size curve Curve created by the GeneScan® Analysis Software for aligning data by 
size. 

The software calculates a best-fit, least-squares curve for all samples. 
This is a third-order curve when you use the Third Order Least Squares 
sizecalling method; for all other sizecalling methods it is a second-order 
curve. 

This curve is black in the Standard Sizing Curve window, although when 
the sizing curve and this curve match, they overlap so you see only the 
sizing curve. 

See also sizecalling curve and size standard spline interpolation curve.

Align By Size/Data 
Point

Shows the horizontal scale of the electropherograms by fragment size or 
by data point.

You can display data by size only if you ran an internal size standard with 
your samples and sizecalled the data.

analysis parameters Options that specify certain ranges and methods used during analysis 
using the GeneScan Analysis Software. 

The software has default analysis parameters that are stored in the project 
itself. 

These parameters apply globally, unless you create your own parameters 
files for use with specific protocols. 

baselining Adjusting the baselines of detected dye colors to the same level for a 
better comparison of relative signal intensity.
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Sequence Collector Sequence Collector (formerly BioLIMS™) is a genetic information 
management system that provides a relational database for storage and 
retrieval of DNA sequence and fragment data. 

In addition to the database itself, Sequence Collector contains a set of 
software applications and tools for maintaining and interacting with the 
database. 

The Sequence Collector database resides on a UNIX workstation and 
uses a Sybase® or an Oracle® database server. 

The client applications run on Windows NT®-based computers and/or on 
UNIX workstations. 

data point The 3700 Data Collection program samples data as it passes by the 
detector. 

Each “sampling” is stored as a data point.

dye color indicator Left color box in the Results Control window and the legend of the Results 
Display. 

In the Results Display, click this box to move the associated 
electropherogram to the front. 

In the Results Control and the Results Display windows, double-click this 
box to change the dye scale, or Ctrl+double-click it to reset the dye scale 
to the default.

dye/sample Individual sample labeled with a single dye within a sample file. 

Sample files normally contain up to four dye/samples, depending on how 
many labeled samples you included in each lane or injection of your 3700 
Data Collection program run.

electropherogram Four-color picture of a sequence, showing peaks that represent the bases. 
The term is used interchangeably with chromatogram in this manual.

grid Spreadsheet-like display used for entering data in tabular format. 

The Analysis Control and Results Control windows display grids for 
entering sample information.
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internal size standard Also called internal lane or injection size standard, DNA fragment of 
known size that you include with your run. On the ABI PRISM 3700 DNA 
Analyzer you include the size standard with each injection.

Running an internal lane standard results in particularly accurate and 
precise molecular length determination because the internal lane standard 
and the unknown fragments undergo exactly the same electrophoretic 
forces. 

The software can then compensate for band-shift artifacts caused by 
variations in the run.

legend Informational text that appears beneath electropherogram panels in the 
results displays. 

You can show or hide legends, and use the color boxes displayed in them 
to bring specified electropherograms to the front of the panel, or customize 
the colors.

matrix 
file/multicomponent 
matrix

File used to adjust for the spectral overlap between the fluorescent dyes 
used on the ABI PRISM® instruments. A mathematical matrix of the 
spectral overlaps is created and the inverse matrix is used to correct the 
data during analysis. Matrix files are stored in the AppliedBio folder inside 
the Macintosh® computer System folder, or in the matrix folder in the 
GeneScan Analysis Software folder. The values of the matrix are stored in 
the gel file (ABI 373 and ABI PRISM 377) and in the Sample files.

For more information, see Chapter 6, “Making a Matrix File.”

overlaid Displayed together so they overlap. 

In the GeneScan Analysis Software Results Display window, all 
electropherograms in a single panel are overlaid. 

You can bring a specific one to the front by clicking the color box that 
represents it in the legend.

plot color indicator Right color box in the Results Control window and the legend of the 
Results Display. 

In the Results Display window, click this box to move the associated 
electropherogram to the front. 

In the Results Control and the Results Display windows, double-click this 
box to change the plot color, or Ctrl+double-click it to reset the plot color to 
the default.
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preferences Defaults you can set so that certain parameters are automatically applied 
when you are working with a project. 

The GeneScan Analysis Software remembers preferences and applies 
them globally to all new projects. 

project File containing links to a set of sample files that you want to analyze and 
display together. 

A project can contain sample files from multiple runs. Adding a sample file 
to a project creates a reference to the file. It does not copy the file into the 
project. 

project options Formatting information you can set for the current project. Project options 
are remembered by the project when you open it again. 

sample files Computer files that contain raw and analyzed data. 

Sample files are created directly by the 3700 DNA Analyzer. Sample files 
contain data such as peak locations, sizecalling values, and a record of 
analysis settings.

sizecalling curve Curve created by the GeneScan Analysis Software for sizecalling. 

The software calculates this curve based on the sizecalling method you 
specify for data analysis. 

This curve is read in the Standard Sizing Curve window. When it matches 
the align-by-size curve, the two overlap so you see only this curve. 

See also “align-by-size curve” and “size standard spline interpolation 
curve.”

size standard Specific DNA fragments of known sizes. 

After you define the peaks of a size standard, the GeneScan Analysis 
Software matches this definition to the internal lane or injection standard 
that you include with your run. 

The software assigns the defined size values to the appropriate peaks of 
the internal lane or injection standard, and uses this information with the 
selected sizecalling method to size all unknown fragments. 



Glossary-5

size standard spline 
interpolation curve

Curve created by the GeneScan Analysis Software for aligning data by 
size. 

The software creates this curve if you use the Local Southern or Cubic 
Spline Interpolation sizecalling method and the size standard data does 
not match the best-fit curve, which is normally used for aligning the data by 
size. 

This curve is blue in the Sizing Curve window. See also align-by-size curve 
and sizecalling curve.

tiled Displayed so they do not overlap. 

The GeneScan Analysis Software displays tiled electropherogram panels 
in the Results Display. 

If you display more than one electropherogram in each panel, all 
electropherograms in the panel are overlaid.
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 Index

A
ABI 373

generating sample files
procedure 6–15 to 6–16

ABI Prism 310
automatic analysis diagram 2–2, 2–3

ABI PRISM 310
loading and running dye standards 6–9 to 

6–11
ABI PRISM 377

generating sample files 6–15 to 6–16
loading and running dye standards 6–12 to 

6–14
Analysis Control window

using to analyze project files 3–2 to 3–5
using to analyze sample file 3–6 to 3–15

Analysis Log, using 9–36 to 9–37
analysis modules

about A–2 to A–4
creating

analysis parameter file A–10 to A–12
size standard file A–6 to A–9

analysis parameter file A–10 to A–12
analysis parameters

about 5–2
setting 5–5 to 5–12

Analysis Range options 5–7
Auto Analysis Only option 5–12
Baselining options 5–12
Data Processing options 5–7
default settings 5–5, A–2
displaying analysis parameters 5–6
Peak Detection options 5–8, 5–9 to 

5–10
Sizecall Range options 5–10
Sizecalling Method options 5–10 to 

5–11
using 5–13 to 5–17

changing existing parameters 5–17
creating custom parameters 5–16
deleting custom parameters 5–17
different parameters 5–15
displaying default parameters 5–16

analysis parameters (continued)
using (continued)

the same parameters 5–13 to 5–14
analysis results

changing how displayed and printed 8–13 
to 8–15

Results Display window
about 8–4 to 8–6
using 8–7 to 8–12

steps to evaluating
evaluating results 8–2

updating the results 8–16
using the Analysis Log 9–36 to 9–37
ways to display 8–3
See Also Sample Results View

analyzing
project files 3–2 to 3–5
sample files 3–6 to 3–15

AppliedBio folder, files installed in 7–6
archiving 10–4
Auto Analysis, setting analysis parameters 5–12
automatic analysis, setting up 2–4 to 2–6

B
Baseline Window Size, setting analysis 

parameters 5–12

C
CD-ROM drive 1–10
colors

assigning to electropherograms 9–23
defining in electropherograms 9–24 to 9–27

copying data to other applications 10–5
Cubic Spline Method B–4
customer support. See technical support F–1

D
Data Collection software

automatically printing results from 11–2
deleting, custom analysis parameters 5–17
disk space recommended 1–10
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Documents on Demand F–6
dye color, changing in electropherograms 9–14
dye scale, changing 9–28 to 9–30

E
electropherograms

about 9–2 to 9–3
changing dye scale 9–28 to 9–30
defining custom colors 9–24 to 9–27
displaying electropherogram data 9–9 to 

9–11
displaying electropherograms and tabular 

data 9–4 to 9–8
using to verify peak detection 9–38
using to verify results 9–31 to 9–32
verifying size calculations 9–33 to 9–35
working with electropherogram data 9–12 

to 9–23
assigning standard colors 9–23
changing horizontal scale 9–21
changing the dye color 9–14
changing vertical scale 9–22 to 9–23
displaying peak positions 9–14
displaying x-and y-axis positions 9–13
highlighting peaks 9–15
making active window 9–13
scrolling the display 9–16
showing data by fragment size 9–20

about 9–20
showing off-scale data 9–18
using legends to change the 

display 9–15
zooming in and out 9–17

e-mail, address for technical support F–1
EPT Data View 4–24 to 4–25

displaying the view 4–24
example 4–25
what it displays 4–24

error messages D–8 to D–9

F
files, software files, table of E-1 to E-2
folders

AppliedBio folder, files installed in 7–6
defining locations 3–16

G
gel files

troubleshooting gel data D–4 to D–5
GeneScan

about the size standards C–1
analysis modules

about A–2 to A–4
creating A–6 to A–12
creating analysis parameter file A–10 

to A–12
See Also analysis parameters

archiving 10–4
copying, data to other applications 10–5
registering 1–8
related manuals 1–7
saving

projects 10–3
Results Displays 10–3
sample files 10–3
why save 10–2

size standard
GeneScan 350 All C–4 to C–7
GeneScan 400HD C–9
GeneScan 500 All C–11 to C–12
GeneScan 500 to 250 C–14

software files, table of E-1 to E-2
GeneScan 500 All size standard C–11 to C–12
GeneScan-400 HD size standard C–9 to C–10
Genotyper software, troubleshooting software 

results D–7
Global Southern Method B–7 to B–8

H
hard drive partitions 1–11
hardware and software requirements to run 

program 1–10
help. See technical support F–2
horizontal scale, changing in 

electropherograms 9–21

I
Internet address

Documents on Demand F–6

L
Least Squares sizecalling method B–2 to B–3
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legends, using to change display in 
electropherograms 9–15

Local Southern Method B–5 to B–6

M
Macintosh, converting sample files to the 

NT 4–3
macintosh, converting sample files to the 

Windows NT platform 4–4
manual

related manuals 1–7
matrix files

about 6–2 to 6–6
assigning to sample files 6–23 to 6–24
bad matrix files, causes 6–26 to 6–27
choosing a scan range 6–17 to 6–19
defined Glossary–3
evaluating the matrix file 6–25
generating files (ABI 373 and ABI PRISM 

377) 6–15 to 6–16
installing new file

sample file 4–27
loading and running dye standards

ABI PRISM 310 6–9 to 6–11
ABI PRISM 377 6–12 to 6–14

new matrix file, generating 6–20 to 6–21
process of creating new file 6–7 to 6–8
saving and naming 6–22

monitor, recommended 1–10
multicomponent matrix defined Glossary–3

O
off-scale data

showing in electropherograms 9–18
Operating System requirement 1–10

P
partitions, hard drive 1–11
PCR Single-stranded Conformation 

Polymorphism (SSCP)
Minimum Peak Half Width setting 5–8

peak detection
setting analysis parameters 5–8, 5–9 to 

5–10
verifying 9–38

peak positions, displaying in 
electropherograms 9–14

peaks, highlighting in electropherograms 9–15
printing

about printing 11–1
automatically printing run results 11–2
printer recommended 1–10
sample files 11–3 to 11–4

projects
analyzing project files 3–2 to 3–5
creating

finding missing sample files 2–14 to 
2–15

process diagrams, using the ABI Prism 
310 2–2, 2–3

using to manage sample files 2–6 to 
2–7

working with 2–8 to 2–13
creating a new project 2–9 to 2–13
defining folder locations 3–16
importance of saving 10–2
opening an existing project 2–8
removing samples from a project 2–13
saving, procedure 10–3
troubleshooting D–2 to D–3

R
Raw Data View 4–22 to 4–23

displaying the view 4–22
example 4–23
what it displays 4–22
what to evaluate 4–23

registering the software 1–8
Registration Number 1–8
requirements, hardware and software 1–10
Results Control window

saving and renaming 8–17 to 8–19
important considerations 8–17
renaming current display 8–19
saving the format 8–17
using previously saved formats 8–18

working with previously saved 
displays 8–18

Results Display window
about 8–4 to 8–6
using 8–7 to 8–12
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Results Displays
importance of saving 10–2
saving, procedure 10–3

S
Sample File window

about 4–8
EPT Data View 4–24 to 4–25
Raw Data View 4–22 to 4–23
Sample Info View 4–11 to 4–19
Sample Results View 4–9 to 4–11
Size Curve View 4–20 to 4–21

sample files
about 4–2 to 4–3
analyzing 4–26 to 4–27

installing new matrix file 4–27
procedure 4–26
using Analysis Control window 3–6 to 

3–15
archiving 10–4
converting Macintosh files to the NT 4–3
converting Macintosh files to the Windows NT 

platform 4–4
file size 1–10
finding missing sample files 2–14 to 2–15
matrix file, assigning to sample files 6–23 to 

6–24
opening, procedure 4–7
printing 11–3 to 11–4
removing from a project 2–13
Sample File window

about 4–8
EPT Data view 4–24 to 4–25
Raw Data View 4–22 to 4–23
Sample Info View 4–11 to 4–19
Sample Results View 4–9 to 4–11
Size Curve View 4–20 to 4–21

saving, procedure 10–3
unlocking sample files 2–12
using project to manage files 2–6 to 2–7
why save 10–2

Sample Info View 4–11 to 4–19
description of view 4–11 to 4–19

Sample Results View 4–9 to 4–11
saving

matrix file 6–22
projects 10–3

saving (continued)
Results Control format 8–17 to 8–19
Results Displays 10–3
sample files 10–3
why save 10–2

Show Clipboard command 10–5
Size Curve View 4–20 to 4–21
size standard file A–6 to A–9
size standards

about size standards 7–2
about the size standards C–1
defining, how to 7–3 to 7–8
file, creating for analysis module A–6 to 

A–9
GeneScan 350 377 C–7
GeneScan 350 All C–4 to C–7
GeneScan 400HD C–9
GeneScan 500 377 C–13
GeneScan 500 All C–11 to C–12
GeneScan 500 to 250 C–14
using 7–9 to 7–14

Sizecall Range, setting analysis 
parameters 5–10

sizecalling methods
Cubic Spine Method B–4
Global Southern Method B–7 to B–8
Least Squares Method B–2 to B–3
Local Southern Method B–5 to B–6
setting analysis parameters 5–10 to 5–11

software
files, table of E-1, E-1 to E-2

software, registering 1–8
SSCP, Minimum Peak Half Width setting 5–8

T
tabular data displays

about 9–2 to 9–3
displaying electropherogram and tabular 

data 9–4 to 9–8
using to verify peak detection 9–38
using to verify results 9–31 to 9–32

technical support F–1 to F–7
e-mail address F–1
Internet address F–6
regional sales offices F–4 to F–5
telephone/fax (North America) F–2
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bad matrix files, causes 6–26 to 6–27
error messages D–8 to D–9
gel data D–4 to D–5
Genotyping software results D–7
projects and results D–2 to D–3

U
unlocking sample files 2–12

V
vertical scale, changing 9–22 to 9–23
viewing scale, changing for 

electropherograms 9–17

W
WWW address

Applied Biosystems F–6
Documents on Demand F–6

X
x-axis positions, displaying in 

electropherograms 9–13

Y
y-axis positions, displaying in 

electropherograms 9–13

Z
zooming, electropherograms 9–17
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